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Introduction
Welcome to NiceLabel
NiceLabel is a family of professional labeling software products that brings a complete barcode
label printing solution to desktop and enterprise users. NiceLabel is used all over the world by companies in all industries, including retail, logistics, manufacturing, FMCG, health care, chemical,
automotive and others.
The latest software is available for download at the NiceLabel product web site at www.nicelabel.com.
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Setting up the Software
User Interface
Basic and Advanced User Interface
The labeling software has two-level user interface. By default, basic user interface is enabled that
makes the software easier to use for beginners and inexperienced users.
Software in basic mode:
l

Hides the advanced tabs in dialog boxes.

l

Enables all wizards for frequent tasks in label design.

l

Hides the advanced Toolbars.

l

Shows large icons.

To switch between basic and advanced modes, do the following:

1. Click on the User Interface command in the Tools menu.
2. Click on the command Set Basic Mode to enable basic mode or
click on the command Set Advanced Mode to enable advanced mode.
Note: You can also enable only some properties of the basic/advanced mode. Look at the other
User Interface options in the Tools menu.

Keyboard Shortcuts
You can quickly accomplish tasks you perform frequently by using shortcut keys - one or more
keys you press on the keyboard to complete a task. Note that this is just a faster and more convenient way of choosing commands. Command itself is executed just as if it was selected from the
menu or toolbar.
Shortcut
Delete
Shift + Delete
Ctrl + Insert
Shift + Insert
Alt + Backspace
+ (numeric pad)
- (numeric pad)
Alt + Shift + Backspace
Ctrl + 1

Ctrl + Shift + 1

Command
Deletes selected element
Cut
Copy
Paste
Undo
Zoom In
Zoom Out
Redo
Open the label design for the next template within
current label file. Only applicable if you use the header/main/tail or front/back labels.
Open the label design for the previous template
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Ctrl + Shift + N
Ctrl + T
Ctrl + A
Ctrl + X
Ctrl + C
Ctrl + V
Ctrl + Z
Ctrl + Y
Ctrl + N
Ctrl + O
Ctrl + S
Ctrl + P
Ctrl + R
Ctrl + G
Ctrl + H
Alt + F4
Ctrl + move object
with mouse
Alt + move object
with mouse
Shift + move
object with mouse
Ctrl + move object
with cursor keys
Shift + cursor keys
Click Text icon

within current label file. Only applicable if you use
the header/main/tail or front/back labels.
Creates a new label with default settings, bypassing
wizards.
Rotate 90° counter-clockwise
Align
Cut
Copy
Paste
Undo
Redo
New
Open
Save
Print
Print Preview
Snap to grid
Display guidelines
Exit
Parallel moving of the object by main axes only.
Object snaps to grid even if it is off.
Toggles object snapping to guidelines (if they are displayed).
Fine tuning the position of the object.
Fine tuning the dimensions of the object, resize
width and height in very small steps.
Dialog box for Text pops up.

in
ToolBox, then
press Ctrl + click
on the label
Click Graphics
icon
in
ToolBox, then
press Ctrl + click
on the label
Select variable
from the list in toolbar, click Text
icon

Dialog box for Graphics pops up.

Variable Quantity is automatically connected with
text object and placed on the label.

in
ToolBox, then
click on the label
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Select variable
from the list in toolbar, click Graphics icon

Variable Picture is automatically connected with
graphics object and placed on the label. This is a
great shortcut for using variable graphics, where filenames for pictures are received from database.

in
ToolBox, then
click on the label
Right-clicking the
object

Enter (or F2)
F2
Space + left-click
and dragging

Opens pop-up menu with shortcuts to commands.
The content of the pop-up menu greatly depends on
where you clicked your mouse button and what was
selected at that time.
Dialog box with element's properties will open.
On-screen edit is enabled for text elements.
Freely move the label within the working window. If
you want to change the view on the label, you do not
need to separately scroll the label in up/down and
left/right direction, but just grab it and move it to
proper position.

Main Window
The main window has many parts and functions. You can click specific parts of the screen-shot
image to see the description.

Main window
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Main Window
Attached form
Shows the name of the form that is attached to label. In front there is also an indication, which side
of label is currently active.

Coordinates
Shows X and Y coordinates of the pointer on the label in selected measurement units.

Label Tabs
Label tabs allow you to quickly switch between different label designs stored within the same label
template (.LBL file), like front/back side for dual-side printing, or header/main/tail label for batch
printing.

Label area
This area shows the current page of labels. If more labels are on one page, only to top leftmost is
active and you can edit it.
The red lines mark the printable area of selected printer. Note that if you put objects on or beyond
the red line, they will normally not be printed. You can however override that in Preferences menu.

Label Rotation
Click this button to rotate the label in 90 degrees steps clockwise. The action will only rotate the
label on the screen, the label will print in the direction specified in the label setup.
You can use this option to make label design easier. Your label can always be rotated in a way to
have all object placed horizontal.

Modified
Shows whether the current label has been modified since the last save command has been
executed.

Object Description
Shows description of selected object.

Ruler
This is ruler that shows the available area for label (white) and page (gray)

Scroll bar
You can use this scroll bar to scroll the label if everything is not visible.
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Selected printer
Shows currently selected printer. Double clicking it executes the Printer setup command

Mouse Wheel support
If you have mouse, that has a wheel in place of the middle button, you can use it to speed-up zooming and scrolling a lot:
l

Turning the wheel, scrolls the label up or down.

l

Holding <SHIFT> and turning the wheel scrolls the label left or right.

l

Holding <CTRL> and turning the wheel, zooms the label in or out.

Using the Keyboard and Mouse Effectively
When selecting objects you can use <CTRL> key to adjust object's anchoring point by clicking the
object placeholders.
If you have a Wheel Mouse, you can use the wheel to scroll label up and down. Holding <CTRL>
when rotating the wheel adjusts zoom factor, <SHIFT> scrolls label left or right.
Double click the form name in the status bar starts NiceForm and opens form that is attached to the
label.
Double click on printer's name in status bar opens printer properties dialog box in which you can
set various options regarding currently selected printer. If you hold <CTRL> while double clicking,
printer setup dialog box is opened, in which you can select different printer.
You can quickly move objects from one open label to another by simply dragging desired object to
another window while holding <ALT>. If you want to copy objects instead, hold both <ALT> and
<CTRL>. Note that you must have both label windows visible to do that.
Different objects on label can be selected using the <TAB> and <SHIFT>+<TAB> keys.
Pressing cursor keys while holding <Ctrl> key can move currently selected object. This can be
used to fine-tune position of the object. Holding <SHIFT> while pressing cursor keys will resize
the object.
You can use the right mouse button almost anywhere on label to access most common options for
that area/object. For example, if you click an object with right mouse button, a pop-up menu is displayed that contains options and actions that can be performed on selected object. Similarly clicking the other parts of label produces pop-up menu with options for that part of label.
Multiple objects can be selected by holding <SHIFT> while clicking them.
Use the element shortcuts in toolbars whenever possible. Each label element that can be connected
to some Contents Provider, has a shortcut enabled to quickly access existing variables or define
new ones. Click the element's shortcut handle for this shortcut. It is shown as a small arrow by the
side of toolbar button:
l

In the Toolbox:

,

,

and
l

In the Variable toolbar:

.
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,

Label Security
Tracking Label Design and Printing
Enable Revision History Comment
To enable the revision history functionality, do the following:

1. Select Options from Tools menu.
2. Go to Settings tab.
3. Tick the option Enable revision history logging.
Note: If you want to be able to write a custom comment for each revision, also enable the option
Prompt for revision history comment.

4. Click on the OK button.
Each time the label is saved, a revision note is saved with the label.
To review the revision history data, do the following:

1. Open your label file.
2. Select Properties from File menu.
3. Click on the Advanced button in the bottom of the dialog box to show the Revision History tab.
4. Go to the Revision History tab.
5. Review revision history data.
6. Click on the OK button to close the dialog box.

Use History Log to Track Label Printing
The labeling software has the ability to log all information about printing action in the database for
later review and reports. By default the logging is disabled. To be able to track label printing, do
the following:

1. Select the option Configure Log File in the Tools menu.
2. Select the option Enable logging.
3. Click on the OK button.
To view at the log of printed labels, do the following:

1. Select the option View Log File in the Tools menu. The table with the printing actions is
displayed.
2. Browse the table, sort the records, filter the records (in the Advanced mode) and generate
report file.
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Define User Passwords and Permissions
If you want to define access permissions for the users working with the labeling software, you can
enable user management feature in the software. If your computer is part of a domain, you can
define permissions for domain users. If you do not use domain, you must define the application
users.
To enable user management and assign the permissions, do the following:

1. Start NiceLabel Designer Pro.
2. Select Tools -> Options.
3. Click on User Rights and Access in the left pane.
4. Click on User configuration... button.

Dialog box for defining users and their permissions in the software

2. Select the Configure Users option in the left pane.
3. Click on the option Set authentication mode in the right pane. The Authentication
Mode dialog box will open.
4. Select the option Mixed (Windows and Application authentication). Click on the OK
button.
If you do not have or do not want to use domain users, define new user by doing the following:

1. Make sure you are still in the Configure Users dialog box.
2. Click on the button Add user in the main toolbar. For the username enter the name you
want to use for your user (like 'User'), then define a password for the user.
3. Click on the OK button.
Set up the profile and define user permissions by doing the following:
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1. Make sure you are still in the Configure Users dialog box.
2. Click on the Add Profile button in the main toolbar.
3. Open the General tab and define the name of the profile, for example My profile.
4. Go to Permissions tab.
Here you will define the access permissions to all applications that will be contained in
this profile.
5. Expand the NiceLabel selection, then tick the options Label design, Label print and
Label view. The members of this profile will be able to use the label design application
in full mode. They will be able to open the label, view it, design it and also print it.

Definition of the permission granted by the profile

6. Go to Members tab and add the user to the profile. Select the user you have created in
previous steps.
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Add the user 'NiceLabel User' to the profile 'My Profile'

7. Close the applications.
8. Start NiceLabel Designer Pro, log on with the new user and see how the access permissions are applied to him.

Login
The labeling software supports different access permissions to various parts of the applications.
Your administrator might have set up different access profiles so you must log in to validate your
credentials. Your username and password defines your permissions.
In order to use the labeling software the proper user name and password must be entered. Different
users have different privileges for usage of the program. For example, the access can be granted
on print only, design only, view only level, or full administrative access level.
The purpose of log in is the ability to distribute different tasks among different users and mainly, to
have ability to protect the data from unauthorized access. Usually the group of label designers consists out of different people than the group of label print operators. The print operators should not
have the access to label design.
Note: the default password for the built-in Administrator account is 'NICE'.

System Folder
The labeling application uses its system folder for storing files needed to run the program. The location of the folder varies depending on the Windows operating system used.
The location of the System folder is:
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c:\Documents and Settings\All Users\Application Data\EuroPlus\NiceLabel
6\system\.

It is vitally important to own the write access to this folder on your computer system and the right
to write to and modify files in this folder.
Note: The Multi-user clients use the System folder on the network server. If you have Multi-user
edition all clients must have the full access also to the System folder on the server.
The software stores important system settings in the System folder, as follows:
n

User data and user rights

n

Various application settings

n

Label printing logs

n

Barcode standards
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Designing Labels
Designing a Basic Label
Overview
In this section you will learn how to design a simple label file with fixed and variable objects. The
variable objects can obtain values from several sources. You will learn how to:
l

Provide object values with a keyboard prompt.

l

Obtain object values from a database.

l

Preview the label on the screen.

l

Print the label.

The label you create will look like this:

Basic label

Create a Basic Label
Create a New Label
To create a basic label, do the following:

1. Open the labeling software.
2. Select New label under File menu or click on the icon

in the standard toolbar.

Each time you create a new label, a Label Setup Wizard will start to help you setup the label and
connect to the printer.
Note: You can leave the Wizard at any time and accept the default settings for the label by clicking on the Finish button.
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Select a Printer
1.

Select the printer you want to use for label printing.
Note: If you don’t find your printer on the list, refer to chapter Install Printer Driver for
installation instructions.

Selecting a printer

2. Click on the Next button.

Define Label and Page Dimensions
1. If you want to use the label stock, select your choices in the window Select Stock.
2. Click on the Next button. A new window will open to define the label dimensions manually.
3. Leave the option Page Size on 'User defined' default and check Automatic Sizing.
4. Click the Next button. A new window will open.
5. Select label orientation and print direction.
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Selecting label layout

6. Click on the Next button. A new window will open.
Enter 10 for label width and 7 for label height.
Note: Dialog box differs from thermal and office printers.

Defining label dimensions
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Note: To change the unit of measure from centimeters to inches or other supported units, click on
the button with unit of measure below the label preview in the dialog box.

7. Click on the Finish button. New empty label will open.

Enter Non-Changing Text
1. Click on the
screen.

button in the Toolbox. The text cursor appears on the

Cursor for text object

2. Move the cursor to the location on the label where you want to place the text object and
click on the mouse button.
The dialog box with object properties will open.
3. Enter the text "SAMPLE" and click on the Finish button.

Entering content for text object
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4. Click on the text object to select the object.
5. Change the font for the text object using the Text toolbar.
Choose Arial font, 28 point size and bold style.

Using format options in the text toolbox

6. To change the position and size of the text object, select the text object and drag object
with your mouse to the position where you want to have it.
The screen should show the following:

The text object is placed on the label

Insert Barcode
Now you will add a non-changeable Code128 barcode on the label.

1. To insert the barcode, click on the

button in the Toolbox.

2. Move the cursor to the desired position on the label and click on the mouse button.
3. The dialog box with object properties will open.
4. Enter the value 1234567890 for the barcode contents.
5. Click on the Define button.
Edit Barcode dialog box opens.
6. Make sure you select barcode Code128 and click on the OK button.
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Selecting barcode type

7. Click on the Finish button to return to the label.
8. Change the position of the barcode by selecting the barcode and dragging it to the
desired position.
9. Change the object size by dragging the object handles. The handles are small rectangles
surrounding the object when it is selected.

Label with text and barcode objects

Insert Pictures
The labeling software works with BMP, PCX, GIF, WMF, JPEG and many other popular graphic
formats.

1. To insert the picture, click on the button in the Toolbox.
2. Move the cursor to the desired position on the label and click on the mouse button.
3. The Open dialog box will open allowing you to browse for your picture on your hard
drive. Go to the folder Sample Graphics and select the picture LEISURE.WMF. Click
on the Open button.
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Label with text, barcode and picture objects

Save a Label
Always save your label during the design process. To save a label, do the following:

1. Select the

icon.

2. Type in the name of the label. For example, enter 'label' for the name of the label.
3.

The name of the label is visible in the program caption.

Name of the label in the program caption

Use Alignment Tools
You have placed the objects on the label. Now you want to make sure they are aligned on the horizontal center of the label. You can align objects on the label by using the Align toolbar on the right
side of the working window.
To align objects on the label, do the following:

1. Select all objects on the label.
Note: The first object you select determines the alignment orientation for all selected objects.

2. Choose a select arrow in the Toolbox and draw a frame around all objects to select all
objects.
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Selecting the objects on the label

3. In the Align toolbar on the right, click on the
icon to arrange the objects.
The selected objects will be rearranged and positioned on the horizontal center on the
label.
Note: There are also other alignment commands available in the Align Toolbar.
Note: You can also align the objects to the label grid or the Guidelines. Both Grid and Guideline
options are available in the View menu.

Object Positioning Guidelines
Guidelines are available to assist you in positioning objects on the label. The functionality of
guidelines is similar to grid, but they allow you much more freedom regarding positioning, moving,
and combining positioning delimiters.
Although the guidelines may be visible while designing the label, they will not be printed on the
final product, regardless of whether the "Display Guidelines setting is turned on or off.
Create Guidelines

Create vertical and horizontal guidelines:
l

l

l

Click anywhere in the ruler area and drag the line out of it (the top ruler contains horizontal, and the side ruler contains vertical guidelines.
Alternatively, you may right-click on the label and select to add a guideline to that position from the Guidelines menu.
Finally, you can open the View menu and access the commands there

Using Guidelines

The guidelines are moved at any time with the drag of a mouse. If they are drug back to the ruler
area, they are deleted. It is possible to toggle between displaying and hiding the guidelines, either
by using the menu or right clicking them.
The guidelines can be hidden with the Ctrl+H shortcut key combination, and when they are hidden,
the Snap to Guideline functionality is also disabled. The menu also includes a Delete all
Guidelines command, which removes all the guidelines on the label.
Holding down the SHIFT key while dragging objects allows you to temporarily turn on the Snap to
Guidelines function.
Guideline Properties

Double-click a guideline or right click a guideline and choose Edit Guideline Properties to open
the Guideline Properties dialog window. The dialog allows you to enter the numeric positioning
value, choose the horizontal or vertical guideline type, or remove the individual guideline.

Use Drawing Tools
Now you will insert a line to separate a text object from other objects and a rectangle around the
picture object.
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1. Select the
ing point of the line.

icon from Toolbox and move the cursor to the required start-

2. Press and hold down the mouse button while drawing the line. Move the mouse to the
end position of the line and release the button. The Line object is placed on the label.
3. Click on the
corner of the picture.

icon in the Toolbox and point the mouse to the upper left

4. Click and hold the mouse button while you stretch the rectangle to the lower right corner
of the picture.
5. To change the thickness of the vertical and horizontal line, double-click on the rectangle
object to open its properties. Select the thickness you want and click on the Finish button.
6. To edit the drawing object, double-click on the line or rectangle to open the dialog box
with its properties.
The label should show the following:

Label with fixed objects

Add Variable Fields
Overview
You may want to print the label on which the data changes for each label. The labeling software
offers different variable fields (counters, date/time fields, operator's input from the keyboard) that
you can use with text, graphics and barcode objects.
For this example a new label was created. The following steps explain how to create a label that
contains a prompted field, a counter and date/time fields. The captions in the following screenshots
were added separately.
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The left label shows design mode, the right two labels are two consecutive labels from print preview

Create Keyboard Entry Variable Fields
The content of a prompted field can be different for every print job. Before you print the label, you
enter the value for the field.

1. Click on the small arrow next to the
of available variable types.

icon in the Toolbox to display a list

2. Select New Keyboard Input from the list and click on the label where you want to position the object.
A dialog box with the Variable Wizard will open.

Creating new keyboard input variable field

3. Type 'Enter product name' for the option Display this text to the print operator.
4. Click on the Finish button. The cursor changes its shape to an arrow with a text object.
5. Click on the label where you want to position the prompted field.
The text object is placed on the label and linked to the new variable.
Note: When you print the label, you will be prompted to enter the product name, which will be
shown in preview on the label and on the printed label.

Create Serialized Data Variable Fields (Counters)
Now create a counter field on the label. The value of that variable field will automatically increase
by one on every label.
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1. Click on the small arrow next to the
of available variable types.

icon in the Toolbox to display a list

2. Select New Counter from the list.
3. A dialog box with counter properties opens.

Creating new counter variable field

4. Leave everything as default so that the counter will always start from 1 and increase by
one on each label.
5. Click on the Finish button.
6. Click on the label where the counter should be placed.
The new variable is linked to the text object on the label.
Note: Typically, the counter will increase by 1 on each label. For example, 1, 2, 3, 4, 5, etc. You
can also define different incremental steps.

Create Date and Time Variable Fields
Content of the variable field can be filled automatically with the date or time stamp from the computer clock or printer clock (for supported printer models).

1. Click on the small arrow next to the
of available variable types.

icon in the Toolbox to display a list

2. Select New Date Field from the list. A dialog box with date properties opens.

Creating new date variable field

3. Leave everything as default and the date will be used on the label using the format as
defined in your Windows operating system.
To place a time stamp on the label, do the following:

- 29 -

1. Click on the small arrow next to the
of available variable types.

icon in the Toolbox to display a list

2. Select New Time Field from the list.
3. Click on the Finish button.
4. Click on the label where the counter should be placed.
The new variable is linked to the text object on the label.
The date and time fields are updated when you preview or print the label. In this example the values will come from the system clock of your computer.

Use Prefix or Suffix Options
You can add a prefix and suffix to each variable field on the label. Both are added to the value
when you preview and print the label.

1. Click on the small arrow next to the
of available variable types.

icon in the Toolbox to display a list

2. Select New Keyboard Input from the list.
3. A dialog box with variable properties will open.
4. Type the text 'Enter product weight' for the option Display this text to the print operator.
Set the allowable characters to digits and click on the Next button.
5. Enter ' kg' for the Suffix option.

Defining the variable suffix

6. Click on the Finish button.
7. Click on the label where you want to position the prompted field.
The text object is placed on the label and linked to the new variable. When you will preview or print the label, the suffix ' kg' will be appended to the entered value on the right
side.

Using Advanced Functionality
Creating a Label with GS1-128 (EAN.UCC
128) Compliance
Add Content to GS1-128 Barcode Using GS1-128 Wizard
Use the GS1-128 Wizard to help you add the necessary Application Identifiers (AI) in the barcode.
Complete the following steps with the wizard:

1. Select 10 Batch or Lot number.
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Selecting Application Identifier from the list

2. Click on the Next button.
3. Select Fixed and click on the Next button.
4. Enter the sample data, for example '12345'.
5. Click on the Next button. A dialog box showing all AI contained in this barcode will
open.
6. Click on the Add button to start adding a new AI.
For example, select AI 21 (Serial Number). Repeat steps from 1 to 5 above.
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Two Application Identifiers are defined

7. When you are satisfied with the designed AI and their positions within the barcode, click
on the Finish button.
The GS1-128 barcode is placed on the label.

Edit Barcode GS1-128

The designed label with GS1-128 bar code
To define the GS1-128 barcode, you first select this barcode type and assign a value to it.

1. Click on the small arrow button next to the
2. Select Fixed Barcode in the context menu.

- 32 -

button in the Toolbox.

Creating a fixed barcode

3. Move the cursor to the location on the label where you want to place the barcode object
and click on the mouse button.
4. The wizard with object properties will open.
5. Click on the button Define. The dialog box Edit Barcode will open.
6. Expand the group EAN.UPC and select the barcode GS1-128.
7. Click on the OK button to go back to the Barcode dialog box.
8. Click on the Next button.
The GS1-128 Wizard will open.

Using EPSC
Using the PIATS Function
The Product Identification Authentication and Tracking System Code (PIATS CODE), also
referred to as EPSC, is a monitoring system, set up by the General Administration of Quality Supervision, Inspection and Quarantine of the People's Republic of China. Its intent and purpose is to
improve product quality and safety, as well as simplify product tracking throughout the production
cycle.
PIATS Standards compliance requirements:
l

Barcode type: GS1-128 (MULTI) AI=21

l

Barcode structure: AI+20 supervision code

l

Minimum barcode module width ≥ 7 mm (recommended minimum is 10 mm, full barcode width in this case is 42,5 mm)

l

Minimum barcode height ≥ 8 mm

l

Barcode quality: Above C (1.5/10/670)

l

Blank area on sides = 10* minimum module width

Setting up a PIATS Variable

A PIATS code is based on a function, which draws its data from a variable. Therefore, the variable must be created first.
Use the New Variable toolbar button to create a new variable. Name it and set the following settings:
l

Source = Global

l

Maximum Length = 20
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l

Data format = Numerical

l

Incremental counter

l

Increment by = 1

l

Initial value ≥ 1

Only if the above criteria are fulfilled, will the barcode variable provide for valid PIATS codes
Setting up the PIATS Function

Use the Function toolbar button to add a new function. Name it and select Electronic Product
Selection Code in the type list. If the variable described above was correctly set up, you will be
able to select it as the Global Variable in the Detailed tab. Only valid variable types are displayed, and if your variable is not available, there was an error in the variable setup.

Click the Import button and browse to the .txt file which includes the PIATS codes you have
been issued. Import the file, and your list of available codes will be populated. You can preview
the list by clicking on the View button.
The imported data is bound to the global variable, therefore data imported for one variable will
not be available in another. Likewise, if the label is exported, the data from the global variable
will not be transferred and will remain available only locally.
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Insert a GS1-128 barcode onto the label and connect it with the PIATS information. Once the
labels are printed, they are marked as printed in the log, along with the timestamp of their printing. It is not possible to print a code that is already marked as printed, nor is it possible to import
the same list of codes twice.
NOTE: It is possible to delete the log of printed codes, makes it possible to perform import and
printing these codes a second time. Be cautious when deleting printed codes from the log, or
you may lose track of past printing activities.

Designing Label with Variable Length
In most label-printing scenarios you design and print the label with fixed dimensions. The label
width and height do not change so you must make sure to fit all objects on the label.
However, in some cases you need the ability to design the label with the variable length. The label
length changes in accordance to the size of the label objects. When you assign more data to the
label objects, their size increases and occupies more space on the label. In order to fit such objects
on the label, the label height must change.
Note: The requirement for variable label sizing is quite often in the textile industry, where labels
print to endless label material. There are no gaps between the labels. The printer cutter cuts the
material after the label prints.
To enable the variable label sizing, do the following:

1. Select File -> Label Setup.
2. Go to the Dimensions tab.
3. Click the Advanced button.
4. Enable the option Enable variable label size.
5. Make sure to set the offset to the proper value. The offset defines the amount of space
between the last object on the label and the bottom label edge.
See the screenshots below to understand the automatic label resizing function.
The variable label size is enabled on the label. There is always 1 cm gap from the bottom label border and the last object on the label, barcode in this case. The text object is a multi-line object. If
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you enter more data for the text object, the label height must increase to accommodate for the larger text object.

Variable label sizing feature increases the label height on demand
To take full advantage of the variable label sizing, you must enable the object relative positioning.
In this case the objects will not always be placed on the same spot on the label. Their placement
will change accordingly to the placement of parent objects. .
Note: When you enable the variable label sizing, you cannot use the "labels across" option at the
same time. However, multiband printing is available.

Controlling Cutter in the Printer
If you have a thermal printer equipped with the cutter, you can control the cutter action from the
labeling software. You must use NiceLabel Printer Driver for your thermal printer if you want to
control the installed cutter. To set up the cutter control, do the following:

1. Select the option Label Setup in the File menu.
2. Go to the Cutter Settings tab.
3. Select the option Enable cutter.
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Enabling cutter functionality
Note: Designer Express edition can control the cutter. However, you cannot use the Label Setup
dialog box. Instead you must define the cutter parameters in the properties of the NiceLabel
Printer Driver printer driver. Please refer to the Designer Express user guide for instructions how
to set up cutter.

Defining Label Batch Printing and Using
Header and Tail Labels
Label batch refers to a group of labels that have some property in common. The purpose of identifying label batch is to execute the actions and to enclose each label batch with header and tail
label. The header and tail labels are printed in front of the first label in the batch (header label) and
after the last label in the batch (tail label). They can be used as page separators and can include
additional information for the label operators. To enable label batch printing, do the following:

1. Select the option Label Setup in the File menu. The Label Setup Wizard will open
2. Select the option Open the advanced options dialog box and click on the button
Finish. The main Label Setup dialog box will open.
3. Go to the tab Batch Printing.
4. Click on the button Advanced in the bottom part of the dialog box. The Advanced tab
will open.
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5. Look at the Label Batch Definition sections. If your label batch will contain 5 labels,
enable the option Fixed number of labels and type 5 in the combo box in the right.

Setting up label batch

6. To enclose the main labels with header and/or tail labels, tick the option Use header
label and/or Use tail label.
Header and tail label are stored in the same label file, but you can still design them as separate
labels. Access to header and tail label from the View menu where you can enable and disable
view on the these labels.

Designing Double-Sided Label
The labeling software supports double side printing for office printers (ink jet, laser...) and for
thermal printers. The option is enabled in the Label Setup dialog box, Printer tab. Look at the
option Double-sided printing.
Note: The option is available only, when the used printer driver supports double-sided printing.
As soon as you enable this option, the option Label Side in the View menu becomes available. Use
it to switch between front and back sides of the label. The identification of the current page is also
visible in the status line at the bottom of the window.
When printing to office printer, these two pages are always printed one after another. They are
sent to the printer one after another so make sure you enable duplex functionality in the printer
driver.
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When printing to thermal printer, printer driver NiceLabel Printer Driver will take care of proper
label processing and printing. You need to use the appropriate NiceLabel Printer Driver to enable
double-sided functionality.

Designing Labels for Mobile Devices
The labeling software has support for mobile label printing from Windows Mobile devices. You
can design the label with the desktop labeling software and then export it to the Mobile device.
The pocket edition of labeling software is not as powerful as desktop edition and does not support
some features that are available in the desktop edition. You must be careful when designing the
label for Mobile device. If you select some unsupported feature, the label export is not possible.
Some examples of unsupported features:
l

Majority of complex functions are not supported (Visual Basic scripting, User defined
check digit algorithms, HIBC, Lookup table, Link to file, etc.), but some are (Concatenate).

l

Global variables are not supported.

l

Variable graphics are not supported.

l

l

l

l

Databases are not supported (but databases are supported on the form created in
NiceForm).
Variable text objects formatted in Truetype fonts are not supported (you can use variable
Truetype fonts if you download them to the memory card in the printer)
Advanced variable features are not available (prefix/suffix, advanced serialization,
remembering the last value used, formatting the date/time stamps, etc.)
etc.

To find out if your label is compliant with the export limitations, do the following:

1. Save the label.
2. Select the command File -> Export -> Export to Pocket PC.
3. If your label complies with the limitations, the label is exported. The files with extensions
.PNL and .LVX will appear in the same folder, where your label is stored. You can copy
them to the Mobile device with the Microsoft ActiveSync.
If your label does not comply with the limitations, you will see the error dialog box that
will explain which unsupported feature you use on the label. Remove that feature and try
to export the label again.
For more information about the label design for Mobile devices refer to the white papers available
online.

Multicolor Printing
Some thermal printers support multicolor printing. They use multiple heads, each head for a ribbon
of a different color. The colors for each printer head are customizable and can be defined in the
printer driver. Each print head is assigned a color that matches the used ribbon. The same colors
become available in the labeling software. For multicolor printing to work you need to use the
appropriate NiceLabel Printer Driver.
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Color palette synchronizes the available colors with settings in the printer driver. All colors you
have defined in the printer driver are retrieved in the labeling software and made available for
color selection. Color palette, color selection dialog box and label setup dialog box all display only
the available colors from the printer. Each label element can then easily be assigned some of the
available colors. The element is then printed using that color. More than one color cannot be used
with a single label element.
When you use color images on the label, their appearance on the label changes. They cannot be
printed in more colors than supported by the printer. The images are not displayed in full color.
Each image is converted to monochrome graphics and previewed on the label as such. Conversion
from color to monochrome graphics is done using dithering setting in the driver. You can assign the
image one color and thus the print head where the image will be printed.
The colors on the label identify which printer head will be used for printing the elements.

Setting up Stock Manager to List Commonly
Used Labels
When you create a new label, you can base the new label on some predesigned label format
referred to as stock, or you can design the new label from the scratch. The labeling software
comes with a library of predefined stocks, based on the labels from different manufacturers. You
can also add the definition of your own labels into the library by using the Stock Management. To
open Stock Management, do the following:

1. Select the option Stock Management in the File menu. A new window will open showing all defined stocks listed in a table.
2. Under the Stock type option, select the group from the combo box for which you wish
to show the stocks. The table will contain stocks from this group only.
Define your own group by doing the following:

1. Click on the ellipsis button. The dialog box of Stock Types will open.
2. Click on the Add button and provide the name of the group. Click on Save and Close.
3. Select your new group and click on the button New in the bottom part of the dialog box.
The stock definition dialog box opens.
4. Open the General tab and define the identification properties of the stock.
5. Open the Dimensions tab and define the width and height of the label.
6. Click on the OK button.
The stock will be saved in the library and available for selection whenever you will create a new
label.

Tracing Variable Values
Each value of the variables can be traced and logged into the log file.
By default the tracing functionality is disabled.
To enable tracing, do the following:
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1. Select Variable Trace Setup from Data menu.
2. Select the variables you want to trace.
Note: By default, values for all variables on the label are traced.

3. Select Configure Log File from Tools menu.
4. Enable logging functionality.
5. When you will print labels, the values for variables as were used on the label are saved to
the log file.

Using Contents Mask
Contents mask is very useful when you must display the input data differently on the label. With
contents mask you can simply reformat the data to suit your needs.
For example, you must use differently formatted human interpretation text below barcode than the
data is formatted in the barcode. You do not want to define two variables for this purpose and enter
the similar data twice.
The mask character will be replaced by the actual data and any other used character will be used
as-is. If the current barcode value is
"AD951"

and the contents mask is
"**C - ** /*/"

the resulting output will be
"ADC - 95 /1/"

Powerful formatting structures can be defined using Contents mask, but it is only available with barcodes that allow custom formatting of the human interpretation. You should also make sure to print
barcodes as graphics, otherwise the contents mask is not available.
Note: If your data contains the asterisk "*" character, then you will have to change the default
mask character to something else. It should be a unique value, not appearing anywhere in the
data.
The contents mask functionality is available with Text and Barcode objects.

Using Expression Builder
The Expression builder is a programming text editor with constant access to command reference of
the script language you are currently using. The Expression Builder can be used for VBScript and
Python scripts as well as for the native NiceCommands.
The Expression Builder lets you edit your scripts and expressions with ease. The Load and Save
buttons allow you to work with the external scripts.
Note: The expression editor understand the syntax highlighting. The editor will highlight the commands of the selected scripting language for easier understanding of the code.
The working window is divided into four parts.
Category

This section contains the groups of available commands, functions
and operators. Similar objects have been grouped together for

- 41 -

Name

Expression
Description

easier identification and faster search.
Some predefined custom functions have been provided in the
VBScript and Python syntax. See Custom Functions in the Category list.
This section will display the contents of the selected group in the
Category section. All available commands, functions, operators
etc. will be listed here. If you select one of them its properties
will be displayed in the Description section. If you want to insert
the selected operands into the Expression field double click its
name or click the Insert button.
This section is the main workplace of the Expression Builder.
Use it to write and modify the script your are working on.
This section displays the name, sample use and description of the
currently selected operand in Name section.
You will get an idea how the current operand should be used.

Script Help: button will open the help file with the detailed reference of the currently used script
(Visual Basic Script or NiceCommands). Click it to find out more about the command you are
working with.
Keyboard Shortcuts

Shortcut
Cursors
Ctrl + F
Ctrl + R
Ctrl +
Space
Ctrl +
Shift +
digit

Ctrl +
digit

Description
Standard positioning of the cursor.
Find some text.
Find & replace some text.
Code completion. When typing the command press this shortcut
to display all commands that match the partially entered name.
Define the bookmark at the current cursor position. Next to the
row number you will see a bookmark number. You can use up to
10 bookmarks simultaneously.
To remove the bookmark go to the row where the bookmark is
defined, then press the same keyboard shortcut again.
Go to the bookmark with the selected number.

Using Label Inspector
Label Inspector is a tool for advanced element and data manipulation on the label. It is used for
overview of label's structure and modifying label components, all element's properties can be
simply modified from Label Inspector. You can of course still double click the element and change
its properties from dialog box, but for smaller changes it is much quicker to change them in Label
Inspector.
Now you can change properties of several selected elements at the same time. If elements are of
the same type, for example, all texts, you will be able to change their every property. If elements
are of different types, for example, one text, one barcode symbol and one rectangle, only the properties common to all elements could be changed.
With Label Inspector you change some element's properties that are not accessible otherwise.
Each element can have its own name, so you can distinguish between them. Whenever you select
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the element on the label, it will be highlighted in the list of elements within Label Inspector and its
properties will be displayed in the bottom part of the Inspector (Properties section).
Label Inspector can be used to change the current view of the label elements, variables, functions
and databases. The following views are available, the first on being the default one.
l

l

l

l

l

View by Objects:
All label elements are listed alphabetically by their type. First listed are text elements,
then paragraph, barcode, graphics, rectangle and line elements. You have probably noted
this is the same order of elements as they appear in the Toolbox. When you select one or
more elements in the upper part of the Inspector, its (their) properties are displayed in the
bottom part of Inspector. You can interactively change them and changes will be reflected automatically on the label. You can right-click any element and quickly access frequently used commands from the drop-down menu. You can find out to which variable
some element is connected to by clicking the plus sign in front of the element's name. If it
is not fixed, the view will be expanded and variable name displayed.
View by Variables:
All variables used on the label are listed here. They can be either prompt (their value is
typed-in by the user at print time), database (acquired from database fields) or functiongenerated variables. If you click the plus sign in front of variable's name, the view will be
expanded. You will be able to review from where the variable gets its data (database,
function) and to which element(s) it is connected to. At the top of the upper section you
can define a new variable. You can right-click any variable name and quickly access frequently used commands from the drop-down menu.
View by Functions:
All functions used on the label are listed here. If you click the plus sign in front of function's name, the view will be expanded. You will be able to review which are input and
output variables for the function. At the top of the upper section you can define a new
function. You can right-click any function and variable name to quickly access frequently used commands from the drop-down menu.
View by Databases:
All databases used on the label are listed here. If you click the plus sign in front of database's name, the view will be expanded. You will be able to review which are output
variables from the database. At the top of the upper section you can define a new database. You can right-click any function and variable name to quickly access frequently
used commands from the drop-down menu.
View as List:
This view is similar to View by objects with one difference. Not only objects are listed
here, but also all variables, functions and databases. You can right-click any name to
quickly access frequently used commands from the drop-down menu.

The rightmost button Inspector properties is used to define the default behavior: should the view
to Inspector's elements be expanded by default or not. If the elements are expanded then all the
properties for all of them are visible. If they are not expanded, you will have to manually expand
the view of the element, you are interested in.

- 43 -

Using Pictures from the Memory Card
To select the picture from the memory card, do the following:

1. Open the label where you want to use the pictures from the memory card.
2. Make sure the printer has inserted the memory card that contains the pictures.
Note: You must use the application NiceMemMaster to fill the content of the memory card. If
you use some other application, the contents will not be recognized.

3. Select the command Printer Settings in the File menu.
4. Go to Printer Memory tab.
5. Look at the Slot where you have inserted your memory card in the printer.
6. Change the Slot Type to Memory Card.
7. Select the appropriate .MMF file, created by the application NiceMemMaster.
8. Close all dialog boxes.
9. Select the Picture object in toolbox, then click on the label.
10. Browse to the picture on the disk that you want to use.
Note: This is the same picture as you have downloaded to the memory card. You need to insert it
from the disk for previewing purposes only. When the label is printed, the picture already stored
in the memory card will be used.

11. Tick the option Picture is stored on the memory card.
12. Click on the OK button.

Designing an RFID Smart Label
Overview
The concept of RFID (Radio Frequency IDentification) can be simplified to that of an electronic
barcode. First emerging in the 1980s, RFID was primarily used to track objects in industrial environments where barcodes were unable to sustain the harsh surroundings. Today, RFID is being used
to track proprietary assets, automate access control and has many more additional fields of usage.
Some thermal printers have the ability to program a RFID tag at the same time as they are printing
the label. Two different technologies and their encoding methods are joined on the same label. Of
course a label must have embedded a RF tag. The tag is paper thin, flexible and small in size
which allows it to be placed inconspicuously under the label. It consists of an etched antenna and a
tiny chip that can store ID number or your custom data in larger quantities. This contrasts with a
barcode label, which does not store any enhanced information, but merely some code number.
Radio frequency identification (RFID) refers to technologies that use radio waves to automatically
identify individual or groups of items. The labeling software and NiceLabel Printer Drivers support
programming and printing of RFID tags embedded in a label.
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Note: You can use RFID functionality in the labeling software only if you have installed a
NiceLabel Printer Driver with RFID support. Make sure you install the NiceLabel Printer Driver
of your RFID printer before you design and print an RFID smart label.

Create RFID Smart Label
1. Click on

button in the Standard toolbar. Label Setup Wizard will start.

2. Select the printer that supports RFID smart label printing.
3. Click on the Finish button.
You will see that ‘RFID Tag’ command is enabled in the Toolbox on the left side of the
labeling software working window.

RFID Tag is available for use

4. Click on the RFID Tag option in the Toolbox and define the data you want to encode
into the RFID tag.

Encode RFID Tag
The RFID tags embedded into the label are usually of two types: ISO tags, which encode blocks of
data; or UHF tags, which can encode one string of data.

1. Click on the button
RFID Tag dialog box opens.

in the Toolbox to begin encoding the data. The
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Encoding contents for RF Tag

2. Select the type of the RFID Tag you want to use from the list box on the top of the dialog box. Click on the Tag Settings button to review RFID tag contents and define the
encoding advanced properties.
3. Enable the option Write data to RFID tag if you want to program the tag at the same
time as the label is printed.
Note: If you don’t select this option, the definition of tag content is saved but not sent to the
printer.

4. Select the appropriate entry from Data Fields section.
For RFID Gen2 tags you are able to select from different data fields. For other RFID
tags usually only one data field is possible - RFID Tag Memory.
5. Go to the first available block in the section Data Blocks and click on the Data cell in
the table.
Note: You might not see the table-like structure. Instead you can see edit fields to enter the
RFID data. The typo of data entering depends on the type of selected RFID tag.

4. Type in the value you want to encode into this block. Repeat the process for other
blocks.
5. Click on the OK button. A schematic view of the RFID Tag antenna will open in the
label background identifying the definition of the RFID data on the label.
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RFID Tag antenna in the background

7. You can continue designing the smart label with non-RFID data as described in the previous sections.
Whenever you print the label, the RFID data will be sent to the printer. The printer prints the RFID
smart label and programs the RFID tag embedded into the label at the same.
Note: The labeling software can work with Unique RF Tag numbers. Each RFID tag has embedded a unique serial number. Some printers can read the Unique RF Tag number and it can be
used on the label linked with some label objects.

RFID Tag Settings
Tag Information: This section provides the information about the selected tag type. You can see
the structure of the selected RFID tag. The outlook of the information depends on the selected type
of the tag. For RFID Gen2 you will see table-like structure with the information about the available
data fields, number and size of the block, read or write support.
For other RFID tags you can review the following structure:
Number of blocks: The number of blocks that are available in the RFID tag.
Reserved blocks: The number of blocks that cannot be accessed and used.
Block size: The size of each block (in bytes).
Unique RF Tag: This property is set to Yes, if you have the printer and/or the tag type that
can provide you with the Unique Tag ID. Each tag has a unique ID encoded already in the production line. If your printer can read this information from the tag, you can use it with the
label objects using RFID Tag Contents contents provider.
For example: The printer scans Unique Tag ID, remembers it and prints it on the label
encoded in a barcode element. The value of Unique Tag is never returned to the labeling software. It is handled internally by the printer.
RFID Tag Data Read: This property is set to Yes, if you have the printer and/or the tag type
that allows the extraction of the encoded data. You can extract all or part of the data encoded
in the RFID tag and use it with the label objects.
Tag Settings: This section provides more control for RFID programming.

- 47 -

Antenna offset: To achieve better programming accuracy of the tags here is the option to
define the offset for the antenna in the printer. This is the distance from the antenna to the to
the embedded tag on the label. This option will help you program the tags more accurately.
Power attenuation: Specifies the radio output power. Use it do adjust the RF emission from
the antenna.
Maximum tags to stop: When the programming of the RFID tag fails, usually the word
"VOID" is printed on the label. With this option you can specify how many tags can be programmed wrongly, before the printing of labels stops. The option can be used as a precaution
measure to prevent endless consumption of labels.
Number of retries: The number of times the printer will try to program the tag if first attempt
fails. The parameter is sent to the printer with the rest of the data.
Check for a valid tag: Before the tag programming begins, the printer will verify if there is a
proper RFID tag available in the smart label. The printer will also verify if the tag can be programmed at all. If the printer cannot check the currently selected RFID tag, the option will not
be accessible.
Verify data write: Once the data has been encoded into the RFID tag, the printer will check
if the written data is equal to the original value.
EAS Settings: This section provides settings for Electronic Article Surveillance.
EAS is not available for all printers and drivers. If your RFID Tag Settings do not include
EAS Settings, you may need to update your printer driver or select a different printer. For
more information, see your printer and driver documentation.
Preserve original EAS setting: The original EAS setting cannot be retrieved, but the default
option assumes that the tag setting should remain unchanged.
Enable EAS: Enable Electronic Article Surveillance in the RFID tag. If this was the original
setting, the tag will remain unchanged.
Disable EAS: Disable Electronic Article Surveillance in the RFID tag. If this was the original
setting, the tag will remain unchanged.
Permanently lock EAS tag setting: Checking this box will permanently lock the chosen setting for the EAS. This lock cannot be undone.

RFID Tag Locking
Tag locking is not available for all tag types, printers, and drivers. If the Locking Settings... button
is not displayed in the RFID tag dialog window, you may be using an unsupported RFID tag type,
printer, or driver. The locking settings are available for certain GEN2 tag types. For more information, see your printer and driver documentation.
RFID tag locking enables the user to lock an RFID tag. This means that no changes can be made
on it without unlocking the tag first. If the tag is permanently locked, it is not possible to unlock it,
and the RFID tag can never be changed.
Preserve original locking setting: The original locking setting cannot be retrieved, but the default
option assumes that the tag setting should remain unchanged.
Lock: The RFID tag is locked and further changes on it are prevented.
Unlock: The RFID tag is unlocked, so that it can be changed.
Relock: The RFID tag is unlocked, the changes are applied, and the tag is locked immediately
after.
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Permanent lock/unlock: Checking this box will apply your selection above permanently and prevent later changes to it. This setting cannot be undone.
Blocks to be locked: Manually define the individual blocks or range(s) of blocks to be locked. Individually locked blocks are defined with an index and separated with a comma (with or without
inserting space between). Ranges of blocks are defined using a dash.

Support for RFID Tags
With the labeling software you can program RFID tags of different manufacturers. It is important
to use NiceLabel Printer Driver printer driver for your thermal printer. You cannot program RFID
tags, if you do not use NiceLabel Printer Driver.
NiceLabel Printer Driver will let the labeling software know which types of RFID tags the printer
supports.
Not all tag types are always available. It depends on each printer model what kind of RFID tags
can be used with it. There are generally two types of tags:
l

l

ISO tags (TagIt, iCode, ISO...): These are block oriented tags. The data can be encoded
in multiple blocks.
UHF tags (EPC): The data is encoded in one block of data.

You can input content for RFID tags using different methods, dependent on the tag type (UHF or
ISO).
UHF Tags
l
l

l

l

Data type: Data type of the selected tag can be specified here.
Data source: Incoming data that is encoded in the tag can be fixed value or acquired
from some variable, defined in the label.
Data size: The currently used data is previewed here. You can see the amount of space
still available in the tag. The occupancy of the tag is seen graphically with growing bar
and numerically with the digit, explaining the number of already used bytes.
Block locked: If you set the block as locked, the data will be permanently encoded into
the tag. You will not be able to erase this block to re-program it with some other value.
Use this option with caution!

ISO Tags

The blocks that are dimmed and inaccessible are reserved blocks that cannot be used.
l
l

l

l

l

Block Number: The successive number of block in the tag.
Data source: Select where the data block will receive the value from. It can be Fixed,
where you will manually type in the value or can be Variable, where the value is
acquired from some variable defined in the label.
Data: Type in the tag value manually, if the selected data type is Fixed. Select the variable defined in the label, if the selected data type is Variable. If your variable length is
greater than the block size, the next block will automatically be reserved for the data.
Size: The currently used data is previewed here. You can see the amount of space still
available in the tag. The occupancy of the tag is seen graphically with growing bar and
numerically with the digit, explaining the number of already used bytes.
Data type: The data can be encoded as ASCII string or as HEX encoded string.
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l

Locked: If you set the block as locked, the data will be permanently encoded into the
tag. You will not be able to erase this block to re-program it with some other value.
Use this option with caution!

RFID Read and Store Data
Here you can define which RFID data fields from the RFID tag will be stored in the selected storage type. Put the tick mark next to the data field you want to store. The list of available data fields
might change with the selected RFID tag type.
Once you have selected the RFID data fields, you can select the storage type that matches your
requirements. Some of the storage plug-ins ship with the software. So you can select the database
and text storage plug-in.
Note: If no storage plug-in is selected the selected RFID Data Fields will still be stored into the
regular log file.

Database Storage Plug-in
The RFID database storage plug-in defines how the RFID data is stored in the selected database.
The printer driver receives the RFID data from the RFID reader embedded in printer. The database plug-in defines into which database field the RFID data should be stored.
Storage Database tab
Here you can create a link to the database and its table, where you want to store the RFID data.
You can use direct database access to open the supported database, or use the connection using
ODBC, OLE DB and BDE drivers.
Note: You must select a true database that is accessible using SQL sentences. This rules out
spreadsheets like MS Excel.
Storage Fields tab
Here you can select the table field into which you want to store the RFID data. You can insert new
records in the database, or you can update the existing records in the database.
Update existing data records in the table. Use this option to insert RFID data values into the existing records in the database table. In the first table below select the
field into which you want to store RFID data. Make sure that the Data Source is set
to 'RFID Data'. At the same time you can also store the values of other variables (not
just RFID data) into the database fields.
In the second table define the query condition, when to store the values in the database. The data values are stored to the database, when all conditions are met. This
feature allows you to define a condition based on the fixed values or variable values.
Create a join between the field name and the data source.
For example: Usually you create a join between the ProductID field in the database
and the label variable ProductID. If both IDs are the same, you can be sure you will
write the data into the correct field.
Insert new data records into the table. Use this option to insert RFID data values
into new record in the database table. In the first table below select the field into
which you want to store RFID data. Make sure that the Data Source is set to
'RFID Data'. At the same time you can also store the values of other variables (not
just RFID data) into the database fields.
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Error Logging
If you do not see the RFID data stored into the selected database, you can enable error logging to
catch the error messages. The RFID data storage takes place outside of the labeling application by
another software component. The RFID data is returned by the printer driver when the printer actually prints the label and reads the RFID data. It might not be immediately after you issue the print
command, the job might be delayed in the spooler out of several reasons.
When you enable the error logging, select the text file into which you would like to store error message. The error messages will help you resolve the error situation. Usually the conditions you have
defined in the Storage Fields tab are not met.
Note: RFID data is always stored in the XML data structure.

Changing Printer Settings
Changing Common Printer Settings
When you start designing a label you tell the labeling software to what printer the label should be
connected. Each label file remembers the printer settings for the selected printer driver on the
label.
As an example, you will change the printing speed and darkness. To change the printer settings, do
the following:

1. Go to File – Printer Settings. The window with the printer settings will open.
2. Open the Options tab.
3. Change the Speed and Darkness options.
4. Click on the OK button.
5. Save the label by clicking the
mand Save in the File menu.

button in the Standard toolbar or selecting the com-

Printer driver properties
Note: Any changes in the printer settings dialog box will be saved to the label and applied to
future print actions.
You can also change the printer settings right before the label is printed.
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1. Select the Print command in the File menu.
2. Go to the Printer tab.
This tab allows you to change the printer just before printing begins, but it also enables
you to change common printer settings like speed, darkness and print direction.
Note: Changes to the settings in the Printer tab will not be saved in the label but used only at
print time.

Changing Dithering Options
Dithering is a process of converting color or gray scale pictures to black and white pictures that
can be printed on thermal printers. Thermal printers normally cannot print color images and can
either print a dot on the label or not. There are no intermediate shades of gray.
During the dithering process all colors and shades of gray in the picture are converted to black and
white dots, creating the illusion of new colors and shades by varying the pattern of dots. Different
shades of gray are produced by varying the patterns of black and white dots. There are no gray dots
at all. In printing, dithering is usually called half-toning, and shades of gray are called halftones.
To change the dithering settings, do the following:

1. Go to File – Printer Settings. The window with the printer settings will open.
2. Open the Dithering tab.
3. Change the Dithering type option to suit your needs. Look at the preview on the right
side how you can expect the selected type to be applied on the label.
4. Click on the OK button.
5. Save the label by clicking the
mand Save in the File menu.

button in the Standard toolbar or selecting the com-

Defining Unprintable Area
Unprintable area is the part of the label where the printer cannot print. You can virtually increase
the size of the label by enabling unprintable area in the printer driver. The thermal printer can only
print labels that are placed below the print head. If you have wider labels and the print head does
not completely cover the label, the label part jutting out of the print head cannot be printed.
With unprintable area feature you can let the application know that there is unusually wide label
inserted into the printer. The labeling software will draw vertical red lines identifying the unprintable area. The unprintable area is usually the label area left and right of the printer head.
The unprintable area is not a margin. The label objects are not shifted on the label.
To define the unprintable area on the label, do the following:

1. Open the label in Designer Pro.
2. Select File -> Printer Settings.
3. Go to Options tab.
4. Enter the values for Unprintable Area.
For example:
You have a printer with 10 cm (4") printer head and a 12 cm wide label. You insert the label
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centrally in the printer, so it sticks out of the print head evenly on both sides. You define a new
label in the labeling software with 12 cm width. By setting the unprintable area to 1 cm on the left
and 1 cm on the right side you let the labeling software know that the actual label width is 10 cm.
There will be two vertical red lines on the label identifying the unprintable area.
Note:
You might also see the vertical red lines when you switch the printer on the label. The original
printer might had wider print head than the new printer. Maximum widths of the labels are not the
same for both printers. The labeling software will try to preserve the original label dimension and
automatically define the unprintable area for the new printer.

Using Toolbars
Using Standard Toolbar
Click on the icons in the standard toolbar will execute the following actions:
Create new label.
Open existing label.
Save currently opened label.
Cut the selected objects to clipboard.
Copy the selected objects to clipboard.
Paste the objects from the clipboard.
Undo last action.
Redo last action.
Access to the
commands.
Access to the
commands.
Access to the
commands.
Access to the

print functionality. Click on the small arrow for more
zoom functionality. Click on the small arrow for more
view functionality. Click on the small arrow for more
variables. Click on the small arrow for more commands.

Access to the databases. Click on the small arrow for more commands.
Open the help file.

Using Database Toolbar
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First field shows the list of currently active databases. It allows you to browse through the attached
databases.
List box lists the links to the databases that are available in the
label.
Define a link to new database using Database wizard. The Database
wizard will guide you through the necessary steps to link database
on the label. The result will be database fields available as variables.
Define new link to the database manually.
Edit the properties of the selected link to the database. You can
change the database driver, select which records will be printed
and define if quantity of the labels comes from the database.
Delete the selected link to the database.
Note: Make sure that database fields are not used anywhere on the
label, linked to objects or used in the functions. Otherwise the link
cannot be removed. If you are not sure, where the database fields
are used, use the Label Inspector to find that out.
Click on this button to open the database table in database management application NiceData.
Database navigator buttons can be used to move through the
records in the database. Use these buttons to see how data from different records will be used on the label. You can quickly verify if
the objects fit on the label.
Note: The buttons are accessible only when you have enabled
Data view on the label and when record selection in the properties of database link is disabled.

Using Design Toolbar
The design toolbar is used for:
l

Changing color of the objects.

l

Aligning objects.

l

Rotating objects.

l

Arranging objects.

Using Printing Toolbar
Preview labels on-screen.
Print the current label.
Test print the current label.
Print the label using the form generated in the application NiceForm.
If you want to print a label from the form, you must have a label
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already defined. The form file must also be prepared and linked to the
label.
Note: To link a form to the label, use the command Tools -> Design
Form.
Open the dialog box with printer properties. You can change the settings in the printer driver.
Quickly change the print direction of the label.

Using Text Toolbar
You can use text toolbar to quickly format the text objects on the label.

Here is how:

1. First select it the text object by clicking it.
2. Click the appropriate shortcut button in the text toolbar.
3. To change the font, select the appropriate font from the list in the list box.
Note: You can limit the display of fonts in the list. You can list all fonts on the system, only
graphic fonts (truetype, opentype, type1, bitmap Windows fonts) or only thermal printer resident
fonts. Click on the two icons next to the list of fonts.

4. To change the size of the text, click on the list with font sizes and select appropriate size.
You can also click on the buttons
to the next step.

and

that will enlarge/reduce the size of the font

Note: You can change the fonts size also directly on the label by resizing the text element with a
mouse.

5. To format the text bold, italic or underline, click on the appropriate formatting buttons.
Formats the selected text in bold style.
Formats the selected text in italic style.
Formats the selected text in underline
style.

6. To change the alignment of the text object, click on the appropriate alignment buttons.
Note: These buttons are accessible only for multi-line text objects.
Aligns text to the left edge.
Aligns text to the horizontal center.
Aligns text to the right edge.
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Using Toolbox
To use the toolbox, do the following:

1. Click on the icon in the toolbox to select the object.
2. Move the mouse over the label. See how the cursors has changed.
3. Click on the label where you want to place the selected object.
Some objects have additional shortcut on the right side of the icon. Using this shortcut you can
quickly create a new object with fixed content, create a new variable and connect it to the selected
object or connect the object to one already defined variable.

Using Variable Toolbar
The list box contains the variables available on the label. If you have selected some variable
object, the list box displays variable linked to that object. If no object is selected, selecting a variable then clicking on the label places new text object and links it to the variable.
Create new variable using the Variable wizard. If you click on the
small arrow, you can specify the type of the new variable.
Create new variable manually.
Edit the properties of the selected variable.
Note: If you select the variable object, the variable linked to the
object will be automatically listed in the list.
Delete the selected variable.
Note: If you want to delete the variable, you must not use it on the
label linked to label objects or used in functions.
Disconnects the variable from the object. The object becomes fixed,
but will preserve the formatting.
The number of the characters in the object will be equal to the length
of the variable. This might be useful when you are changing the database on the label and want to conserve current position and format of
the objects. When you re-connect the other database, you can simply
link the objects to new variables.
Access to the labeling software Functions dialog box. If you click on
the small arrow, you can select which new function you want to create.
There are several methods to connect a variable to some label element that should contain variable
values.
l

l

If you have the element already positioned on the label, select it, then choose the appropriate variable in the list.
If the element is not already on the label, you can first select the variable in the list and
then click the label where you want the element positioned. Text element will appear
there and will be connected to the selected variable.
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l

l

If you want any other element (and not text) connected to the variable, you can first
select the variable in the list, then click the desired element in the Toolbox and then click
the label.
You can click on the small arrow button next to the object icon in the toolbox, select the
option Use Existing Variable, select the variable from the list and click on the label.

Variable toolbar always shows the name of the variable, which is attached to the current selected
element. If there are two or more elements selected, and do not have the same variable attached to
it, then the variable combo box is empty.

Using Zoom Toolbar
Zoom in: This command increases the selected element or part
of the element.
Zoom out: This command decreases the selected element or part
of the element.
Factor: You can define your own factor of zoom (in %).
Zoom to label: You will see the entire label on the screen.
Zoom to page: You will see the entire page on the screen.
Zoom to objects: You will see all the objects on the screen.

Note: To be able to zoom into the label at custom zoom factor, you can click on the
button and the draw a frame on the section of the label you want to zoom in.
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Working with Objects
Using Text Wizard
Text Wizard

First screen of Text Wizard
Text Wizard guides you to define all parameters for the text object.
Fixed text: Select this option if you would like to have a fixed non-changeable content of the
object. If you select this option, you can enter the text directly in this dialog box.
Variable text: Select this option, if you would like to have variable content of the object. Defining
the content is defined in the next step.
Font: Currently selected font type is shown in this field.
l

Inverse: Enable this option to use the text in inverse.

Note: The option is not available for all printers.
l

Select button: You can select different font type for this text object among available
fonts in the system.
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Text Wizard - Choosing Variable Text

Text Wizard - Choosing variable text
Select the type of the variable field you want to use. If some of the option in the list is not accessible, the functionality is not available.
Variable name: Type in the name of the variable that will be linked to the barcode object and will
provide the value for it.
The next page of the wizard depends on your selection here.

Text Wizard - Keyboard Input
Use this variable type when you want the operator to enter a value of the variable from the keyboard before printing the specified numbers of labels.
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Dialog box for Text Wizard when Keyboard input option is chosen
Prompt text for this variable field: Fill in the message that will be shown to the user when he
will enter the values for the variable field.
Format: Select the format of data you allow to be entered for the variable field.
Set maximum number of characters: Define the maximum length of characters that can be
entered for the variable field.

Text Wizard - Counter
On this page of the wizard, you define the counter variable.
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Dialog box for Text Wizard when Counter option is chosen
Starting Value: Set the starting value for the counter. The counter will increment or decrement
from the starting value.
Note: You can enter only digits for the starting value.
Prompt for value before print: Tick this option to enable entering the starting value of the
counter when you start printing labels. Enter the text that will be shown to the user before printing.
The message will be shown on the screen each time when the label is to be printed.
Set maximum number of digits: Define the maximum length of digits the counter can occupy.
Increment or decrement: You can define that the variable value will increase or decrease from
label to label.
Preview: The field shows the preview of the counter, based on your selection.

Text Wizard - Counter Continuation
Step: Define the step for your counter. The counter will increase by this number on every label.
Change value every <n> labels: Define the number of labels, when the counter will change the
value.
Rollover when reached: Enter the value, when reached, will cause the counter to reset the value
to the starting value.
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Text Wizard - Date Field
Define the properties of the date field. The variable field will get the value from a computer clock.

Dialog box for Text Wizard when Date field option is chosen
Format: Select the format for your date from the list. You can also enter the custom format.
Date offset: You can add a certain numbers of days, months or years to a current date and print
that date instead of the current one.
Preview: The printer will print the date as shown on the Preview field. This way you can see how
the selected date format will look on the label.

Text Wizard - Time Field
Define the properties of the time field. The variable field will get the value from a computer clock.

- 62 -

Dialog box for Text Wizard when Time field option is chosen
Format: Select the format for the time from the list. You can also enter the custom format.
Preview: The printer will print the time as shown on the Preview field. This way you can see how
the selected time format will look on the label.

Text Wizard - Database
Variable field linked to the database gets the value from the specified database field.
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Dialog box for Text Wizard when Database option is chosen
Define: Click on this button to open the database wizard that will help you define the link to the
database.
Field: Choose one of the available database fields as a source for the variable field.
Length: Define the maximum length of the string in variable. If field in database contains more
characters, they will not be printed. This option is useful if the field length in your database is not
fixed (for example tab delimited ASCII file), or if you don't want to reserve space for all the characters in database's field.

Text Wizard - Prefix and Suffix
The variable element can have a prefix and suffix values. The prefix text is placed in front of the
variable's value. The suffix text is placed at the end of the variable's value.
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Setting Prefix and Suffix string for the variable text element
Note: If you leave the edit fields empty, the prefix/suffix will not be used.
Prefix and suffix can be used in situations where they are required only if the variable has set some
value. If the variable is empty, the prefix/suffix will not be printed as well.
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Using Barcode Wizard
Barcode Wizard

First page of barcode Wizard
Barcode Wizard guides you to define all parameters for the barcode object.
Fixed barcode data: Select this option if you would like to have a fixed non-changeable content of
the object. If you select this option, you can enter the text directly in this dialog box.
Variable text: Select this option, if you would like to have variable content of the object. Defining
the content is defined in the next step.
Note: When entering values for RSS composite barcodes, you need to provide the value for the
linear and composite (2D) parts at the same time.
Use the following syntax for entering values for RSS composite barcodes. The pipe character (|) is
used to distinguish between the components.
The syntax: <linear part>|<composite part>
The example: 12345|description

Barcode Wizard - Choosing Variable Barcode
Select the type of the variable field you want to use.
Variable name: Type in the name of the variable that will be linked to the barcode object and will
provide the value for it.
The next page of the wizard depends on your selection here.
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Barcode Wizard - Keyboard Input
Use this variable type when you want the operator to enter a value of the variable from the keyboard before printing the specified numbers of labels.
Prompt text for this variable field: Fill in the message that will be shown to the user when he
will enter the values for the variable field.
Format: Select the format of data you allow to be entered for the variable field.
Set maximum number of characters: Define the maximum length of characters that can be
entered for the variable field.

Barcode Wizard - Counter
On this page of the wizard, you define the counter variable.
Starting Value: Set the starting value for the counter. The counter will increment or decrement
from the starting value.
Note: You can enter only digits for the starting value.
Prompt for value before print: Tick this option to enable entering the starting value of the
counter when you start printing labels. Enter the text that will be shown to the user before printing.
The message will be shown on the screen each time when the label is to be printed.
Set maximum number of digits: Define the maximum length of digits the counter can occupy.
Increment or decrement: You can define that the variable value will increase or decrease from
label to label.
Preview: The field shows the preview of the counter, based on your selection.

Text Wizard - Counter Continuation
Step: Define the step for your counter. The counter will increase by this number on every label.
Change value every <n> labels: Define the number of labels, when the counter will change the
value.
Rollover when reached: Enter the value, when reached, will cause the counter to reset the value
to the starting value.

Barcode Wizard - Date Field
Define the properties of the date field. The variable field will get the value from a computer clock.
Format: Select the format for your date from the list. You can also enter the custom format.
Date offset: You can add a certain numbers of days, months or years to a current date and print
that date instead of the current one.
Preview: The printer will print the date as shown on the Preview field. This way you can see how
the selected date format will look on the label.

Barcode Wizard - Time Field
Define the properties of the time field. The variable field will get the value from a computer clock.
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Format: Select the format for the time from the list. You can also enter the custom format.
Preview: The printer will print the time as shown on the Preview field. This way you can see how
the selected date format will look on the label.

Barcode Wizard - Database
Variable field linked to the database gets the value from the specified database field.
Define: Click on this button to open the database wizard that will help you define the link to the
database.
Field: Choose one of the available database fields as a source for the variable field.
Length: Define the maximum length of the string in variable. If field in database contains more
characters, they will not be printed. This option is useful if the field length in your database is not
fixed (for example tab delimited ASCII file), or if you don't want to reserve space for all the characters in database's field.

Barcode Wizard - Prefix and Suffix
The variable element can have a prefix and suffix values. The prefix text is placed in front of the
variable's value. The suffix text is placed at the end of the variable's value.
Note: If you leave the edit fields empty, the prefix/suffix will not be used.
Prefix and suffix can be used in situations where they are required only if the variable has set some
value. If the variable is empty, the prefix/suffix will not be printed as well.

Defining Objects
Defining Text Object
To place the text object on the label, do the following:

1. Click on the Text icon in the Toolbox.
2. Click the position on the label, where you want to place the object.
Text Wizard dialog box will open.
3. Define the contents for the text object.
4. Click on the Next button to advance to the next step of the wizard.
5. Follow on-screen instructions in the next steps.
6. Click on the Finish button.
Note: Should you later want to edit the object, select it then double-click it. The wizard with properties appears.

Defining Text Box Object
The Text Box object enables you to use free-flow text inside the designed Text Box frame without
being limited to a one-line text. To create a Text Box object, do the following:
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1. Click on the
screen.

button in the Toolbox. The text box cursor appears on the

2. Move the cursor to the location on the label where you want to place the text box object
and click on the mouse button. The properties of the object will open.
3. Open the Value tab and type in the text content.

Entering value for Text Box object

4. Click on the OK button. The Text Box object is placed on the label.
5. Double click the Text Box to open its properties.
6. Go to the Detailed tab and select the option Best fit.
Note: When you change the size of the Text Box frame, the content will automatically align to
the new size.

All three text objects are available in the labeling software
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Defining Rich Text Box (RTF) Object
The Rich Text Box object enables you to format text in any kind of font types and styles. To create
a Rich Text Box object, do the following:

1. Click on the
the screen.

button in the Toolbox. The rich text box cursor appears on

2. Move the cursor to the location on the label where you want to place the text box object
and click on the mouse button. The rich text editor will open.
3. Enter the content.
4. Use the text toolbar in the editor to format the characters.
5. Click on the OK button. The Rich Text Box object is placed on the label.
6. Double click the Rich Text Box to open its properties.
7. Go to the Detailed tab and select the option Best fit.
8. Click on the OK button.
The text size in the Rich Text Box object automatically changes when you re-size it.

Defining Barcode Object
To place the barcode object on the label, do the following:

1. Click on the Barcode icon in the Toolbox.
2. Click the position on the label, where you want to place the object.
Barcode Wizard dialog box will open.
3. Define the contents for the barcode object.
4. Click on the Next button to advance to the next step of the wizard.
5. Follow on-screen instructions in the next steps.
6. Click on the Finish button.
Note: Should you later want to edit the object, select it then double-click it. The wizard with properties appears.

Defining Picture Object
To place the picture object on the label, do the following:

1. Click on the Picture object in the Toolbox.
2. Click on the label, where you want to place the picture.
The Open dialog box opens.
3. Browse for the picture on the hard disk, then click on the Open button.
Note: Should you later want to edit the object, select it then double-click it. The wizard or dialog
box with properties appears.
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Defining Rectangle Object
To place the rectangle object on the label, do the following:

1. Click on the Rectangle icon in the Toolbox.
2. Click the position on the label, where you want the upper-left position of the object to be
set.
3. Drag to bottom-right direction until the object size is as requested.
4. The other method of positioning the rectangle object on the label is simply selecting the
Rectangle tool and then clicking the label. A default-sized rectangle will appear and you
can re-size it using handles around the object.
Note: If you want to draw a square, grab a handle a on one of the rectangle corners, simultaneously press and hold Shift key, then re-size the rectangle. A square will be drawn. For
more useful shortcuts available in the software refer to the chapter Shortcuts.

4. To move a rectangle to a different position simply select it and drag it elsewhere on the
label.
Note: Should you later want to edit the object, select it then double-click it. The dialog box with
properties appears.

Defining Line Object
To place the line object on the label, do the following:

1. Click on the Line object in the Toolbox.
2. Define the line starting point by clicking the mouse at the start position.
3. Move the cursor to the end point, while holding down the mouse button.
A line will be drawn from the left to right side of the label.
Note: If you need to draw a vertical line, just click for starting point then drag the cursor in the
up-down direction.

Defining Ellipse Object
To place the ellipse object on the label, do the following:

1. Click on the Ellipse icon in the Toolbox.
2. Click the position on the label, where you want the upper-left position of the object to be
set.
3. Drag to bottom-right direction until the object size is as requested.
4. The other method of positioning the object on the label is simply selecting the Ellipse tool
and then clicking the label. A default-sized ellipse will appear and you can re-size it
using handles around the object.
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Note: If you want to draw a circle, grab a handle a on one of the ellipse corners, simultaneously
press and hold Shift key, then re-size the ellipse. A circle will be drawn. For more useful shortcuts available in the software refer to the chapter Shortcuts.

4. To move a ellipse to a different position simply select it and drag it elsewhere on the
label.

Defining Inverse Object
To place the inverse object on the label, do the following:

1. Click on the Inverse icon in the Toolbox.
2. Click the position on the label, where you want the upper-left position of the object to be
set.
3. Drag to bottom-right direction until the object size is as requested.
Note: If you want to draw a square, grab a handle a on one of the rectangle corners, simultaneously press and hold Shift key, then re-size the rectangle. A square will be drawn. For
more useful shortcuts available in the software refer to the chapter Shortcuts.

4. To move a inverse to a different position simply select it and drag it elsewhere on the
label.

Curved Text
To place a curved text object on the label, do the following:

1. Click on the Curved texticon in the Toolbox.
2. Click the position on the label, where you wish to place the object.
The Curved Text dialog box will open.
3. Define the contents for the object.
4. Click OK to place the object.
Note: Should you later want to edit the object, select it then double-click it. The wizard with properties appears.
Using Contents Mask

Contents mask is very useful when you must display the input data differently on the label. With
contents mask you can simply reformat the data to suit your needs.
For example, you must use differently formatted human interpretation text below barcode than
the data is formatted in the barcode. You do not want to define two variables for this purpose and
enter the similar data twice.
The mask character will be replaced by the actual data and any other used character will be used
as-is. If the current barcode value is
"AD951"

and the contents mask is
"**C - ** /*/"

the resulting output will be
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"ADC - 95 /1/"

Powerful formatting structures can be defined using Contents mask, but it is only available with
barcodes that allow custom formatting of the human interpretation. You should also make sure to
print barcodes as graphics, otherwise the contents mask is not available.
Note: If your data contains the asterisk "*" character, then you will have to change the default
mask character to something else. It should be a unique value, not appearing anywhere in the
data.
The contents mask functionality is available with Text and Barcode objects.
Style Tab

In the Style tab the appearance of the object can be set.
Font: Click on the button Select to open Windows dialog box for selecting font for the object.
Note: If the currently selected printer is a thermal printer, there will be some additional fonts
available in the list. They are printer internal built-in fonts identified by printer icon in front of
their names.
Effects: Define the effects for the object.
l

l

l

l

Inverse: If selected, text is printed in reverse. This option is available mainly for
truetype fonts. Only a few thermal printers support this option with internal fonts.
Mirror: If selected, text is printed mirrored. Most thermal printers do not support this
option, so you will have to use truetype fonts to print mirror text.
Stacked text: If selected, the character will not be aligned in left-right order next to
each other, but in top-bottom order one on top of the next one. The text orientation is
remains the same, just the alignment within the element changes.
RTL printing: If selected, the internal printer text will be printed in right-to-left order.
It is useful if you operating system does not have native RTL support but you still need
to print text in this manner.

Note: For RTL printing option to work, you printer has to have an internal right-to-left printer
font built-in, for example: Hebrew or Arabic font. This option only works with internal printer
fonts and not Truetype fonts.
Font scaling: This is a factor that defines, how much the font is stretched from its original proportions. If the factor is 100%, the font has a normal look. If factor is 200%, it means that font is
twice as wide as normal. If it is 50%, the font is stretched.
Alignment: Define how the text will be aligned within the object, when using multi-line text.
l

None: No alignment is used.

l

Left: Text is aligned to the left side of the object.

l

Center: Text is aligned to the center of the object.

l

Right: Text is aligned to the right side of the object.

Spacing: Define the custom spacing in the object.
l

Line: The distance between lines of text.

l

Character: The distance between characters in the line of text.
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Color: Click on the Color button to change the color of the object.
Note: Text will be printed in color only on printers that support color printing. These are mostly
ink jet and color laser printers, but also some thermal printers.
Appearance Tab

Position and Size: Enter the new values for position and size in the relevant fields. The origin of
the coordinate system on the label is upper left corner of the label. This dialog box should be
used for fine-tuning the placement and dimensions of the element. Another method of fine-tuning
is using Label Inspector functionality.
Keep aspect ratio: Locks the ratio of the element. When you change the height, width is automatically adjusted so that the element is not distorted and vice-versa.
Rotation: It is possible to set the rotation of the objects in steps of 90 degrees anti-clockwise to
fit the appropriate position.
Anchoring point: Set the corner of object bounding box that is used for positioning the object on
the label. This is the corner where the element is pinned on the label. For example, if you select
the upper left button here, then upper left corner of the object will be placed to position that is set
above. If the object is variable, it will enlarge to the right side of the anchoring point. If you want
the object to enlarge on the left side, set the anchoring point to the right side.

Using GS1-128 Wizard
Using GS1-128 Wizard
This wizard allows you to define the data structure for GS1-128 barcode. This kind of barcode has
different areas of application that include trade items, logistic units, assets and locations.
The GS1-128 barcode is an extremely flexible symbology. It allows representation of data of variable length, and makes it possible to encode several pieces of information in one barcode symbol.
This is called concatenation. An Application Identifier is the field of two or more characters at
the beginning of an data value. Application identifiers are prefixes that uniquely identify the meaning and the format of the data field following. The data fields are either of fixed or variable length,
depending on the AI.
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Step 1: Choosing the application identifier

GS1-128 Wizard: Choosing application identifier
The dialog in the first step of Wizard allows you to select the GS1-128 barcode data structure.
Each barcode is composed out of one or more Application Identifiers and the corresponding data.
Choose one of the Application Identifiers in this list. You can add, edit or delete Application Identifiers from the barcode later in the process.
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GS1-128 Wizard: How check digit should be applied
If you have selected the Application Identifier which data includes a check digit (for example, AI
(01) - GTIN, Global Trade Item Number), then first you will have to select how the check digit
will be applied. The possible options are:
n

Automatic calculation: Check digit will be calculated by the application.

n

Check digit to be entered with data: Manually enter the data and check digit. The
application will verify, if the entered check digit is valid.
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Step 2: Application Identifier Input Type

GS1-128 Wizard: Where the data for AI is obtained from
When the Application Identifier is selected, you will have to define where is the data for its value
obtained from. There are three possible options:
l
l

l

Fixed: The application identifier will have the fixed value on every label.
New variable: The application identifier will be linked to the variable and have variable
value on each label. You will define a new variable.
Use existing variable: The application identifier will be linked to the variable and have
variable value on each label. Select the existing variable from the list.

Step 3: Entering the value for the Application Identifier
Entering fixed value for the application identifier
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Entering fixed value for the application identifier
If you have selected fixed value in the previous dialog box, you should enter value for the Application Identifier here. The Wizard will let you know about the required data format fort this AI and
how long the AI value should be. For some AI's the field length is fixed to certain number of digits,
for others only the maximum number of possible digits is stated. You will also be reminded of the
AI's proper field format (numeric, alphanumeric) if you enter incorrect data.
Entering variable value for the application identifier
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Creating new variable for the application identifier
If you have selected new variable value in previous dialog box, a new variable field will be created. You will have to provide some information about variable being used.

Calculating Check Digit
Select how the check digit will be calculated.

1. You can enter the check digit with the data and the software will validate it.
2. The software can calculate the check digit.

Defining New Variable
Define the properties of the variable that will provide value for the application identifier.
Prompt: Enter the text that will be displayed to the user at print time.
Format: Define the format of the variable.
Counter: If the variable will be a counter, define its properties.
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Step 4: List of selected application identifiers

Listing the selected application identifiers
This is the last step of the GS1-128 Wizard. Here you can add, edit or delete Application Identifiers and define separator among them.
Application Identifiers selected: In this field all selected application identifiers for the barcode
are listed in the order of creation. You can change the order with the arrow buttons.
Add, Edit or Delete buttons: Use these buttons to add additional application identifiers and edit
or delete existing ones.
Input Application identifier delimiter:Define left and right separator among different application
identifiers. The default setting is to use round parenthesis.
Preview: A sample barcode content based on your application identifier selection is shown here.
Click the Finish button to exit the wizard.
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Selecting Barcode Type
Settings for Advanced Barcodes
GS1-128 Barcode

This barcode is combined from one or more input values and standard AI - Application Identifiers.
Each AI must be followed by the standard values. These values can be fixed or variable.
When the GS1-128 barcode is selected, the Barcode data field in the Barcode Wizard dialog box
is disabled. To define the contents of the barcode, click the Next button.
From the list of available Application Identifiers select the first identifier. It will be written in
bracket bellow the barcode.
When the Application Identifier includes also check digits, you have to define whether it will be
calculated or entered together with data.
Next, define how you will set the values for the selected identifier. You may enter fixed value or
define variable value.
Fixed values
When values are fixed, the Wizard dialog box will inform you what is expected to be entered –
digits the maximum places...
The defined AI is presented on the list of selected Application Identifiers. Click the Add button to
add a new AI or on the Delete to delete existing one.
Should you need to change the AI and the data, select the AI and click the Edit button.
You can sort the listing of AI by using the Up and Down buttons.
All the settings can be previewed on the Preview field.
The separator among Application Identifier can be defined by entering the required separator for
the left and for the right side of the Application Identifier. The default separator is bracket.
Variable values
GS1-128 barcode supports keyboard variables – the variable data will be entered from the keyboard.
You can define the Prompt – the message for the operator, who will enter the data.
The data can be numeric only or the operator is allowed to enter all characters.
The value can be fixed or incremented/decremented on every label or certain number of labels
with the desired step.
The variable data will be written in the Preview field as a series of "A" character.
When you are satisfied with the settings, click the Finish to put the GS1-128 barcode to the label.
PDF 417 2D Code

General tab
Y expansion factor
This option defines the height of the barcode symbol.
Security tab
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Accordingly to the standard, you can select among 9 levels of security. Higher security level
allows more reliable reading regardless errors, but the barcode symbol is bigger.
Truncated barcodes can be used where label damage is unlikely and there is no demand for very
high level of security. The truncated symbol is smaller.
Aspect Ratio
It is the ratio between number of columns and number of rows.
Contents
PDF 417 code can encode:
l

Full 128 ASCII character set

l

All 128 Extended ASCII characters

l

8-bit binary data

DataMatrix Barcode

General tab
Y expansion factor
This option defines the height of the barcode symbol.
Aspect Ratio
It is the ratio between number of columns and number of rows. Enter the wanted value in the
fields.
Details tab
ECC Type
Error Correction Codes define the security level. You can select one from the standard levels in
the pull-down menu.
Format ID
This option defines which character set will be used in the barcode. You can select one of the
formats with the following filter.
01 and
11
02 and
12
03 and
13
04 and
14
05 and
15
06 and
16
07 and
17

0..9, space
A..Z, space
A..Z, 0..9, space
A..Z, 0..9, space,.-/
7-bit ASCII lower part (from 0 to
127)
all
7-bit ASCII
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The formats from 1 to 7 allow the data length to 500 characters, while formats from 11 to 17 allow
to 2000 characters.
Border Size
Factors from 1 to 15 set the dimension of the border in the shape of the character “L”.
Data Matrix can encode:
l

Full 128 ASCII character set

l

All ISO characters

l

All EBCDIC characters

MaxiCode

MaxiCode is a public domain, machine readable symbol system originally created and used by
United Parcel Service (UPS). Suitable for tracking and managing the shipment of packages, it
resembles a barcode, but uses dots arranged in a hexagonal grid instead of bars.
A MaxiCode symbol (internally called "Bird's Eye" or "Target") appears as a 1 inch square, with a
bullseye in the middle, surrounded by a pattern of hexagonal dots. It can store about 93 characters
of information, and up to 8 MaxiCode symbols can be chained together to convey more data. The
centered symmetrical bullseye is useful in automatic symbol location regardless of orientation, and
it allows MaxiCode symbols to be scanned even on a package traveling rapidly.
All MaxiCode symbols include a Structured Carrier Message containing key information about a
package. This information is protected with a strong Reed-Solomon error correction code, allowing
it to be read even if a portion of the symbol is damaged. These fields include:
A national postal code. MaxiCode supports both numeric postal codes (e.g. a ZIP Code), and alphanumeric postal codes.
l

A 3-digit country code encoded per ISO 3166

l

A 3-digit class of service code assigned by the carrier

l

A 20-character tracking number

l

A 2-4 character code indicating the originating carrier

Additional information can be encoded in a MaxiCode symbol, but it may require reduced error correction protection:
l

Purchase order number

l

Customer reference

l

Invoice number

The labeling software supports two Maxicode modes:
l

Mode 2 - Used for numeric postal codes (primary use is US domestic destinations)

l

Mode 3 - Used for alphanumeric postal codes (primary use is international destinations)

You can define the values for individual data fields. The values can be fixed, just type in the value.
You can also link the Maxicode fields with some of the variable defined in your label template.
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Edit Barcode Dialog Box
This dialog box is displayed when you click the Define button on the Barcode dialog box.
In this dialog box you specify the type of barcode you want to use on the label and all barcode properties:
n

How the barcode should be generated

n

Automatic or manual check digit calculation

n

Position of the human readable

n

Other options dependent on the barcode type

Click the option Enable preview to preview the barcode. The barcode symbol was displayed on
the right side of the dialog box.
Click the OK button to confirm the changes you made.
Click the Cancel button to discard the changes.

General Tab
On this tab you can select the barcode type you want to use and the properties of the barcode.

Edit barcode dialog box – General tab
Type of barcode: The required barcode symbology is selected from the tree list of available barcodes.
Symbol height: The height dimension of a barcode can be specified either by entering a value here
or by resizing the barcode symbol directly on the label.
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Narrow bar width: The width of the narrowest bar in the barcode. This is the base bar width. The
widths for all wider bars are calculated by the formula: 'narrow bar width' * 'ratio'. The result of
the formula must be a whole number (it represents number of pixels).
Ratio: This is the ratio between narrowest and widest bar in the barcode. The ratio is locked for
majority of barcodes and you cannot change it. However, for some barcodes you can change it and
adjust the barcode size to your needs.
Space correction: Enable this option to insert additional white pixels for each white space in the
barcode. The option is useful for Ink Jet printers where the ink can spill out and you need an extra
space between bars for the reader to decode the barcode properly.
Base object width: Shows the width of a narrowest bar in the barcode.
Print barcode as graphics: Select this option to convert the barcode object into the image and
sent to the printer as image. If not selected, the barcode will print as printer internal object. Printing barcodes as internal printer objects will speed up label printing, because less data must be transferred to the printer.
Note: To disable the option Print barcode as graphics, you must use the printer drivers that ship
with the software, NiceLabel Printer Drivers.
Enable preview: Enable this option to see the preview of the selected barcode type. The preview
will show on the right side of the dialog box.

Check Digit Tab
This tab is used to specify if you want to use the check digit in the barcode or not. This option can
only be modified for the barcodes that allow you to enable and disable the check digit.
Some barcode standards include the check-digit by the definition and it cannot be omitted. An
example of such barcodes are EAN and UPC barcodes, where check digit cannot be disabled at
all. But some codes allow you to freely enable/disable check-digit.
Note: It is always recommended to include the check digit character in the barcode. It will
increase the scanning reliability.
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Edit barcode dialog box – Check digit tab
You can choose whether you want to input the check digit value, or let the program calculate it for
you:
Auto-generate check digit: Check digit is calculated by the software. You must only enter the barcode data. For example: when using EAN-13 barcode input the first 12 digits, check digit on 13th
place will be calculated and added automatically.
Verify the provided check digit: Use this command when you want to enter the value for the
check-digit. At print time the entered check digit it will be verified for validity.
Enable custom check digit algorithm: You can set some other algorithm you want to use for calculating the check digit. Click on the button Select to choose the algorithm.

Human Readable Tab
On this tab you can set the options regarding position and format of the barcode interpretation.
No interpretation: Barcode object does not have any human interpretation.
Below barcode: All data encoded in the barcode is placed beneath the barcode symbol as human
readable characters.
Above barcode: All data encoded in the barcode is placed above the barcode symbol as human
readable characters.
Font: Using the Font button, you can choose the suitable font for auto-translation text. The option
Auto font scaling will adjust the font of the auto translation text to the size of the barcode.
Note: You can only format the font for human interpretation, if the barcode is printed as graphics. When printing barcode as internal printer object, the printer will print the interpretation using
resident built-in fonts.
Contents mask sets the custom format of the human interpretation.
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Edit barcode dialog box – Human readable tab

Details Tab
On this tab you can define advanced settings for the barcode.
Note: Not all of these options are available for all barcodes and printers.
Include quiet zones: By checking this field you set, that the barcode will have some white space
in the front and in the end for increased readability.
Descender bars: Some bars of a barcode will be longer than others. This is typically used with
EAN and UPC barcodes that have longer bars in the begging, in the middle and in the end of the
barcode.
Mirror horizontally/mirror vertically: The barcode can be mirrored vertically and horizontally.
barcode will usually have to be printed as graphics for this option to be accessible.
Intercharacter gap: Some barcodes allow you to change the gap between characters in the barcode (e. g. Code-39).
Include EAN white space: Before and after the barcode a special character is inserted, < or >. It
indicates the width of the barcode. If you put any other object in the extent of the barcode, it will
reduce the readability of the barcode. This option is only valid for EAN barcodes.
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Edit barcode – Details tab

Supported Barcode Types
Barcode
Group
EAN and
UPC

Linear

GS1
Databar

Two-dimensional

Barcode Types
EAN-8, EAN-8 + 2-digit supplement, EAN-8 + 5-digit supplement,
EAN-13, EAN-13 + 2-digit supplement, EAN-13 + 5-digit supplement, EAN-14, DUN-14, UPC Case Code, UPC-A, UPC-A + 2digit supplement, UPC-A + 5-digit supplement, UPC-E, UPC-E +
2-digit supplement, UPC-E + 5-digit supplement, UPC-E(1), GS1128, SSCC, Bookland, Addon 2, Addon 5
Interleaved 2 of 5, ITF 14, ITF 16, Code 39, Code 39 Tri Optic,
Code 39 Full ASCII, Code 32, Code 93, CODE 128 (A, B and C
subsets), Code 128 Pharmacy, MSI, Codabar, Postnet-32, Postnet37, Postnet-52, Postnet-62, Kix, Pharmacode, Plessy, Anker
Linear GS1 Databar symbologies
RSS14, RSS14 Truncated, RSS14
Stacked, RSS14 Stacked Omnidirectional, RSS Limited, RSS
Expanded
Composite GS1 Databar symbologies
RSS14, RSS14 Truncated, RSS14 Stacked, RSS14 Stacked Omnidirectional, RSS Limited, RSS Expanded, UPC-A, UPC-E, EAN-8,
EAN-13, EAN.UCC-128 & CC-A/B, EAN.UCC 128 & CC-C
2D-Pharmacode, PDF-417, DataMatrix, MaxiCode, Aztec, QR,
MicroQR, Codablock F, MicroPDF.
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Working with Images
Place Images on the Label
To insert an image to the label, use the Picture object in the toolbox and browse for the image file
on the disk. The supported image types are displayed in the Browse dialog box. If the image size is
too big for the current label dimensions, the image will be proportionally re-sized to fit into the
label. You can also freely re-size the image by dragging the handles surrounding it. The image can
be re-sized proportionally or stretched in both directions.
The images can also be placed on the label from the clipboard or imported from another applications, such as graphical designers, and scanning programs, using either the Insert Object or Paste
command from the Edit menu. In both cases, the graphics is embedded in the label file.
Note: When you insert the graphics as OLE object on the label (copy/paste from other software),
the entire design environment of that other software is available in label design. When you double
click such OLE object, that other application opens on the label. When using OLE object, the
label processing might be slower. A label also occupies more space on the disk and takes more
RAM. If possible, avoid using OLE objects on the label.
Once you place a fixed picture on the label, you can embed it in into the label. The picture will be
saved inside the label, so you no longer need the original picture on the disk. It makes the label
more portable. If you copy the label to some computer the picture goes with the label.
There are the following types of image embedding:
l

l

l

To embed the selected image in current the label, open the picture properties and select
the option Embed into label.
To embed all images into the current label use the command Transformations ->
Embed all Pictures into Label.
To enable automatic embedding of all images that you will place on the label from now
on, enable the option Embed graphics into label in Tools -> Options.

Use Variable Images
When you use variable pictures on the label, usually you will provide the path and file name of the
picture stored in some file system. The labeling software will locate the image file and use the picture on the label. The picture name can be acquired from different sources (contents providers):
keyboard prompt, field in a database, result of some function etc.
To create a variable picture object, do the following:

1. Make sure you already have an appropriate variable designed that will store the path and
name of the picture on the disk.
2. Click on the small arrow button next to the Picture object
box.
3. From the drop-down menu select the option Use Existing Variable.
4. Select the appropriate variable from the list of available variables.
5. Click on the label where you want to create the variable image object.
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in the tool-

Hint! If all images are of the same file format and you store all images in the same folder you
can define a prefix and suffix to the variable. When the variable will obtain the image name as
its value, prefix will provide the path to the image and suffix will provide the file extensions. This
way the whole path and extension of the graphics file will be added automatically, you just have
to provide the image name.
For example: If you set the variable prefix to "C:\GRAPHICS\" and suffix to ".JPG" while the
variable has the value "ROSE", the result will be "C:\GRAPHICS\ROSE.JPG". The labeling software will try to locate this image and use it on the label.
When you define graphics as an variable object (some variable defines the path an file name of the
picture), the labeling software does not know the size of the picture in advance, because this
information is provided only at print or preview time. Until the picture name is known, the picture
is previewed as a question mark.
Usually you will print the images from files that originate in some file system. However, you can
also use the images that are stored in the database BLOB fields. In this case there is no file name
on the disk; the whole image is in fact stored in the database.

Using Transparent Images
NiceLabel supports the image transparency (opacity). Transparent images are without any background, but use a see-through background. You can stack the transparent images on top of each
other on the label and the top image will not cut rectangular shape out of the images lower in the
stack. Transparency is honored when you use NiceLabel printer drivers and also when printing to
non-NiceLabel, Postscript and full-color printers.
You must use the valid image file formats that supports transparency. The popular format are
PNG, PSD and WMF.
Note: If you embed your images into the label, make sure you have the option Compress embedded graphics stored in the label enabled in the program preferences.

Using Variable Pictures from Blob Fields
You can use the pictures stored in the database BLOB fields. These database fields do not contain
the reference to the image location in some file system (path and file name), but contain the image
itself. The labeling software will read the data from the BLOB field.
If the data from blob field is identified as the image it will display as the image on the label, when
you link such database variable with the picture object. You can connect such field to any label
object, not only picture object. But the field value will be as follows:
[IMAGE ext=XXX] ID
where:
XXX stands for the image extension that defines the image type
ID stands for the internal number that identifies each image from the database uniquely.
When you use the BLOB fields with MS SQL database server, you can embed different image
types into the fields (BMP, JPEG, GIF, PCX, TIFF, PNG, TGA, PXM, ICO, JP2, J2K). However,
when you use some other database type, not all types might be accessible. Bitmap (BMP) format is
always supported.
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Handle Missing Images
The labeling software remembers the path and file name of the picture that you place on the label.
Each time you open the label, the labeling software checks if the pictures is accessible and then
uses it on the label. If the picture is missing, you will see a warning dialog box. You can:
l

Ignore the error and temporarily design the label without the needed picture.

l

Discard the missing picture and permanently remove it from the label.

l

Browse to the missing picture if you have changed the picture folder location or file
name.

Designing Objects with Relative Positions
During the regular label design process you put the objects on the certain spot on the label and they
occupy that space whenever the label prints. If you link object with variables, the objects become
variable object. If linked variables contain more data, the objects will usually increase their size
and occupy more space. You must be careful to anticipate the maximum variable length and design
your objects accordingly so the objects do not overlap each other or exceed the label boundaries.
However, in some cases you need the object to change its placement on the label.
For example: You have a multi-line text object and barcode on the label. The barcode must
always print below the text object. To solve the problem, you must link the objects together. The
text object is a parent object, the barcode is linked to is as a child object. You can lock the vertical
position of the barcode to the bottom of the text object. You can also define the offset between the
object.
See the scheme below. The barcode changes its vertical placement. The vertical distance between
the text and barcode object is always 1 cm, no matter the number of lines in the text object.

Variable positioning of the barcode object (linked to the bottom of the text object)
The placement of each label object can be variable. You can define the placement based on the
label border or based on the distance from some other label object. In each case, you can define
the offset from the border or other object. Of course, you can define object horizontal and vertical
relative positions independently of each other.
To enable the relative positioning of the object, do the following:

1. Open the object's properties.
2. Go to the Appearance tab.
3. Click the Advanced button in the Anchoring Point section.
4. Define the appropriate horizontal and vertical relative position.
5. Click OK when ready.
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When defining the relative object positions you might also want to enable the variable label sizing.
The length of the label can also adapt to the size of the objects.
Rules for Relative Positioning
l

Object positions can be relative to another object borders.

l

Object positions can be relative to another label borders.

l

Object vertical positions can be relative to the objects on the back side.

l

You can define offsets between objects and borders.

l

l

l

l

l

You can enable the variable label sizing. When some object with relative positioning
overlaps the label borders, the labeling software can adjust the label length and
increase/decrease the label dimensions.
Variable label sizing takes into consideration the other side of the label as well (if
double sided printing is enabled).
When you export the label to printer (File -> Export -> Export to Printer on supported
printers), the links between the object break and the objects will have fixed positions.
When you group objects then if the selected objects are dependent of some other
objects, the parent and slave objects are all grouped together.
You cannot delete the parent object. First remove the links to the child objects so it
becomes stand-alone object, then remove it.

Rotating Label
To rotate the label on the screen, do the following:

1. Click on the
icon in the top left corner of label design area (where vertical and horizontal ruler collide).
2. The label will rotate for 90° clockwise.
Each click on the button will rotate the label for additional 90 degrees. The initial rotate position is
portrait. Each click will rotate the label to the next position. The positions in line are: portrait, landscape, rotated portrait, rotated landscape.
Rotating the label on screen will help you define label easier, when the objects on the label must
be printed rotated, but you want to be able to design the label in the upside orientation.
Note: If you do not use NiceLabel Printer Driver or your printer does not support 180° printing,
then only two rotations are possible (portrait and landscape).

Selecting Objects
To select two or more objects, you should press the <Shift> key, and hold down, while clicking the
object with a mouse.
The objects can be selected, cut, copied, pasted and edited with the right mouse button. If you click
the right mouse button on the object, the menu shows all the available commands. Note that these
commands are equivalent to correspondent menu commands.
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You can also change the anchoring point of a selected object by holding <CTRL> while clicking
the placeholders (corners of the bounding box) of the object.

Editing Objects
To edit the properties of the object, do the following:

1. Double-click the object on the label.
The dialog box with object properties will open.
Note: You can also press the <Enter> key, while the object is selected.

2. Make modifications to the object properties.
3. Click on the Finish button.

Moving Objects
To move the object on the label, do the following:

1. Select the object.
2. Click on the object with the left mouse button.
3. Hold the mouse key pressed.
4. Move the position of the cursor on the screen.
The object will move with the cursor.
Note: When you move the object, it fades in the preview window, so that you may be able to position it more accurately. The opacity will return to normal when the object is placed in its new
position.

Aligning Objects
First you have to select objects that you want to align.
Note: All objects are aligned relatively to the first selected object.
Then click appropriate buttons in the Design toolbar to align selected objects to each other. If
Align toolbar is not visible (by default it is located on the very right side of the window), enable the
Design toolbar in Toolbar option in View menu.
You can align objects to:
Left
Right
Horizontal center
Top
Bottom
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Vertical center
You can also distribute object evenly, so that spacing between them is equal:
Horizontally
Vertically
Note: If you hold the <CTRL> key while clicking the buttons, objects are aligned relative to
label and not to the first selected object.

Resizing Objects
To re-size the object on the label, do the following:

1. Select the object.
The selected object is framed with a rectangle.
2. Click on one of the small rectangles in the corners of the rectangle.
3. Hold the mouse key pressed.
4. Move the position of the cursor on the screen.
The object will re-size with the cursor.

Rotating Objects
To rotate the object, do the following:

1. Select the object.
2. Click on the
icon in the design toolbar.
The object will be rotated for 90° clockwise.
Note: If the design toolbar is not visible, select the command Toolbars in the View menu, then
click on the Design.

Grouping Objects
You can work with individual objects on the label, or you can group the objects into groups of
objects. When you group two or more objects into a group, the objects behave as one single object
on the label. In some cases the grouping feature will make the label design easier.
To group objects on the label, do the following:

1. Select two or more objects on the label.
2. Select the Group from Transformations menu.
The individual objects will be grouped into one group.
Note: To ungroup the objects in a group you must use the command Ungroup from Transformations menu.
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Clipart Galleries
The distribution of labeling software includes a library of frequently used clipart images that you
can use on your labels. Images are stored in bitmap (.GIF, .JPG) and vector (.WMF) file formats.
Clipart Galleries incorporate useful images from retail, logistics, chemical, automotive and other
industries. Subset of these galleries is included within the two Font files, but for the whole collection of available symbols you should browse the galleries.

Font Files
Along with the labeling application you have also got two fonts with graphical symbols. You can
use them on your labels. They contain frequently used care symbols (used in textile industry), symbols for handling dangerous materials (used in chemical industry) and many other useful industry
symbols. The fonts are not automatically installed on your system, but should you require them,
they are stored on your CD-ROM. They are accessible from the folder X:\Utility\Fonts, where X
represents the letter of CD-ROM drive in your system.
The fonts are in standard TrueType format and can be installed using Fonts utility in Control Panel.
They are accompanied with two document files that include all symbols from the fonts in a easily
scanned formatted table.

Character map of Care Symbols Font - CARESYM.TTF
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Character map of EP Symbols Font - EPSYM.TTF

Supported Graphics Formats
The following graphical formats are supported:
File extension
BMP, DIB,
RLE
GIF
JPG, JPEGM
JPE
TIFF, TIF,
FAX, G3N, G3F
PNG
WMF
EMF
ICO
CUR
TGA, TARGA,
VDA, ICB,
VST, PIX
PXM, PPM,
PGM, PBM
JP2
J2K, JPC
PCX
PSD
PDF

Graphics type
Windows Bitmap
CompuServer Bitmap
JPEG Bitmap
TIFF Bitmap
Portable Network Graphics
Windows Metafile
Enhanced Windows Metafile
Windows Icon
Windows Cursor
Targa Bitmap

Portable Pixmap, GreyMap,
BitMap
JPEG2000
JPEG2000 Code Stream
Paintbrush
Adobe Photoshop
Adobe Portable Document
Format
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Working with Text Objects
There are two modes of operation, which can be set by setting program preferences. The first
(default) is "On screen edit". This means, you can enter text directly on the label, similar to a word
processor program. When you have typed the contents, you can cancel typing by pressing <ESC>
key, or confirm it by pressing <CTRL+ENTER>. The text object is created.
The second mode immediately opens the dialog box for the text, where you can enter the contents
and set all other properties of the text. This dialog box can also be opened any time by double clicking the text object or by right clicking the object and selecting Edit from menu.

Working with Variable Data
Dynamic Data Overview
You may want to print labels on which data changes for each label, for example, counters, serial
numbers, date and time, weight, article pictures… To accommodate the changing data, the labeling
application can easily be used to format labels using variable data, special functions on variables,
and databases.
There are several types of variables you can choose, and functions, which you define, to best suit
your needs. Data that must be printed as a variable is prepared at the time of printing, and can be
entered in the program from different sources i.e. keyboard, databases, system clock, etc. The variable data can be the same for a quantity of labels or/and specific for one label only.
To understand how variable data is handled, a few terms must be explained: variables, functions
and database access.
Variables

Variables in this labeling application are much like ordinary variables; they simply don't have
constant value. The basic idea of variables was to allow you to type the variable value just
before printing the label, but this has expanded a lot. You can now automatically get correct
value from a database or perform a calculation on existing variables and take the result as a variable value.
A variable also has several properties: its name, type (text, numeric, date…), maximal length of
value in characters and many more. One other important, but fixed property is the input for specific variable (keyboard, database, function, system clock…).
Functions

Functions are very powerful tool, which offers almost unlimited possibilities to the user, when
processing data for the label. The function takes some variables as input, make some processing
on the data, and return the result in one or more variables that contain new values. Complexity of
function varies from simple concatenating of two variables to very complex manipulation of
external data.
For example, you can use functions to concatenate two strings of data to one if they are separate
in database like FIRST_NAME+LAST_NAME. You can also do numeric calculations on variables. That way you can for example have the weight on a label displayed in pounds, although
the weight in database is in kilograms. Using the built-in Visual Basic scripting you can add any
functionality to the labeling software you can possibly need.
Database Access
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If you have existing database on your computer (or network) you can use that database to print
labels. Simply create a special database function that gives you variables you can use to access
the specific records in your database. That way you can completely automate the process of printing the labels for your product.
For example, as new products are created, you fill a special table with serial numbers of those
products. The application then uses this table as source to print appropriate labels.

Contents Providers
Contents Providers
Contents Provider is an expression for any method that can be used as an source of data for
objects on the label. It is applicable to all label objects that can have some sort of data associated
with them (Text, Text box, Rich text box, Barcode and Picture).
The contents provider for objects can be one of the following:
Fixed

Variable

When you select Fixed, you can enter a desired value in the edit
box. This value will remain the same on each label. To edit the
text, all standard Windows editing features (cut, copy, and paste)
can be used. If you need to enter some special character, that is
not accessible via keyboard, click the button with the arrow to the
right of the dialog box. You can also right-click anywhere in the
edit box and select "Insert special character" from the menu.
When the Variable option is selected, you can connect any variable field to the object, just select the appropriate variable name
from the list. This approach will allow you to change the object
value on the labels.
Object is connected to some variable. The variable is defined on
the label. Its type can be Keyboard Input, Counter, Date/Time
field etc. When variable's value changes, the change will be reflected in the appearance of the selected object.

Functions

Database

If no variable is defined on the label, you should first create one.
Click Wizard button to start Variable Wizard, that will guide you
through the steps of creating the variable. Variable field will be
created very easily, but cannot be used for setting of all the
options. For advanced variable setup click New button. Edit button will let you change properties of selected existing variable.
You will find more information about variables in the topic Variables.
When this type of contents provider is selected, you can select the
proper function from the list of defined functions and then also the
output function-generate variable. This variable will be the source
of data for the object.
Click New to create new function. Click Edit to change function's
properties.
When this type of contents provider is selected, you can select the
proper database from the list of defined database connections.
Then select the proper field from this database. This field will be
the source of data for the object.
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Expression

Visual
Basic
Script

Click New to create connection to new database (click Wizard to
use the wizard for the connection). Click Edit to change function's
properties.
Expression is an simplified version of Visual Basic Script. Expression can be used in situations when you want to manipulate existing variables, extract some sub-string or perform a quick
calculation and you do not want to write a dedicated Visual Basic
script. For this purpose Expression will do just fine. You can
enter one-line expression in the edit field that will be validated at
print-time. Of course all Visual Basic scripting commands can be
used in here.
An entire Microsoft Visual Basic Script functionality can be
included on the object. Each object can have assigned its own programming script for advanced functionality.
Visual Basic Script option will allow you to use a complete implementation of Visual Basic programming scripting, provided my
Microsoft Corporation. This makes is possible to perform
advanced data manipulations, comparisons and calculations directly on the label. If you are not familiar with Visual Basic scripting, a comprehensive help system is accompanying the labeling
application. To access is, click the VB Script Help file. Once your
script is written, it will be check for the consistency and syntax
errors and you will be notified of the exact positions of any possible error for easier problem solving. There is one thing you have
to pay special attention to: your script has to define an output variable Result. The value of variable Result is output of the function
and is used for setting of Visual Basic Script variable.

Link to
File

Lookup
Table

For more complex scripts click the Build script button to edit your
code in Expression Builder.
The value for the label object is acquired from the specified text
file in this case. The contents of the file is used for the object.
You can link the object to some fixed file name on the disk. Or you
can use variable file names. To achieve that connect the object to
the variable containing the path and file name of the file.
Lookup Table is a facility for the user to simplify working with
data tables. Although the software can interact to any database,
sometimes there is a need only for one quick simple table that
stores your data. Lookup Table provides a shortcut to database
usage.
Lookup Table is used when you want to use a data from a simple
database on your label. You can use some external databases as
data source for all variable fields. But Lookup Table greatly simplifies this task. It is in fact a table stored within the label file.
Built-in database editor can be used to manage the data records.
Every Lookup table can have a Key (Primary) and Secondary Key
that are used for actual data query. Using these keys you can
make a query into the table and extract only fields that comply to
the condition. Both keys can be either fixed or get a value from
some variable. When the record from the table is found based on
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ASC
(FACT)
HIBC
Rich Text
Editor
Structured
RSS barcode
RFID Tag
Contents

information from one or both keys, the value of the database field
selected in Output fields is returned as the object contents. The
object on the label now has its value from the database. The button Configure tables will let you manage your Lookup Tables.
ASC (FACT) is used when you want to encode the data using this
standard for Data Identifiers (DI). It is much like GS1-128 standard and its Application Identifiers (AI).
There is the ability to encode data in the object using HIBC standard.
This contents provider is available only for RTF object. It
provides you with the RTF editor, where you can define the fixed
or variable contents for the object.
This contents provider is available only when using RSS type of
barcode. It provides you with the functionality to provide linear
and composite (if applicable) data to the barcode.
This contents provider is available for text and barcode objects. It
is available when you have RFID-aware printer driver connected
to the label and the printer can extract part of the RFID encoded
data and print it on the label.
Two types of data are usually available:

1. The Unique Tag ID
It is the number that is programmed in the RFID tag during the manufacturing process. The number is unique and
usually cannot be changed.
2. RFID Tag Data
Any part of the tag data can be extracted.
The printer will read the data from the tag, remember the value
and use it with the text or barcode objects on the label. The data is
never returned to the labeling software, but is handled internally
in the printer.
Note: The text or barcode objects to which you assign the value
from the RFID tag must be formatted as printer internal
objects. Format the text object with some internal printer font.
Select the barcode object to print as internal printer object, not
as graphics.
For on-screen previewing purposes you can enter some data into
the Preview edit field.

Working with Variables
Using Variable Wizard
Variable wizard

The variable wizard simplifies and speeds up the creation of the most common types of variables.
You cannot however set the advanced options in variables. These can only be set in a Variable
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dialog box.

Variable Wizard - Choosing the type of variable
First you must type in the variable name and select the type of variable. You can chose among:
Keyboard
input
Counter
Date field
Time
field

The value of the variable will be typed in before printing.
The variable will automatically increment when the
labels are printed.
The value for the variable will be current date (optionally with offset).
The value for the variable will be current time.

Generic variable name based on the type of a variable field selected will be auto-generated, but
you should change it to a more descriptive name. Use the name that will clearly on first sight
determine the contents of this variable.
When all data, that wizard needs are provided (you click the Finish button), the text with variable
content will be inserted at the specified point of the label. You can later edit the text object and
variable itself just as any other text and variable on the label. See Text command and Variable dialog box above for further information.
Variable Wizard - Keyboard input

Use this variable type when you want the operator to enter a value of the variable from the keyboard before printing the specified numbers of labels.
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Dialog box for Variable Wizard when Keyboard input option is chosen
Prompt text for this variable field: Fill in the message that will be shown to the user when he
will enter the values for the variable field.
Format: Select the format of data you allow to be entered for the variable field.
Set maximum number of characters: Define the maximum length of characters that can be
entered for the variable field.
Variable Wizard - Counter

On this page of the variable wizard, you define the counter variable.
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Dialog box for Variable Wizard when Counter option is chosen
Starting Value: Set the starting value for the counter. The counter will increment or decrement
from the starting value.
Note: You can enter only digits for the starting value.
Prompt for value before print: Tick this option to enable entering the starting value of the
counter when you start printing labels. Enter the text that will be shown to the user before printing.
The message will be shown on the screen each time when the label is to be printed.
Set maximum number of digits: Define the maximum length of digits the counter can occupy.
Increment or decrement: You can define that the variable value will increase or decreasefrom
label to label.
Preview: The field shows the preview of the counter, based on your selection.
Variable Wizard - Counter Continuation

Step: Define the step for your counter. The counter will increase by this number on every label.
Change value every <n> labels: Define the number of labels, when the counter will change the
value.
Rollover when reached: Enter the value, when reached, will cause the counter to reset the value
to the starting value.
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Variable Wizard - Date Field

Define the properties of the date field. The variable field will get the value from a computer clock.

Dialog box for Variable Wizard when Date field option is chosen
Format: Select the format for your date from the list. You can also enter the custom format.
Date offset: You can add a certain numbers of days, months or years to a current date and print
that date instead of the current one.
Preview: The printer will print the date as shown on the Preview field. This way you can see how
the selected date format will look on the label.
Variable Wizard - Time Field

Define the properties of the time field. The variable field will get the value from a computer clock.
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Dialog box for Variable Wizard when Time field option is chosen
Format: Select the format for the time from the list. You can also enter the custom format.
Preview: The printer will print the time as shown on the Preview field. This way you can see how
the selected date format will look on the label.

Available Data Types
Here you can define the input format and output format of the variable.
Supported format types are:
None
Date

Time

Floating
Point
Money
Pick
List

Binary

This format is used when you don't need any special format.
This format is used to insert the date. Input and output pictures can
be set. Allowed values for input are shown in drop-down list. More
on date inputting can be found in section Variable Wizard - Date
Field.
This format is used to insert the time and is similar to date inserting.
More on time inputting can be found in section Variable Wizard Time Field.
This format is used to insert large numbers. This type enables you to
put comma and points in the right places.
This format lets you choose the currency unit, and put it on the correct place.
This format enables you to define a list of values for the input values.
Entered entries in the pick list are available to the user in the combo
box that is displayed when the label is printed. The user can select
one of the predefined values.
This format enables the insertion of a binary value on the input. The
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output is ASCII character.

Available Date Formats
The date fields can be printed in various formats. In this field you define, how the date will look.
You can select some of the predefined date formats or enter you own. When defining the formats,
the following notation is used:
D
DD

Number of the day in a month. Can occupy one or two characters.
Number of the day in a month. Always occupies two characters. (leading
zeros will be added as necessary).
M is number of the month. Can occupy one or two characters.
MM is number of the month. Always occupies two characters.
The year as 2 or 4 digits number.

M
MM
YY or
YYYY
DDD
DDDD
MMMM
MMM
J

Abbreviation of the day of week name.
The full day of week name.
The full name of the month.
The abbreviation of the name of month.
The number of days since 1. January. Can occupy from one to three characters.
The number of days since 1. January. Always occupies three characters.
The week number in current year. Can occupy one or two characters.
The week number in current year. Always occupies two characters.
The weekday. The value range is 1 - 7, where 1 represents Monday and 7
represents Sunday. characters.
Any other sequence of characters will be displayed unchanged. This way
you can insert dots, commas and other characters needed to properly
write the date.

JJJ
W
WW
N

The examples:
Format
D/M/YYYY
DD/MM/YY
DDDD, D. MMMM YYYY
JJJWWYYYY

How the date will look
10/3/2005
10/03/05
Thursday, 10. March
2005
069102005

Available Time Formats
The time can be printed in various formats. In this field you define, how the time will look. You
can select some of the predefined time formats or enter you own. When defining the formats, the
following notation is used:
h
hh

Hours in 12-hour format (AM/PM will be added if they follow the time). Can
occupy one or two characters.
Hours in 12-hour format (AM/PM will be added if they follow the time).
Always occupies two characters. (leading zeros will be added as necessary).
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H
HH
mm
ss

Hours in 24-hour format. Can occupy one or two characters.
Hours in 24-hour format. Always occupies two characters.
Used for minutes.
Used for seconds.

The examples:
Format
h:mm
{AM/PM}
H:mm
hh:mm:ss

How the time will
look
8:25PM
20:25
08:25:36

Changing the Order of Entering Prompted Variables
When you are using variables, value has to be assigned to them before printing. And one way of
doing this is by using prompted variables (other are counters, functions, databases, ...). You are
asked for the value of every prompted variable before every printing. Then you fill in the values.
The order in which you are entering the values may or may not be the order you want. If it is not
it's probably the best solution, to change it.
The order can be changed in Variables dialog box.

1. Click Variables in Data menu to display a dialog box. All variables you are using are listed here alphabetically.
2. Click the button 1, 2, 3, ... in the lower right part of the dialog box.
3. Prompt order dialog box pops up. This is where you can change the order in which you
are entering values to variables. Select the variable from the list on the left and roll it to
appropriate position using buttons Up and Down. Repeat the procedure for every variable, that needs its position changed.

Creating a Prompted Variable
1. Create a new variable. Instructions for this step can be found in how-to topic Create a
serial number, counter.
2. Name the variable "Prompted". Set the length of the variable.
3. Go to the Prompting tab.
4. Type in the Display this text to the print operator field the content "Please enter a
value".
5. If you want to be prompted for every label that is printed, change setting to Every to 1.
6. If you want the variable to have a default value, go to the Prompting tab. If you do not
want to be prompted for value at print time, change the mode to Do not prompt for
value. The variable will behave like a constant.
7. Press on the OK button and link the variable with text or barcode.
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Creating a Serial Number, Counter
The easiest way of creating new variable is using Variable Wizard.

1. Click the arrow button in the button

on variable toolbar to start Variable Wizard

2. From drop-down menu select Counter as the type of the variable, set the name of the
counter and click Next
3. Type in Starting value and you are finished with setting up this simple counter.
However, using Variable Wizard you are also capable of changing other properties of the counter:
prompt for value before printing, maximum number of digits, step of incrementing/decrementing
and much more.
The other method of creating counter is by creating a new variable directly (not using the Wizard)
and then setting its parameters appropriately:

1. Click on the button New variable

on variable toolbar or

2. Click command Variables in menu Data and press New button.
3. Name the variable e.g. "Counter". Set the length of the variable. Go to the Serialization
tab of the dialog and set the parameters:
l

Incremental/decremental counter

l

Step - value of the variable will be increased in steps

l

Change value after the number of labels

If you want to make counter filled in with leading zeroes, do the following:

1. Go to the Data Processing tab.
2. Set Position relative to the variable value to On left.
3. Type 0 for the Character.
If you want the variable to have a default value, do the following:

1. Go to the Prompting tab.
2. Enter the value into the Default value field.
Note: If you do not want to be prompted for variable value at print time, change the option
Prompt to Do not prompt for value. The counter will always start counting from the default
value.
Press on the OK button and link the variable to text or barcode.

Make a Counter that Preserves Last-used Value
Counter which preserves last-used value is applicable in cases when continuing of numbering from
last label production is required (e.g. serial number). The last value of the counter that was used on
the label is stored and the numbering is continued from this point at next use.

1. Create a new variable. Instructions for this step can be found in how-to topic Create a
serial number, counter.
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2. Name the variable e.g. "Counter". Set the length of the variable and Format to Numeric.
Go to the "Increment" page of the dialog and set the parameters:
l

Incremental/decremental counter

l

Step - value of the variable will be increased in steps

l

Change value after the number of labels

3. Go to Prompting tab, select the option Prompt and enter the Default value you want to
use as the starting value for the counter.
4. Then tick the option Remember last used value (dynamic value). This will enable the
counter to remember the last used value.
Note: The counter which preserves last-used value cannot be made with Variable wizard, but
only using dialog for adding new variables.
The last used value is stored in the same folder, where the label is. The file extension with last
used value is .DVV, the filename is the same as the label.
Last-used values are stored in the external text files in the same folder where the label resides.
The external files have the same filename as the label file, but the extension .DVV. The label file
does not have to be saved to store the dynamic values. If you use labels with dynamic values and
exchange them with other users, make sure to exchange not only label files (.LBL) but also files
with last used dynamic values (.DDV).
Note: If you want to use the counter that remembers last-used value, you must have the permissions to write in the folder with the labels.
This type of a counter will remember the last value that was used for it on this label. If you want to
share the same counter on many labels and it should progress no matter which label is printed, look
at the global variable. It too can remember last-used value and can be used on different labels.

Overriding Default Values
When you define default values for variables in the label, they are saved inside the label file or
saved in the external .DVV file (when using "remember last used value" option). The default values are used every time that you don’t explicitly specify the custom values. To print labels with custom values, your printing application must send the values to the label variables just before the
printout.
You can override the default values using the external file that provides new values for the variables. The file must have the same name as the label file, but with the extension .defaults. For
example, the file with new default variables for the label LABEL.LBL must have name
LABEL.DEFAULTS and must be saved in the same folder with the label.
The file structure must contain field-value pairs each in a newline, such as:
VariableName1 = Value1
VariableName2 = Value2

In this case, the variable VariableName1 will have value Value1 and variable VariableName2 will get value Value2.
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Global Variable
Global variable is a type of variable that can be used on many different labels. Once it is defined,
it is stored outside the current label so it is available for any other label as well.
Its last value is stored even after closing the label file and exiting the application. It is useful when
continuing of numbering from previous printing is required. Values of global variables are stored in
a separate file on disk GLOBALS.TDB.
The location of the folder is C:\Documents and Settings\All Users\Application Data\Euro Plus
d.o.o.\NiceLabel6\System.
Global variable is an advanced option for power users, and is not available in the Variable wizard.
Global variable can only be created manually in the Variable dialog box. Make sure to select
Global as the Source for the variable in the General tab.
If you copy your label file, which uses global variables to another computer, you have to copy the
file GLOBALS.TDB to the new computer as well. If you miss this step, then the labeling application won't find appropriate global variable and will notify you of this situation. At the same time a
substitute global variable will be created, but last value of old variable will not be known, nor will
the correct variable properties be restored. Check the settings of substitute global variable and
change them appropriately to suit you needs.
The same global variable is not limited for use on only one label. You can use it on as many labels
as you like. Please note, that only one label, using the same global variable, can be printed at a
time. When using global variables, they are locked for one label and this prevents more labels to
use the same global variable at the same time.

Groups of Allowable Characters
The format of a variable is selectable to filter the input data. This helps avoiding mistakes when
entering data. You can only enter characters, which are included in the specified format range.
All

Numeric

Alphanumeric

Letters
7-bit ASCII
format
Hex
Date
Time
Digits and
Capitals
CUSTOM

Select this format when there is no need to limit the variable
data. For example: one variable can be used to define changes in
the barcode, the text and the graphics. You can enter all characters from the keyboard.
Use this format you need numeric variables, for example, serial
numbers or EAN and UPC barcode. Only numeric characters in
the range 0 to 9 can be entered.
Use this format when numbers and characters are mixed in the
same variable - for example, identity codes... Characters from 0
to 9, a to z and A to Z can be entered.
Use this format when you need the character variable.
The variable will contain only characters with ASCII code from 0
to 127.
Use this format to allow input of hexadecimal numbers.
Use this format to print date stamp.
Use this format to print time stamp.
Use this format to limit the usage only to digits and capitals of
English alphabet.
You can define your own data format. The allowable characters
can be defined in the Serialization tab.

- 110 -

<printer family name>
FORMAT
Code 39,
Code 128A,
Code 128B,
Code 128C,
Code 128,
Codabar

Use this formats do enable usage only of characters that are
allowed in the internal fonts of the currently selected printer.
Use this formats to enable usage only of characters that are
allowed by these barcodes standards.

Internal Variables
Internal variables are filled automatically by the software and you do not have any influence on
them. They cannot be edited and modified, but only used in the functions and on the label. Their
value is updated for every printed label.
Internal variables are represented with the
other types of variables.

icon so they can be easily distinguished from the

The list of available internal variables:
ComputerName

CurrentBatchQuantity

DefaultPrinterName
LabelFileName
LabelPrinterName
RequestedQuantity
ShortLabelName
SystemUserName
TotalQuantityPrinted

UserName

Contains the information about the computer name of a PC
computer where labels are processed, as specified from
Windows system.
Contains information about the label quantity reached in the
current label batch.
The value is reset at beginning at each batch in the printing
process.
Contains the name of the default printer on the system.
Contains full name of the current label, including the path
to the file.
Contains the name of the printer that is used on the label.
Contains the quantity of the labels as specified by the user
or external application.
Contains the name of the label without the path. Only filename with the extension LBL is available.
Contains the name of the system Windows user that is
logged in and is running the application.
Contains the quantity of all unique labels printed. Label copies are not included in this variable, only the number of different labels is.
Contains the name of the user that is logged in and is using
the application. This variable has some value only when you
have enabled user management in the software.
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Types of Variables
Each type of variable has its own icon to easier distinguish variables among each other. The icon
in front of the variable name determines its type.
The available types of variables are:
System Date/Time variable
Printer Date/Time variable
Counter variable
Counter variable with enabled Dynamic
Value
Prompt variable
Prompt variable with enabled Dynamic
Value
Global variable
Database variable
Function-generated variable
Internal variable
Locked variable

Using Printer Internal Increment Counter
Almost all thermal printers offer internal increment counter. This is a special printer counter that
counts labels internally. The printer only receives the first value of the counter and then automatically increments the counter in steps of 1 on the subsequent labels. Using this option reduces
the amount of data transferred between computer and printer as only start value is sent to printer.
This can significantly speed up label production.

1. Create a new variable "Counter". Instructions for this step can be found in the topic
Create a serial number, counter.
2. To use counter as internal printer element please pay attention to the following settings:
l

The variable's maximum length is limited by you printer. You should find this
value in your printer's Owner Manuals. If you can not find this value, experiment.

l

The variable length has to be set to Fixed.

l

The variable format has to be set to Numeric.

l

The text object linked to the variable must be formatted in the internal printer font.

l

Tick the option Use printer internal counter in the Value tab of the Text object's
Properties dialog window. This option is available only if the counter variable has
been set up properly.

3. There should be two symbols
in the lower right corner of text box. The first one
tells that this text will be printed in internal printer font. The second one tells that this
counters is internal printer increment counter.
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Using Variable Quantity
Variable Quantity is a special variable in the label. You use this variable, when you do not know
exact number of labels for printing. Using this variable, you can enter the number of labels to print
during printing itself.
The example: You have a label of a product. Already defined variables are "Name" and "Price".
We want to print labels as follows:
l

Enter Name and Price values

l

Enter quantity for this product

l

Print

l

Start with new product.

Do the following:

1. Create new variable, named "Quantity".
2. Tick the option The variable value is used as label quantity in the General tab.
3. Edit variables "Name" and "Price". Go to the Prompting tab (assuming, the variables
are already defined as prompted variables).
4. Change the Prompt setting to Based on variable quantity.
When you start printing labels, the quantity parameter in the print dialog is already set to Variable
quantity (defined from label variable).

Working with Functions
Defining a Function
Define a Function

Functions allow you to modify the data received into the label. For example, you get the current
day from the system and must calculate the expiry date for a product. Another example, you have
to implement the specific proprietary check-digit algorithm.
Each function has input and output. The input are one or more variables, which variables the function will use. The output (result of a function) is a new function-generated variable that you can
use on the label linked with some object.
When you want to define the first function, the list of functions will be empty and, you must click
the New button to define the function. The Function dialog box is then displayed.
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Function dialog box – General tab
This dialog box is also displayed when you want to change the existing function.
To define (change) the function all required parameters must be entered and confirmed by clicking
OK button.
Dialog box has several pages – tabs. Note that only General tab is fixed, all other tabs change
according to the function type you select on General tab. Each other tab is described separately for
each function.
Function Types

Using Functions to Manipulate Label Data
Using Functions to Manipulate Label Data

The labeling software enables you to work with variable values on the label, manipulate the values
and use them with other label objects. The labeling software offers a group of functions that help
you work with the variable values. There is always some input to the function that the function
manipulates and always some output that is stored to a function-generated variable. The functiongenerated variable can be linked to label objects or used in other functions.
There are many functions available, such as Concatenate (for linked fields), Subset, Date addition,
FACT, HIBC and VBScript. VBScript is a powerful function allowing you to perform advanced
data manipulation.

- 114 -

Using Concatenate Function

The concatenate function merges two or more variables into one new variable. To create a concatenate function, do the following:

1. Click on the
button in the Standard toolbar or select Open in the File menu. Select
the label file ID_CARD.LBL from the sample folder.
The label has a link to the database so you see how the concatenate function operates on
a set of records.
2. Select the command Functions in the Data menu.
3. There is already one function defined in the label. Ignore it and click on the New button.
The dialog box with the properties of the new function will open.
4. In the General tab type 'My Concatenate function' for the name for the function.
5. Select the Concatenate function from the list of functions.
6. Click on the Detailed tab to define details for the function.
Look at the top of the dialog box. The left side contains the available variables defined
on the label.
7. Select the variables ID and NAME. Note that they have appeared in the right list box.
8. The name of the output variable is 'Concatenate' and delimiter is set to 'None'. Click on
the OK button.
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Definition of the Concatenate function

9. Click on the Close button to close the Functions dialog box.
10. The function-generated variable is defined on the label. You should link it to text object
on the label.
11. Click on the small arrow next to Text Object in the Toolbox.
12. Click on the option Use existing variable and select the variable Concatenate.

Selecting the function-generated variable Concatenate

13. Click on the label where you want to place the text object. The text object is linked to the
new variable Concatenate.
The values of variables 'ID' and 'NAME' are merged and saved to the function-generated variable
'Concatenate' every time the label is processed for preview or print.
Using VBScript (Visual Basic Scripting Edition) Function

VBScript function allows you to perform the most demanding and difficult data manipulation on the
label. Available are all the functions, procedures and operands from Microsoft Visual Basic script.
Your script can take values from all label variables, work with the values and save the result in a
function-generated variable.
Creating a VBScript function

To create a visual basic function, do the following:

1. Click on the
button in the Standard toolbar or select Open in the File menu. Select
the label file ID_CARD.LBL from the sample.
The label has a link to the database so you see how the concatenate function operates
on a set of records.
2. Select the command Functions in the Data menu.
3. There is already one function defined in the label. Ignore it and click on the New button.
The dialog box with the properties of the new function will open.
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4. Type in the name for the function, for example 'My Visual Basic function'.
5. Select the Visual Basic Script function from the list of functions.

Select the Visual Basic Script option

6. Click on the Detailed tab to define properties for the function.
The variable NAME on the label provides the first and last names of the person. The
Visual Basic script should break them apart and use only the first name as the result of
the function.
For the Visual Basic script enter the following code:
Dim Spc
Spc = InStr(NAME, " ")
if NAME <> "" then
Result = Mid(NAME, 1, Spc-1)
end if
The above script will search for the first space in the variable NAME and save all characters until this space character as a result.
Note: Refer to the online help or User Guide for more information about Visual Basic Script
functionality.
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7. The result from the Visual Basic Script function is automatically stored in the functiongenerated variable (VBScript1) every time the label is processed for preview or print.
8. Click on the OK button.
9. Click on the Close button to close the Functions dialog box.
Using the result of VBScript on the label

To link the function-generated variable VBScript1 to an object on the label, do the following:

1. Click on the small arrow at the right end of the Text object. Click on the option Use
existing variable and select the variable VBScript1.

Selecting the function-generated variable VBScript1

2. Click on the label where you want to place the text object. The text object is linked to
the new variable VBScript1.
Every time the label is processed for preview or print the Visual Basic script will re-calculate
the result and store it in the function-generated variable VBScript1.
Note: VBScript is capable of handling Unicode-encoded values. If you use multi-lingual values
on the label (typically for chemical labels), you can manipulate the values in the VBScript.
Using custom VBScript functions

Some useful predefine Python scripts are included with the software.
In Expression Builder, expand Custom Functions in the Category window and select the function.

Working with Databases
Using Database Wizard
Using Database Wizard

Process of defining a new Database access function consists of four steps (pages). On those pages
you enter the data required by Wizard. You can go to the next step (page) by clicking Next button
or return to previous with Previous button.
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When all data needed has been entered, Finish button will become available, allowing you to complete the process of defining a new Database access function. Note that some options have predefined values, so you don't really need to go through all the steps of a wizard.
Selecting Database File

Database wizard – Selecting database file
Enter the full path name of the database file in edit box or use Browse button to find the file on
your computer.
Note that you can only select databases that are stored in files. If you use databases via ODBC or
OLE DB drivers, you will have to set that manually in Database dialog box.
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Selecting Desired Fields

Database wizard – Selecting fields
On this page you can select the fields you want to use on the label. All fields in a table are selected by default, but you will probably want to unselect some of them, especially if you have large
table. Variable will be created for each selected field and can later be attached to objects.
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Selecting Which Records will be Printed

Database wizard – Selecting which records will be printed
Select the desired option how you want to use the records in the database. By default the option I
want to print all records from the table is set and all records in a table will be printed one at a
time. Each record will be printed only once.
If you do not want to print the entire database, you can select which records should be printed. In
this case select the option I want to select which record to print. Prior printing you will be
shown a dialog box with all records from the database. Then you will be able to select which
records should be printed.
By default records are used once for a single label. If you would like to print several copies of a
label with database data, you can define it in the second part of this step of the Wizard.
A field in table contains quantity to print option will let you chose some field in the database.
This field has the information about the quantity of labels for each record.
For example: You have database with records of your products. It contains a field with a
numeric value, where the required number of label copies is stored. Select this field and let the
application print the quantity of labels specified here.
I will enter print quantity for each record: This option is only accessible if you have defined to
select which records should be printed. Prior printing you will be able to select which records will
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be printed in the selection dialog box. At the same time you will be able to type in the exact label
copy for each selected record.
Selecting Variable Quantity from the Database Field

Select a field in the database that contains the label quantity information. The database record will
be printed on as many consecutive labels as the selected field contains.
Note: Make sure to select the field that has been formatted with the numeric data.
Adding the Fields to the Label

Database wizard – Adding fields to the label
On this page you specify if you want the wizard to generate text objects on the label that are
already linked to the corresponding fields in table. Text objects are created in upper left corner of a
label, but you can later move them to another position.
Finishing the Process with Database Wizard

The summary of tasks you have completed will be shown in the last step of the Wizard. If you are
satisfied with your selection, click Finish to complete the process of creating a new database
access function.
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Linking Label to Text Databases
Overview

Text databases are text files containing data values that can be used for variable objects on the
label. The text database is not a real database. It contains the data values but lacks the information
of the data structure, name of the fields and maximum lengths of the fields. You have to provide
the missing information before the labeling software can use the data from such a text database.
An example of such text database is a CSV file (comma separated values), where some delimiter
(semicolon ";") delimits the fields. Every line provides data for one label and can be understood as
a "record" in database nomenclature.
Note: The label designer does not support XML data files. To use data from XML files, see
NiceLabel Automation line of products.

The label in design mode (on the left) and preview of the five labels with data from the database

Connect to a Database

The labeling software offers a Database Wizard that guides you through the necessary steps to connect the database to a label. To connect your label to a database using the Database Wizard, do the
following:

1. Click on the

button in the Standard Toolbar.

2. Click on the Browse button and point to the text database "c:\Program Files\EuroPlus\NiceLabel 6\\Samples\Database\data.txt".
Note: Your labeling software might not include the text database sample.
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Selecting the text database

3. Click on the Next button.
Note: If you connect to the database for the first time, you need to define the database structure.
Continue with the next section.
Format the Data with the Text File Wizard

Because the text files do not contain the structural information like real databases do, you must
define the fields and their data structure. When you use the same text database some other time,
you won't have to define the structure again.

1. Select the encoding of the data in your text file. The encoding selection is important
when your file has multi-lingual contents (Unicode data). If in doubt what to use, first try
the option Automatic detection. Refer to the preview, it must display to correct values.
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Defining the file encoding

2. Choose the data type for the selected text database. The fields are aligned in columns, so
you must select the option Fixed.

Defining the type of the text database

3. Click on the Next button.
4. Define the widths of the individual columns by placing a break line before the second
column and before the third column.
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Defining the fields in the text database

5. Click on the Next button.
6. Accept the default field names and click on the Next button.
7. Review the text database structure. The field names and their maximum lengths are displayed. Click on the Finish button to close Text File Wizard.
The link to the database has been created and database fields are available on the label.
The labeling software brings you back to the Database Wizard.
Place Database Fields on a Label

The next step in the Database Wizard opens the dialog box with the list of available fields from the
database.

1. By default all fields from the database will be used on the label. Click on the Next button.

Using all fields in the text database

2. Specify what records and how many you want to print:
Select the options I want to select which record to print and I will enter label quantity for each selected record. Before printing labels, the table with the records will open
and you will be able to select the records you want to print and the quantity of labels for
each record.
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Specifying which records from the database will be printed and in what quantity

3. Click on the Next button.
4. Select if the Database Wizard should link all selected fields from the database to the text
objects on the label or if you want to link the fields manually to the label.
5. Click on the Next button.
6. Select I want a text object for each selected field and click on the Finish button.

Each field from the database will be linked to a text object
The label will show several text objects. Every field from the database is linked with the text
object on the label.
Use Print Preview to Select Data and View a Label

Now you will simulate label printing using print preview.

1. Click on the print icon

in the Standard Toolbar.

2. The Print dialog box opens with the Quantity of labels set to Variable quantity
(entered for each database record). This setting corresponds to your selection in the
Database Wizard when you have selected the options I want to select which record to
print and I will enter label quantity for each selected record.
Only the records you select will be printed in the defined quantity.
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Print / Print preview dialog box

3. To choose which records to print from the database click on the Select Records button.
The Record Selection dialog box will open.
4. Select the records from the database you want to print and enter the number of labels you
want to print for each selected record.

Record selection dialog box
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5. Click on the OK button. You will return to the Print dialog box.
6. Click on the Preview button. Now you can preview the labels on the screen. Note that
the text objects on the label change for each new record.

Preview of the second label in the series

7. Click on the Next button in the command window to advance to the next label in the
series. After you see the last label in the preview series, the labeling software will re-open
the Print dialog box.
8. Click on the Close button to close the Print dialog box.
Print a Label

When you are certain that the label design is correct and label preview shows the correct values
from the database, you can start sending the labels to the printer. To print a label, do the following:

1. Click on the print icon
in the Standard Toolbar.
The Print dialog box will open (same as the print preview dialog box).
2. Click on the button Select Records and select the records you want to print and specify
the label quantity for each record.

Selecting records and specifying label quantity
3. Click on the OK button.
4. Click on the Print button to start printing labels.
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5. Click on the Close button to close the dialog box.

Using Text File Wizard
Text File Wizard

When the input database file is a plain ASCII text file or formatted CSV (Comma Separated Values), Text File Wizard will be started within Database Wizard and it will guide you through quick
and easy steps of text data acquire. The main difference between real database and text file is in
their data structure information. Databases include the whole information about their fields (names,
data format, length) and can be automatically used with the application. Text files, on the other
hand, do not have stored such information and you will have to instruct the application how the data
is encoded.
When Text File Wizard finishes, it will return control back to Database Wizard, that will guide the
rest of the way.
Choosing Data Type

Before you can use text file, you will have to define its data structure. Fields can be delimited by
some sort of a separator (tab, semicolon, comma or some entirely user-defined separator) or can be
of a fixed length.

Database Wizard –Choosing Data Type
Choose Delimited, if you know that data fields are separated with some special character. File preview at the bottom of the dialog box can be helpful, if you do not know exactly how the data is
organized.
Choose Fixed if you know, that your data fields always occupy the same number of characters.
Start import at row option is useful, when you do not want to import some rows at the top of the
file. Most usual situation, when you would want to use this option is when text file contains some
header on top of actual data fields.
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Setting the Fields

Database Wizard –Setting separator and delimiter
In the second step of the Text File Wizard you have to set the fields in the text file. If you have
selected Delimited in the previous step, choose the appropriate separator here. The ones that are
usually used with text files are already predefined. But if you require some other, there is an option
to use a custom-defined one.
You can also select the Delimiter character that is used when separator character is used in the
text field itself. The delimiter should be used to enclose such field. Text between two delimiter
characters is treated as one field although it contains the field separator character.
The data preview in the bottom part of the dialog box will let you know if your choice of a separator character is a correct one. Fields will be separated with vertical lines, if a separator is valid.
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Database Wizard –Setting column breaks
If you have selected that your data is formatted with fixed widths, the second step of the Wizard
will be slightly different. Instead of selecting character for field separation, you will have to define
field widths. The Wizard makes is as simple as possible. Use a mouse and draw a vertical line to
the start positions of the fields. Lines will indicate where the new field starts.
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Formatting the Fields

Database Wizard –Formatting the fields
In this step of the Wizard you can review the field names and lengths and modify them, if necessary. You will probably use more friendly field names, so you can distinguish between them more
easily.
When you are finished with Text File Wizard, the structure information of the used text file is
stored to a separate file with a extension of .SCH (Scheme File). If you will try to use the same
text file some other time on a different label, you will be spared all efforts of structure creating.
SCH file will be automatically used and Text File Wizard will be skipped entirely.
Note, that SCH file is created also with add-on database manager NiceData, when you open the
text database in NiceData for the first time.

Linking a Label to Advanced Databases
Overview

You can use the labeling software to retrieve data from any database on your computer or network.
If you have the appropriate database drivers, you can connect to the database and use the records
on the label.
Note: Designer Express does not have all database options available. You can only use data from
text databases and Excel spreadsheets.
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With the labeling software you can connect to any database type as long as you have the appropriate database drivers installed on your computer. The labeling software supports different database drivers, such as ODBC, OLE DB and BDE. Your computer comes preinstalled with database
drivers for frequently used database types, but you can always install additional database drivers.
The typical databases you would connect to are Microsoft Access, Microsoft SQL Server, Oracle
SQL Server, MySQL Server and PostgreSQL Server. NiceLabel is not limited to relational database structure. You can connect to any other database as long as you have the appropriate database
drivers installed on your system and permissions to access the database. For example, you can use
data from NoSQL databases, such as MongoDB and other.
You have total control over which records in the database table will be printed. By default all
records are printed, but you also have the option to select the records for printing. Before the labels
are processed you can select the records in the table that you want to print. You can also specify
the print quantity for each record.
Advanced record selection techniques are also available in the labeling software. You can create
database filters and obtain only the records that match the conditions. The same functionality
allows you to join two or more database tables together and obtain values for the same product
from multiple databases.
Manual modification of the SQL sentence is available for advanced users.
Link to a Database Using Database Wizard

1. Click on the button
open.

in the Standard Toolbar. The Database Wizard will

2. Select the option Direct database access and click on the Browse button.
Use the option Direct database access, if you use file-based databases like Microsoft
Access, Paradox, dBase, Excel or .TXT files.
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Selecting the type of database connection

3. Point to the Access database c:\Program Files\EuroPlus\NiceLabel 6\\Samples\Database\IDENTITY.MDB.
Note: The database might not be included with your labeling software.
4. Click on the Next button. The next step Fields Selection of the Database Wizard will
open.
The dialog box will show all fields defined in the database table.

All fields defined in the database table are displayed

5. Leave the default settings and click on the Next button. A next step Records Printing of
the Database Wizard will open.
6. Leave everything on a default settings in this dialog box.
What this means is that all records from the database will be printed and each record is
used on one label.
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Select how the records from the database will be used on the label
Click on the Next button. A next step Fields Usage of the Database Wizard will open.

7. Leave everything on the default settings.
The wizard will automatically connect all database fields to the text objects on the label.
8. Click on the Finish button.
The Database Wizard will connect to the database, obtain the fields and make them available on the label as variables. The variables will be linked to the text objects.
Link to a Database Manually

The Database Wizard does not support your database if it is not listed in the direct database access
or does not have an ODBC driver. In just a case you have to link your database to your label manually by doing the following:

1. Click on the button
open.

in the Standard Toolbar. The Database Wizard will

2. Select the option Other databases (ODBC).
Use this option, if you use server-based databases like SQL server, Oracle, Informix or
some database not directly supported by the option Direct database access.
3. Select the available ODBC definition in the list.
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4. Click on the Define button, if the connection to your database is not already defined.
5. The dialog box Database opens.
Here you can define the connection to your database.

Manual definition of the database connection

6. Click on the OK button.
7. Continue from the step 4 in the chapter Link to a Database Using Database Wizard.
Print All Database Records

By default the Database Wizards sets up the database connection to print all records in the database. The Database Wizard step Records Printing is where you can define which records are printed.
To print all records in the database table follow the steps in the chapter Link to a Database Using
Database Wizard.
Note: To print all records in the database it is important to select the option 'I want to print all
records from the table.' By default each record is printed once on the label.
Print Selected Database Records

You can define which records from the database you want to print in the Records Printing of the
Database Wizard.

1. Follow the steps in the chapter Link to a Database Using Database Wizard until the step
5.
2. Select the option I want to select which record to print to be able to select which records
are printed.
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You will be able to select which records are printed

3. Click on the Finish button.
The link to the database is created and text objects linked to the variables are positioned
on the label.
4. Click on
to open Print dialog box.
The button Select Records... becomes available.
5. Click on the button Select Records...
The Record Selection dialog box opens.
6. Tick the records you want to print.
You can select individual records or group of records by selecting the first record, press
and hold the Shift key and then select the last record in the series.
Note: Selecting of multiple records is only available when using real databases and not when
using data from spreadsheets like Microsoft Excel or text CSV data files.
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Selecting records for printing
Query and Create a Database Filter

The labeling software allows you to perform queries on the database table to extract only the
records matching some condition. Please note that you have to enable record selection in the database properties to be able to query the database. To enable database filter, do the following:

1. Refer to the chapter Link to a Database Using Database Wizard. Follow the steps
from 1 to 6.
2. Select the option I want to select which record to print.
3. Click on the Finish button.
The link to the database is created and database fields are linked to text objects on the
label.
4. Click on the

button or select the command Print in the File menu.

5. Click on the Select Records button in the Print dialog box.
Record Selection dialog box opens.
6. Click on the small arrow button next to the field names in the table and choose the condition.

Defining the filter by clicking the arrow button
You can display only the records that are equal to the selected value in the list or you can define
your custom filter.
All records matching the condition will be filtered from the database and displayed in the table.
Note: You can define conditions on multiple fields at the same time.
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Database Access
Database access functions are functions used to retrieve data from the database.
The records can be obtained from the database using different approaches.

1. You can successively read record by record from the database and use them all on the
label.
2. You can select records for printing.
3. You can define filters that will be used to retrieve just a subset of records from your database, that will comply to your conditions.
The result of the database access function is a set of variables, one for each selected field of database table. Each database variable is named the same as the database field, but has additional prefix of a database name. This allows you to quicker identify from which database table the variable
comes from.
For example: If you have a field name Product in the database table DBPROD, the resulting
label variable will be named DBPROD.Product.
The labeling software supports all types database. The only condition is that you have the appropriate database driver installed in the Windows system. The labeling software can work with OLE
DB, ODBC, BDE and other database drivers.
For connectivity to modern multi-lingual Unicode databases the OLE DB provider is available.
Using this technology the Unicode values can be used on the label. These are the data values in different codepages. You can use the tables with different language settings on the same label.

Changing the Order of Database Records
You can change the order in which the labeling software prints the records from the database
table. By default the records are printed from the first one to the last one in order as they appear in
the table (if you do not enable record selection feature).
To order records by one field from the database, do the following:

1. Connect the database table to the label.
2. Make sure the Database toolbar is visible, then click on the
(Edit) button.
The Database Access dialog box opens with General tab displayed.
Note: If the Database toolbar is not visible, select Toolbars from the View menu, then click Database.

3. In the Order dialog box select the field, by which you want to sort the records.
When you will print or preview the label the records are ordered by the selected field in
ascending order.
4. Click OK.
To order records by multiple fields from the database, do the following:
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1. Connect the database table to the label.
2. Make sure the Database toolbar is visible, then click on the
(Edit) button.
The Database Access dialog box opens with General tab displayed.
Note: If the Database toolbar is not visible, select Toolbars from the View menu, then click Database.

3. Click on the Advanced button next to the Order combo box.
The Table Order dialog box opens.
4. Look at the Available fields section. Select all fields by which you want to sort the
records.
5. Look at the Selected fields section. Define the order or appearance of the fields.
6. Define the sort order for each field.
When you will print or preview the label the records are first ordered by the first field in
the list, then by the second field, and so on until the last field in the list.
7. Click OK.

Quickly Editing Database
Click the
icon in the Database toolbar. The application NiceData will open the currently selected database.
Note: NiceData must be installed on your computer.

Read Data from the Database
To read data from the database, create a new connection to the database using either of the two
methods below:
l

Click the "New database wizard" button

in the Database toolbar

l

Select Database access from Data menu and clicking on the Wizard button.

Follow the on-screen instructions until the Database Wizard finishes.
For every field in the table, you now have a text object on the label. Each database field is available as a variable on the label.
If your database type is not available in the Wizard or you want to use different driver (OLE DB
provider) for connection to the database, you will have to use direct database set-up option and not
the Database Wizard.

Using Data from Excel Spreadsheet
NiceLabel can collect data from any data source for which you have the appropriate "drivers"
installed. A database driver is a computer program that allows access to the data stored inside a
database. The developer of the database also provides the drivers for various operating system platforms, so the user can access the data.
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The driver for Microsoft Excel spreadsheets is usually already available with your Windows system.
The Recommended Structure of the Spreadsheet

You can look at the Excel file as the database. The spreadsheets are like tables in a database.
Columns are like fields defined in the tables. Rows are like records in the tables. Each row
(record) will print one separate label.

Name the data in each column. Enter the name of the column in the first row. The column names
will be imported into the label as variable names. Having field names will make label design
easier. You don't have to name the columns, but in that case the variables in the label will have
unfriendly names, such as F1, F2, F2.
Acquiring the Data from Excel

To connect to the Excel spreadsheet and acquire data, do the following:

1. Open your label.
2. Select Data>Database Access>Wizard.
3. In the Database and Table dialog box, browse for your Excel file.
4. Select the Table containing the label data. Table drop-down box will display all spreadsheets in your Excel file.
5. Click Next.
6. In the Fields Selection dialog box, select the fields you want to use on the label. The
fields are columns from the spreadsheet. You can use standard Windows shortcuts with
Ctrl+click to select individual fields, or Shift+click to select range of fields.
7. Click Next.
8. In the Records Printing dialog box, select the printing mode.
9. Click Next.
10. In the Field Usage dialog box, choose if you want the designer to create a Text object
for each selected field.
11. Click Finish.
12. To close the Database Access Functions dialog box, click Close.
13. Select File>Print Preview to preview the labels on-screen. Each line of data from Excel
will be used on a separate label.

Using ODBC Databases
To be able to use ODBC databases, you first have to setup your ODBC drivers properly. You can
do this in advanced by starting ODBC setup program in Control Panel and modifying Data Source
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Names (DSN) to suit your database file locations. Or you can do the same thing from the labeling
software.
Connection to already defined ODBC data sources can be done using the Database Wizard.
If data source is not defined in the system yet, you will have to use direct connection method and
by pass the Wizard.

1. Open Database Access dialog box, then click the Define button in General tab.
2. In the list of database connection types first find the OLE DB drivers, then ODBC Data
sources.
3. In the right side of the dialog box select already prepared data connection or create a new
one.
4. Once you have the ODBC data connection prepared, select it and close the dialog.
5. The fields from the selected database can now be used on the label.

Creating Custom Check Digit
Creating Custom Check Digit
You can add new or edit and delete existing algorithms by clicking appropriate buttons. Algorithm's
parameters are defined in Edit algorithm dialog box, which has following options:

Editing check digit algorithm
To understand all parameters, you must know, how check digit is calculated. First of all, we must
have a numeric value and on top of that the check digit will be calculated. If weights are required,
we will need them as well. Let's look at EAN13 check digit calculation:
Value: 123456789012
Weights: 1, 3
When starting calculating, each digit has its weight. When only two weights are specified, the third
digit gets the first weight, the forth the second, and so on. If only one weight is specified, all digits
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have the same weight. According to Sum determination, we can use weights (sum of the products)
or not (sum of the digits). EAN13 algorithm uses products, so we define Sum of the products.
The sum is: 1×1 + 2×3 + 3×1 + 4×3 + 5×1 + ..... + 2×3
When the sum is calculated, we take modulus parameter and divide the sum with that number and
remember the remainder of division. This can already be the result.
If Result complemented is specified, we subtract the result from modulus and so we get the new
value. When this value is less than 10, we already got check digit. If it is greater value (two
digits), we take the whole value or just the least significant digit (One digit only) as the result of
check digit algorithm.

Special Characters
Using Special Characters
Special characters are the kind of characters you usually cannot find directly on your keyboard. In
spite of that, some of them can be typed in using combinations of Alternate and Control keys.
The problem usually does not appear with your language-specific characters (ä, í, ń, ş, č, A etc),
you can enter them directly on the keyboard or using Alt+<key_code> combination. alternatively
Windows utility Character Map can be used to find appropriate character and paste it to the label.
You might have problems using other kind of special characters. Sometimes there is a need to
include a character with ASCII code below 32. These are so-called control characters. They cannot be normally entered to labeling or any other application. There is an alternative method of entering such characters, explained later in this topic.
There are several methods how special characters can be typed in to the labeling software.

Entering characters with <#hex_code> syntax
Another method of entering special characters is using the syntax <#hex_code>. The hex_code
stands for a two-character mark in hexadecimal numerical system. The appropriate values go from
0 (decimal 0) to FF (decimal 255).
For example, <#BC> (decimal 188) would be the same as <FNC1>, as they both would encode the
character with ASCII code 0188.

Entering characters with Alt+<ASCII_code>
This method is valid only for characters that are above ASCII code 32. A typical example would
be FNC codes that are used to encode GS1-128 barcode data. The labeling software will encode
this type of barcode according to standards and normally you would not have to change anything
about it. However, sometimes it is necessary to manually add such character to label data.
To include Function Codes just type in the appropriate character for Function Code. ASCII codes
of Function Codes are as follows:
FNC1
FNC2
FNC3
FNC4

0188
0189
0190
0191
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To type in character for FNC1, press and hold down left Alt key, then type in digits 0188 on the
numeric keyboard. Note the leading zero, it is mandatory. Release the Alt key and FNC1 character
should appear.
These characters can be typed in directly using the keyboard.

Predefined Character Shortcuts
The labeling application has several control characters predefined and they can be selected from a
drop-down menu in any dialog box, where a text input is enabled. Just look at the right side of the
edit field and find a button with arrow. Click it for a list of all available shortcuts to predefined
characters. The same list can be accessed with right-click on the edit field, where you select
Insert special character. For example: FNC1 character can simply be encoded as <FNC1>.
If special characters you want to use on the label is not available in this list of shortcuts, consult
additional input methods.
ASCII
code
1
2
3
4
23

Abbreviation
used in the
application
SOH
STX
ETX
EOT
ETB

25
5
6
7
8
9
11
13
10
12
14
15
16
17

EM
ENQ
ACK
BEL
BS
HT
VT
CR
LF
FF
SO
SI
DLE
DC1

18
19

DC2
DC3

20
28
29
30

DC4
FS
GS
RS

Description of the character
Start of Heading
Start of Text
End of Text
End of Transmission
End Transmission
Block
End of Medium
Enquiry
Acknowledgement
Bell
Back Space
Horizontal Tab
Vertical Tab
Carriage Return
Line Feed
Form Feed
Shift Out
Shift In
Data Link Escape
XON - Device Control
1
Device Control 2
XOFF - Device Control
3
Device Control 4
File Separator
Group Separator
Record Separator
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31
21

US
NAK

22
24
26
27
188
189
190
191

SYN
CAN
SUB
ESC
FNC
FNC
FNC
FNC

Unit Separator
Negative Acknowledgement
Synchronous Idle
Cancel
Substitute
Escape
Function Code 1
Function Code 2
Function Code 3
Function Code 4

Working with Memory Cards
Using the Printer Memory Card
Usage of printer memory card is recommended whenever faster label printing is required. A
memory card boosts performance because there is no need to transfer large bitmap images or custom font files to printer over and over again. Every element that is needed on the label is already
stored on the memory card.
Preparing Data for Memory Card

Follow these steps to prepare and use your memory card.

1. First of all, go through the user manual of your memory card. Memory cards are sensitive devices and misuse could damage the card as well as your printer.
2. Insert memory card into Slot 1. The slots are usually located at the back of the printer.
Switch on the printer.
3. Start the application NiceMemMaster, memory card manager. If the icon for
NiceMemMaster is not shown in the labeling software folder in the Start menu check
your installation. Reinstall the labeling software if necessary.
4. We'll assume that memory card is empty or safe to delete. First step is, to let
NiceMemMaster know what type of card is inserted in printer. Click Print Setup
in Card menu. Select your thermal printer from the list. If your printer is not listed,
you will have to install the appropriate NiceLabel Printer Driver. Click button Properties then click button Memory to open dialog box Printer memory. Here we have
to activate the memory card in Slot 1. Look at section Slot 1. In field Type select
Memory Card, leave field Connected file intact. Keep clicking OK until you return to
NiceMemMaster.
Note: NiceMemMaster works only in conjunction with NiceLabel Printer Drivers.

5. We will format the memory card and prepare it for downloading our data. Be careful, if
the card contains any previously downloaded elements, they will be deleted. Click
Format from Card menu or click

. Formatting will take a few seconds.
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6. Next step is to build a list of fonts and graphics that we want to store on memory card.
The information about these fonts and graphics is stored in memory card file (.MMF).
Let's make a sample memory card file. Select New from Card menu, or click
.
Name the file Sample and click OK. In dialog Card setup type in description and
select proper card size in kilobytes. You can always return to this dialog by selecting
Memory card information in Card menu or clicking
.
On the left side of the NiceMemMaster windows is place for inserting fonts; on the
right side is a place for graphics files. To add a font select Add from Font menu or
right-click Fonts side of the window. Select font to be downloaded and its style and
size. Next dialog allows you to select only the required characters in this font. Only
selected characters will be downloaded to memory card. Use this option if you are running low on kilobytes on memory card. Let's add the whole font in our sample. Next
we we'll add some graphics to our list. Select Add from Graphics menu or right-click
Graphics side of the window. Select some pictures (e.g. SAMPLE.PCX or
PRINTER.BMP).
In the lower part of the window you can see information about selected font or graphics: preview, used memory, width and height. Every element can be printed to label,
just to see if everything is all right. Use command Test print. Add some more fonts
and graphics to get a grip. Undesired elements can be removed from the list. Use
Delete from Font/Graphics menu or right click the element and select Delete.
7. When layout is complete and every font and graphics is in the list, we are ready for
download. You can download the whole list to the printer at once. Right-click left or
right side of the window and select Download All from the list. Or you can download
one element at a time by selecting it and clicking Download from Fonts/Graphics
menu or right clicking it and selecting Download from the list. If for some reason you
want to remove a downloaded element from memory card, but keep it in the list for
later, use command Remove.
Now let's do a status print. Printer will report some useful information of memory card
usage. Click Status Print from Card menu.
Using Data from Memory Card in the Designer

Memory card is now filled with elements (fonts and graphics) and is ready to be used from the
labeling software.

1. Start the label designer
2. Create new label. Click New from File menu or click
. Choose your printer from
the list. Select predefined label stock or design your own label.
3. We have to tell the label designer that our printer is equipped with memory card and
what kind of data is stored on the memory card.
Double-click the printer name in the status line in the bottom of the window. Click button Memory, and in section Slot 1 for Type select Memory Card and for Connected
file select SAMPLE. This is the name of the memory card file (.MMF) we created
before. Click OK to return to the label designer.
4. Using downloaded font.
Click Text icon

or Paragraph icon
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and type in some

text. From text toolbar select the font, you downloaded to memory card before. If text
toolbar is not shown on your screen, switch it on using command Text tool in View
menu. You will recognize downloaded font by special printer symbol in front of its
name . To make sure, you have selected the proper font, the same symbol is shown
in the lower right corner of the element on the label. If the symbol is not there, you
didn't select the right font or you do not have switched on displaying of printer element.
In this case select Object properties in View menu and click Printer elements.
5. Using downloaded graphics.
Click Graphics icon
and select the picture you downloaded to
memory card before. Click OK. Inserted picture is used from disk and not from
memory card yet. To change this double click the picture and select On memory card
in General tab. Click Browse and select the picture from memory card. To make sure
you are using picture from memory card look at the picture on the label. It should be
framed in blue box. Regular picture doesn't have any frame.
If you need further explanation on how NiceMemMaster works please refer to NiceMemMaster
documentation.

Using Label Setup Wizard
Using Label Setup Wizard
Label Setup Wizard offers defining dimensions of the label and changing printer setup. It consists
of a few simple steps. Click on the Related Topics button for more information.

Defining Label Dimensions
Here you can enter the label dimensions.
Note: The values for dimensions are entered automatically if you selected the label stock in the
previous step.
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Label setup Wizard - defining the label format
Width, height: Define the label dimensions.
Margins: Define the label margins.
Rows, columns: Define the number of labels in horizontal and vertical directions. This option is
commonly used with office printers (laser and ink jet printers).
Gaps: Define the gaps between the labels.
Note: Define gaps only if you have changed rows and columns option. If you have rolls of labels,
the gaps between the labels are auto-identified by the gap sensor in the printer.
Unit of measure: Change the unit of measure you want to use.
When you are satisfied with the label dimensions, click on the Finish button to close the Label
setup wizard.

Stock
If you use one of the standard predefined label formats, you can specify it here.
Stock Type: Select the type of stock.
Stock name: Select the stock from the list.
Stock information: The information about label dimensions, printer settings, background images
as defined by the selected stock.
Label linked to stock: If you enable this option, you cannot change the dimensions of the label,
because the stocks locks the dimensions.
Note: Using predefined stocks simplifies the process of label creation as you do not have to
define the label dimensions manually.
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Click on the Next button to continue with the next step.

Label setup Wizard - selecting Label Stock

Selecting Label Layout
Orientation: Select the label orientation. Look at the screen and printer layouts for suggestion how
the label will really be printed from the printer.
Print directions: Tick the option Rotated to rotate the label for 180 degrees, when printed.
Click on the Next button to continue with the next step.
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Selecting label layout

Defining the Page Size
Select the page size for your labels. This step is only necessary for the office printers.
Automatic Sizing: Tick this option, if you are using thermal printer with NiceLabel Printer
Drivers. The labeling software and NiceLabel Printer Drivers will negotiate about the label dimensions.
Click on the Next button to continue with the next step.

- 151 -

Label setup Wizard - choosing Label Dimensions

Selecting Printer
Select desired printer and optionally click Properties button if you want to set the printer parameters. Print setup dialog box is shown, allowing you to set the printer parameters such as print
speed, print darkness and print direction. Note that this is standard Widows printer setup dialog box
and its options may differ from printer to printer as it is based on the printer driver.
If the check box Always use default printer is checked, the default window's printer and its settings will be used always when opening this label.
Click the Next button to continue with the next step.
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Label setup Wizard - Selecting printer

Formatting Allergens for Food Ingredients
The European Union’s mandatory food labeling legislation, formalized in Regulation (EU) No
1169/2011, not only specifies what information must be shown, but also how that information is
presented, including font, color and contrast. The regulation deals in detail only with font size, but
leaves the exact type of allergen highlighting to the user. The allergens in the ingredient list must
be printed in a typeset or font that distinguishes them from the rest of the list (such as bold, italic,
underlined, inverse, different color).
NiceLabel has a built-in support for allergen formatting through the custom functions. These are
predefined functions that you can use to highlight the allergens in the list of ingredients. By highlighting, you can you bold, italic, underline, CAPS formatting or combination of this formatting.
The function result is RTF-formatted data you can use with the Rich Text Box object.
The allergen word might appear inside some ingredient that is not allergen. In this case you can
use the "WithExceptions" type of functions. These functions will accept another input parameter a list of exceptions. These are words or sentences that must not be formatted even if they contain
the allergen word. For example, if you define the word "milk" as allergen, it will be also highlighted in the ingredient "coconut milk", which is wrong. You can define "coconut milk" as an
exception and NiceLabel will not highlight the word "milk" when used in combination "coconut
milk".
For samples and additional how-to documentation see NiceLabel.Com: EU Food Allergen Labeling Regulation.
Prerequisites

The Food Allergens functions connect to the provided data source and read the allergens within.
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In order to open the data source, the appropriate database drivers (ODBC drivers) must be
installed on the computer.
l

l

For Excel and Access data sources. If you have Microsoft Office installed on the
same machine, you already have the database drivers. If not, install the drivers separately. Visit Microsoft Download Center then download and install Microsoft Access
Database Engine 2010 Redistributable or Microsoft Access 2013 Runtime.
For MS SQL data sources. The ODBC driver has been released within the
Microsoft SQL Server Feature Pack. You must have installed support for the provider SQLSQLNCLI11. Visit Microsoft Download Center and download the driver.

Note: If you plan using the Food Allergen functions from NiceLabel Automation software on
64-bit machine, make sure to install 64-bit database drivers as well (Automation Service runs
as 64-bit process on 64-bit machine).
Applying formatting to the allergens

To format allergens in the list of ingredients, you have to execute the formatting function and
provide the input parameters. The formatting functions are executed as VBScript function and
will provide the result in the output variable, which can be used directly in the Ricth Text Box
object. The function that you would use must match the data location, where you keep the list of
allergens, such as CSV string, Microsoft Excel spreadsheet, or Microsoft Access database.
To format the allergens from a list in Excel, do the following:

1. In NiceLabel Pro, select Data>Functions.
2. Click New.
3. Select Visual Basic Script and type in the function Name.
4. Go to Detailed tab.
5. Click Build Script.
6. Change the line Result = "0" into Result = and position the cursor after the
equal sign.
7. In the Category section, expand Custom Functions and select Food allergens.
8. In the Name category, double click the function FormatAllergensFromExcel.
9.

In the Expression category, define the function parameters, for example:
Result = FormatAllergensFromExcel(Ingredients, "c:\data\allergens.xls", "Sheet1", "1", "bold")

This will read the list of ingredients provided in the variable Ingredients, read the list
of allergens from Microsoft Excel file allergens.xls in the first column in the
sheet Sheet1 and apply bold formatting to all allergens within.

10. Click OK.
11.

In Output variable name, define the variable name, where the formatted allergens will
be saved.
Note: Make sure the variable begins with the prefix RTF_, such as RTF_Allergens.
This will instruct Rich Text Object to honor the control codes specified in the variable.
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12. Click OK.
13. Click Close.
14. In the toolbox, select the Rich Text Box object, then click anywhere on the label.
15.

In Rich Text Editor, select your variable in the list and add it into the content.

You can add additional variables or fixed text if necessary.

16. You can use the controls available in the Rich Text Editor to format the font type, size
and colors.
17. Click OK.
You can follow the similar steps for the other allergen formatting functions.
Syntax of Allergen formatting functions
User provided list of allergens

This function will accept the list of ingredients and list of allergens in two variables and create
the RTF code with highlighted allergens. All words from the Allergens that are matched in
the Ingredients will be formatted by the Highlight specification.
Syntax:
FormatAllergens(Ingredients,Allergens,Highlight)
Parameter

Description

Ingredients

The CSV list of ingredients.

Allergens

The CSV list of allergens.

Highlight

The CSV list of formatting switches you want to apply to the allergen. You can
use "bold", "italic", "underline", "caps", text color and/or background color. The
colors are formatted in hex syntax for RGB scheme, for example "#FF0000" for
red. For text color just provide the color code, for the backround, prefix the
color code with "bg:", such as "bg:#FF0000".
This is optional parameter. If provided as empty value (""), bold format is
used.

Example:
FormatAllergens("wheat flour,salt,veg fat,hazelnuts","wheat,hazelnuts","bold,italic")
FormatAllergens(Ingredients,"wheat,hazelnuts","bold,italic")
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Allergens from Microsoft Excel spreadsheet

This function will accept the list of ingredients and location of the Microsoft Excel spreadsheet. The function reads the allergens from the spreadsheet and creates the RTF code with
highlighted allergens. All words from the spreadsheet that are matched in the Ingredients
will be formatted by the Highlight specification.
Syntax:
FormatAllergensFromExcel(Ingredients,ExcelFile,Spreadsheet,Column,Highlight)
Parameter

Description

Ingredients

The CSV list of ingredients.

Excel file

The full path and filename to the Microsoft Excel file containing the allergens.

Spreadsheet

The name of the spreadsheet containing the list of allergens.
The name of the field (column name) containing the allergens.

Field

You can also provide the column index number containing the list of allergens.
Column A must be provided as "1", column B as "2", etc.

Highlight

The CSV list of formatting switches you want to apply to the allergen. You can
use "bold", "italic", "underline", "caps", text color and/or background color. The
colors are formatted in hex syntax for RGB scheme, for example "#FF0000" for
red. For text color just provide the color code, for the backround, prefix the
color code with "bg:", such as "bg:#FF0000".
This is optional parameter. If provided as empty value (""), bold format is
used.

Example:
FormatAllergensFromExcel("wheat flour,salt,veg fat,hazelnuts","c:\files\data.xlsx","Sheet1","1","bold,italic")
FormatAllergensFromExcel(Ingredients,"c:\files\data.xlsx","Sheet1","1","bold,italic")
Allergens from Microsoft Access database

This function will accept the list of ingredients and location of the Microsoft Access database.
The function reads the allergens from the specified table and creates the RTF code with highlighted allergens. All words from the spreadsheet that are matched in the Ingredients will
be formatted by the Highlight specification.
Syntax:
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FormatAllergensFromAccess(Ingredients,AccessDb,Table,Field,Highlight)
Parameter

Description

Ingredients

The CSV list of ingredients.

AccessDb

The full path and filename to the Microsoft Access file containing the allergens.

Table

The name of the table containing the list of allergens.

Field

The name of the field containing the allergens.

Highlight

The CSV list of formatting switches you want to apply to the allergen. You can
use "bold", "italic", "underline", "caps", text color and/or background color. The
colors are formatted in hex syntax for RGB scheme, for example "#FF0000" for
red. For text color just provide the color code, for the backround, prefix the
color code with "bg:", such as "bg:#FF0000".
This is optional parameter. If provided as empty value (""), bold format is
used.

Example:
FormatAllergensFromAccess("wheat flour,salt,veg fat,hazelnuts","c:\data\db.mdb","Allergens","Allergens","bold,italic")
FormatAllergensFromAccess(Ingredients,"c:\data\db.mdb","Allergens","Allergens","bold,italic")
Allergens from Microsoft SQL database

This function will accept the list of ingredients and location of the Microsoft SQL database.
The function reads all records from the selected field in the specified table and creates the
RTF code with highlighted allergens. All words from the spreadsheet that are matched in the
Ingredients will be formatted by the Highlight specification.
Note: The function requires the SQL Server Native Client ODBC driver. It is installed
with the SQL Server tools that you can download from Microsoft web pages.
Syntax:
FormatAllergensFromMSSQL(Ingredients, SQLServer, dbUsername, dbPassword, dbName, Table, Field, Highlight)
Parameter

Description

Ingredients

The CSV list of ingredients.

SQLServer

The SQL server name and optional instance, for example server\instance

dbUsername

The user name defined in the SQL server.

dbPassword

The password for the SQL user name.

Table

The name of the table containing the list of allergens.

Field

The name of the field containing the allergens.

Highlight

The CSV list of formatting switches you want to apply to the allergen. You can
use "bold", "italic", "underline", "caps", text color and/or background color. The
colors are formatted in hex syntax for RGB scheme, for example "#FF0000" for
red. For text color just provide the color code, for the backround, prefix the
color code with "bg:", such as "bg:#FF0000".
This is optional parameter. If provided as empty value (""), bold format is
used.

Example:
FormatAllergensFromMSSQL("wheat flour,salt,veg fat,hazelnuts","server\sqlexpress","db","password","Allergens","Allergens","bold,italic")
Allergens from any SQL database

This function will accept the list of ingredients and connection string to the SQL database. The
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function reads all records from the selected field in the specified table and creates the RTF
code with highlighted allergens. All words from the spreadsheet that are matched in the
Ingredients will be formatted by the Highlight specification.
Note: The function requires the database driver for your flavor of SQL server to be installed.
Syntax:
FormatAllergensFromSQL(Ingredients, ConnectionString, Table, Field,
Highlight)
Parameter

Description

Ingredients

The CSV list of ingredients.

ConnectionString

The connection string providing information to access your SQL server. The
connection string must be provided based on the database driver you are
using.
Connection strings for many flavors of data sources can be found online at
http://www.connectionstrings.com.

Table
Field

The name of the table containing the list of allergens.
The name of the field containing the allergens.

Highlight

The CSV list of formatting switches you want to apply to the allergen. You can
use "bold", "italic", "underline", "caps", text color and/or background color. The
colors are formatted in hex syntax for RGB scheme, for example "#FF0000" for
red. For text color just provide the color code, for the backround, prefix the
color code with "bg:", such as "bg:#FF0000".
This is optional parameter. If provided as empty value (""), bold format is
used.

Example:
FormatAllergensFromSQL("wheat flour,salt,veg fat,hazelnuts","Provider=OraOLEDB.Oracle;Data Source=XE;User Id=useer;Password=password;","Allergens","bold,italic")
FormatAllergensFromSQL("wheat flour,salt,veg fat,hazelnuts","Driver=
{MySQL ODBC 5.3 UNICODE Driver};Server=mysqldb;Database=Allergens;User=mysql_user;Password=password;Option=3;","Allergens","bold,italic")
Allergens embedded within the custom tags

This function will accept the list of ingredients where the allergens are marked with tag. The
tag is a custom character placed in front of and after the allergen. The value between the two
tags is highlighted as specified by Highlight.
Syntax:
FormatAllergensFromTags(Ingredients,Tag,Highlight)
Parameter

Description

Ingredients

The list of ingredients where the allergens have been enclosed by tag characters.

Tag

The character that is used in front of and after the allergen. Make sure to select
the character that is not used anywhere else in this string.

Highlight

The CSV list of formatting switches you want to apply to the allergen. You can
use "bold", "italic", "underline", "caps", text color and/or background color. The
colors are formatted in hex syntax for RGB scheme, for example "#FF0000" for
red. For text color just provide the color code, for the backround, prefix the
color code with "bg:", such as "bg:#FF0000".
This is optional parameter. If provided as empty value (""), bold format is
used.

Example:
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FormatAllergensFromTags("*wheat* flour,salt,veg fat,*hazelnuts*","*","bold,italic")
Syntax of Allergen formatting functions with support for exclusions
User provided list of allergens

This function will accept the list of ingredients and list of allergens in two variables and create
the RTF code with highlighted allergens. All words from the Allergens that are matched in
the Ingredients will be formatted by the Highlight specification. The last parameter
provides the CSV list of sentences that must not be highlighted even if they contain the allergen words.
Syntax:
FormatAllergensWithExclusions(Ingredients,Allergens,Highlight,Exclusions)
Parameter

Description

Ingredients

The CSV list of ingredients.

Allergens

The CSV list of allergens.

Highlight

The CSV list of formatting switches you want to apply to the allergen. You can
use "bold", "italic", "underline", "caps", text color and/or background color. The
colors are formatted in hex syntax for RGB scheme, for example "#FF0000" for
red. For text color just provide the color code, for the backround, prefix the
color code with "bg:", such as "bg:#FF0000".
This is optional parameter. If provided as empty value (""), bold format is
used.
The CSV list of words & sentences that will not be highlighted even if they contain allergen words.

Exclusions

For example: Milk is an allergen so the word "milk" must be highlighted,
but not when used in context "coconut milk". In this case "coconut milk" must
be defined as exception.

Example:
FormatAllergensWithExclusions("wheat flour,salt,veg fat,hazelnuts,
coconut milk","wheat,hazelnuts,milk","bold,italic","coconut milk")
FormatAllergensWithExclusions(Ingredients,"wheat,hazelnuts","bold,italic",Exclusions)
Allergens from Microsoft Excel spreadsheet

This function will accept the list of ingredients and location of the Microsoft Excel spreadsheet. The function reads the allergens from the spreadsheet and creates the RTF code with
highlighted allergens. All words from the spreadsheet that are matched in the Ingredients
will be formatted by the Highlight specification. The last parameter provides the CSV list
of sentences that must not be highlighted even if they contain the allergen words.
Syntax:
FormatAllergensFromExcelWithExclusions(Ingredients,ExcelFile,Spreadsheet,Field,Highlight,SpreadsheetEx,FieldEx)
Parameter

Description

Ingredients

The CSV list of ingredients.

Excel file

The full path and filename to the Microsoft Excel file containing the allergens.

Spreadsheet

The name of the spreadsheet containing the list of allergens.
The name of the field (column name) containing the allergens.

Field

You can also provide the column index number containing the list of allergens.
Column A must be provided as "1", column B as "2", etc.
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Parameter

Highlight

Description
The CSV list of formatting switches you want to apply to the allergen. You can
use "bold", "italic", "underline", "caps", text color and/or background color. The
colors are formatted in hex syntax for RGB scheme, for example "#FF0000" for
red. For text color just provide the color code, for the backround, prefix the
color code with "bg:", such as "bg:#FF0000".
This is optional parameter. If provided as empty value (""), bold format is
used.

SpreadsheetEx

The name of the spreadsheet containing the list of word & sentences to be
excluded from allergen formatting.
The name of the field (column name) containing the words & sentences to be
excluded from the formatting.

FieldEx

You can also provide the column index number containing the list of allergens.
Column A must be provided as "1", column B as "2", etc.

For example: Milk is an allergen so the word "milk" must be highlighted,
but not when used in context "coconut milk". In this case "coconut milk" must
be defined as exception.

Example:
FormatAllergensFromExcelWithExclusions("wheat flour,salt,veg
fat,hazelnuts","c:\files\data.xlsx","Sheet1","1","bold,italic","Sheet2","2")
FormatAllergensFromExcelWithExclusions(Ingredients,"c:\files\data.xlsx","Sheet1","1","bold,italic","Sheet2","2")
Allergens from Microsoft Access database

This function will accept the list of ingredients and location of the Microsoft Access database.
The function reads the allergens from the specified table and creates the RTF code with highlighted allergens. All words from the spreadsheet that are matched in the Ingredients will
be formatted by the Highlight specification. The last parameter provides the CSV list of
sentences that must not be highlighted even if they contain the allergen words.
Syntax:
FormatAllergensFromAccessWithExceptions(Ingredients,AccessDb,Table,Field,Highlight,TableEx,FieldEx)
Parameter

Description

Ingredients

The CSV list of ingredients.

AccessDb

The full path and filename to the Microsoft Access file containing the allergens.

Table

The name of the table containing the list of allergens.

Field

The name of the field containing the allergens.

Highlight

The CSV list of formatting switches you want to apply to the allergen. You can
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Parameter

Description
use "bold", "italic", "underline", "caps", text color and/or background color. The
colors are formatted in hex syntax for RGB scheme, for example "#FF0000" for
red. For text color just provide the color code, for the backround, prefix the
color code with "bg:", such as "bg:#FF0000".
This is optional parameter. If provided as empty value (""), bold format is
used.

TableEx

The name of the table containing the list of word & sentences to be excluded from
allergen formatting.
The name of the field containing words and sentences that will not be highlighted even if they contain allergen words.

FieldEx

For example: Milk is an allergen so the word "milk" must be highlighted,
but not when used in context "coconut milk". In this case "coconut milk" must
be defined as exception.

Example:

FormatAllergensFromAccessWithExclusions("wheat flour,salt,veg
fat,hazelnuts","c:\data\db.mdb","tblAllergens","Allergens","bold,italic","tblAllergensEx","Ex
FormatAllergensFromAccessWithExclusions(Ingredients,"c:\data\db.mdb","tblAllergens","Allergens","bold,italic","tblAllergensEx","Exclusions")
Allergens from Microsoft SQL database

This function will accept the list of ingredients and location of the Microsoft SQL database.
The function reads all records from the selected field in the specified table and creates the
RTF code with highlighted allergens. All words from the spreadsheet that are matched in the
Ingredients will be formatted by the Highlight specification. The last parameter
provides the CSV list of sentences that must not be highlighted even if they contain the allergen words.
Note: The function requires the SQL Server Native Client ODBC driver. It is installed
with the SQL Server tools that you can download from Microsoft web pages.
Syntax:
FormatAllergensFromMSSQLWithExclusions(Ingredients,SQLServer,dbUsername,dbPassword,dbName,Table,Field,Highlight,TableEx,FieldEx)
Parameter

Description

Ingredients

The CSV list of ingredients.

SQLServer

The SQL server name and optional instance, for example server\instance
The user name defined in the SQL server.

dbUsername

Note: This is SQL user, not Windows user account.
dbPassword

The password for the SQL user name.

Table

The name of the table containing the list of allergens.

Field

Highlight

The name of the field containing the allergens.
The CSV list of formatting switches you want to apply to the allergen. You can
use "bold", "italic", "underline", "caps", text color and/or background color. The
colors are formatted in hex syntax for RGB scheme, for example "#FF0000" for
red. For text color just provide the color code, for the backround, prefix the
color code with "bg:", such as "bg:#FF0000".
This is optional parameter. If provided as empty value (""), bold format is
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Parameter

Description

TableEx

The name of the table containing the list of word & sentences to be excluded from
allergen formatting.

used.

The name of the field containing words and sentences that will not be highlighted even if they contain allergen words.
FieldEx

For example: Milk is an allergen so the word "milk" must be highlighted,
but not when used in context "coconut milk". In this case "coconut milk" must
be defined as exception.

Example:

FormatAllergensFromMSSQLWithExclusions("wheat flour,salt,veg
fat,hazelnuts","server\sqlexpress","SQLuser","password","tblAllergens","Allergens","bold,ital
Allergens from any SQL database

This function will accept the list of ingredients and connection string to the SQL database. The
function reads all records from the selected field in the specified table and creates the RTF
code with highlighted allergens. All words from the spreadsheet that are matched in the
Ingredients will be formatted by the Highlight specification. The last parameter
provides the CSV list of sentences that must not be highlighted even if they contain the allergen words.
Note: The function requires the database driver for your flavor of SQL server to be installed.
Syntax:
FormatAllergensFromSQLWithExclusions(Ingredients, ConnectionString,
Table, Field, Highlight, TableEx, FieldEx)
Parameter

Description

Ingredients

The CSV list of ingredients.

ConnectionString

The connection string providing information to access your SQL server. The
connection string must be provided based on the database driver you are
using.
Connection strings for many flavors of data sources can be found online at
http://www.connectionstrings.com.

Table
Field

Highlight

The name of the table containing the list of allergens.
The name of the field containing the allergens.
The CSV list of formatting switches you want to apply to the allergen. You can
use "bold", "italic", "underline", "caps", text color and/or background color. The
colors are formatted in hex syntax for RGB scheme, for example "#FF0000" for
red. For text color just provide the color code, for the backround, prefix the
color code with "bg:", such as "bg:#FF0000".
This is optional parameter. If provided as empty value (""), bold format is
used.

TableEx

The name of the table containing the list of word & sentences to be excluded from
allergen formatting.
The name of the field containing words and sentences that will not be highlighted even if they contain allergen words.

FieldEx

For example: Milk is an allergen so the word "milk" must be highlighted,
but not when used in context "coconut milk". In this case "coconut milk" must
be defined as exception.

Example:
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FormatAllergensFromSQLWithExclusions("wheat flour,salt,veg fat,hazelnuts","Provider=OraOLEDB.Oracle;Data Source=XE;User Id=user;Password=password;","Allergens","bold,italic","tblAllergensEx","Exclusions")

FormatAllergensFromSQLWithExclusions("wheat flour,salt,veg fat,hazelnuts","Driver={MySQL ODBC 5.3 UNICODE Driver};Server=mysqldb;Database=Allergens;User=mysql_
user;Password=password;Option=3;","Allergens","bold,italic","tblAllergensEx","Exc
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Printing and Previewing Labels
Preview and Print a Label
If you want to print a label, you can use the print preview to simulate a print output. The label preview shows the label on the screen.
Simulate printing 10 labels on the screen to check label layout and printing procedure.

1. Click on
icon in the Standard toolbar or select the command Print in the File
menu. The Print dialog box appears.
2. Enter 10 for Label Quantity and click on the Preview button. The software will close the
dialog box and simulate the production for 10 labels on the screen.
Note: You can select between the quantity of the labels and the quantity of the pages. The page
can have one or more labels and the labels are arranged on the page in columns and rows. If you
have eight labels on the page, the quantity of ten pages will print 80 labels.
When you are certain that the labels will be printed correctly and the preview shows the correct
values, you can proceed to real printing. To actually print the labels, do the following:

1. Click on

icon in the Standard toolbar. The Print dialog box appears.

2. Enter 10 for the Label Quantity and click on the Print button. Your printer will now
print 10 labels.
Note: To manage fast and easy label printing, you can print labels from the application NicePrint
or the form generated with NiceForm. For more information refer to the chapter Other Applications.

Store and Recall Printing Mode
Store and Recall printing mode is the method of optimized label printing.
In this mode the software does not send the data for each label individually to the printer, a process
that used in standard printing mode. Instead for each print action label recall command is sent to
the printer. The obvious benefit is reduction of data sent to the printer. Typically a few bytes of
data is sent to the printer, compared to a few kilobytes with normal printing.
Store and recall printing method is a perfect solution for label printers, where high response and
high-throughput is required. Usually with embedded and integration systems. Once you have
defined the store and recall printing mode in the label designer, the same benefits are available
from the form designer and middleware integration module.
Instead the label printing process is broken into two processes:
l

Store label
During this process the software creates a description of the label template formatted in
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the printer command language of the selected printer. The software then sends the created command file to the printer memory and stores it there.
Once the label has been stored in the printer, it remains there until you format the printer
memory, or switch off the printer. There are various memory locations in the printer and
some of them are non-volatile and you can lose the contents, when the printer switches
off
l

Recall label
The label stored in the printer memory can be immediately printed out. Using the recall
process the software creates another command file to instruct the printer which label from
the memory to print. The recall label command can occupy a few bytes of data only. It
depends on the situation you have.
l Fixed labels: If you have labels without any variable contents, the recall command
file contains just the recall label command.
l

Variable labels: If you have labels with some variable fields, the command file will
include the values for these variables and the recall label command.

To use the store and recall printing mode, do the following:

1. Make sure to select the appropriate printer driver for your label printer. Not all label printers have the ability to use the store and recall printing mode.
2. Select File -> Label Setup and go to the Printer tab.
3. Enable the option Store label template and recall for printing in the Print Mode section.
4. Click OK.
5. Define you label template.
All object on the label for which you want to be variable should be formatted as internal
printer objects. You must format text objects in printer internal fonts (not Truetype fonts).
You must format the barcode objects as printer internal barcodes. You can still use variable objects formatted in Truetype fonts, or variable pictures, or database fields, however,
during the label store process default values will be sent to the printer.
6. When ready for printing, select File -> Print.
7. Go to the Store Label Template tab.
8. Make sure the 'Store location' points to the correct memory location in the printer.
9. Type in or select the values for variable objects that are not formatted as internal printer
objects. These variables will have the same value on each label, they will behave as they
are objects with fixed value.
10. Click on Store button to create the command file with label template description and
send it to the printer.
11. Go to the General Tab.
12. Type in the values for prompted variables on the label. These variables link to the
internal printer objects on the label, that's why you can set their values to different value
with every print.
13. Click on Recall button to send the variable values and recall label command to your label
printer.

- 165 -

14. You can preview the data that is sent to the printer using the Store and Recall function. In
the Print dialog window, select Analyze Stream on the Advanced tab. A Print
Stream Analysis window will open, displaying the stored data in the Store Stream
frame. The Recall Frame will display the data that is sent to the printer during subsequent printing of a stored label.

Previewing Pictures
When you place a picture on the label, in design mode it is always shown in color-depth as defined
in the picture.
However, when previewing the labels on-screen, the preview of the pictures depends on the dithering option set in the printer driver. All color pictures (except WMF and EMF files) are converted
to monochrome images. The illusion of colors and shades of gray is accomplished by varying the
pattern of dots. More dots close together will provide darker shade of gray.
The preview of the label will show pictures in the same way as they will be printed accordingly to
the dithering setting. More accurate print preview is guaranteed this way.
If the picture is not previewed as you would like to print it, change the dithering setting in the
printer driver.

Optimize the Printing Speed
There are many factors that affect the printing speed. By following the guidelines below you can
dramatically increase the speed of printing:
l

l

l

l

l

If your printer supports parallel and serial port, use the parallel port. Computer can send
data to printer over parallel port much faster than over serial port.
Use printer's internal fonts instead of Windows' true-type fonts. True-type fonts must be
sent to printer as graphics and therefore the size of data sent to printer is much bigger
(couple of kilobytes). When using internal fonts, only the text is sent to printer (couple of
bytes). If you must use true-type fonts, use the NiceMemMaster program, to download
these fonts to printer's memory and later access these fonts as internal printer fonts (only
if your printer supports this).
Avoid use of graphics on labels. If you must print graphics on labels, use the
NiceMemMaster program to download these graphics to printer's internal memory (only
if your printer supports this).
When using barcodes, make sure that you don't print barcodes as graphics, if your printer
supports printing barcodes.
When using counters, the printer will internally increment the numbers if the internal
fonts are used. (if supported by the printer) This means, that the printer will only receive
the first number of object, and will later increment this number to print other labels.
Using this option also reduces the amount of data transferred between computer and
printer, but the difference is noticeable only with high quantity of labels.
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l

l

Set the printing speed to a higher value (if your printer supports it). Note that setting the
printing speed usually affects the quality of printing. The higher the speed, the lower the
quality. You will have to find an acceptable compromise for this.
Don't print too much data on labels. If the speed of printing is an important factor, you
should consider using preprinted labels, and only print the data, that is different on each
label.

Reprint Labels
The ability to reprint labels is one of a stronger key values of the labeling software. When you
have the print logging enabled, the software will keep track of all printed labels. The Microsoft
Access database stores all information about the printed labels. Not just basic information like the
user name, the label name, label quantity, time of printing, printer name and similar data, but also
advanced information like the values of variable fields on the label, status of counters, printed
quantity and label job status.
Because all information about the printed label is remembered, you can reprint the whole print
jobs, or individual labels from the job. The reprint feature is available as long as the information
about the printer job is stored in the log database. You can use the reprint feature to print the label
with the same information on the same printer as originally used, or to any other available printer.
Note: The reprint feature works with the same data on the label, but not with the same job files.
The software recreates the print jobs on-the-fly using the information of variables fields from the
log file.
Before each reprint action, the software checks the status of the printed label, as follows:
Label Version
Change
Printer
Availability

Version of the label file is checked against the label version information
in the log database. If the label version on the disk is greater than the
version of the printed label, you will need to confirm printing of
changed label.
Each label file remembers to which printer the label must be sent. If
the printer in not accessible, you can select some other printer driver.

To reprint labels, do the following:

1. Select Tools -> View Log File.
2. Select the log entry in the table that you want to reprint.
3. Click on the Reprint button.
4. Visually check the label preview if the selected label is really the correct one.
5. Select which label or labels you want to reprint from the print job. Put a tick mark in the
selection box before the line. You can reprint the currently selected label, all labels from
the beginning of the print job, all labels until the end of the print job, or select individual
labels.
Note: To find a label with some particular value of variable field, use the Find toolbar. The
labels matching the criteria will be selected in the table.

6. Select the printer to which you want to reprint the labels.
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Note: You can select any available printer, not the original printer only, because the software
will process the label again, not just send the same print job to the printer.

6. Click OK.
7. Click Close.

Use Custom Edit Forms
If you have a lot of prompted variables on a label, you can use custom forms that allow userfriendly data entry.
Do the following:

1. Open your label.
2. Select Label Setup from the File menu.
3. Go to Printing tab.
Note: If Printing tab is not visible, click on the button Advanced at the bottom of the dialog box.

4. Type in the name of the form file you want to use for printing.
5. If the form does not exist, click on the button Define to create it.
6. Click on the OK button.
When you will select the Print command, the form will start and replace the standard Print dialog
box in the labeling software.

NicePrint
NicePrint is a standalone application that enables fast and easy label printing. You can start it from
labeling software program group in the Start menu. Using the application, you can perform all printing steps in one single window:
l

Select the label for printing

l

Set the values for variables

l

Select records in the database

l

Change the printer and its properties

l

Define label quantity

l

See label preview

l

Print the label
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The Application provides fast access to label printing
Note: If you provide the label name as a parameter in the command line next to the NicePrint
executable name, the application will open that label.
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Integration and Connectivity
Overview
The most common method is to print labels directly from the labeling software. But sometimes
there might be other requirements of label production. The labeling software has a wide connectivity and integration options so you do not have to use the labeling software interactively but
through ActiveX interface or DDE connectivity. You can use a "print-engine" totally integrated to
your custom application and invisible to end-user's eyes.
If you do not require such tight integration to your application, you can use the automation module,
add-on utility for non-programming integration to existing systems and fully automated printing. A
set of actions is defined that are trigger if pre-defined event occurs. These actions can open the
label, connect it to database, fill variable's values, connect to proper printer and print the required
number of labels. You can even build your custom data-entry and printing applications with
NiceForm in a totally user friendly way without any programming skills required.

Command Files
Use Command Files
You can use command files to instruct the print engine what to do. The command files use the
structure of NiceCommands in order to send the commands to the print engine.
The following command files are supported:
l

JOB file

l

XML file

l

CSV file

You can use the command files from several applications:
l

From labeling software interactively (command File -> Command Files), or automatically
(the name of the command file specified as parameter in the command-line, works for
JOB files)

l

From NiceForm in action Run Command File

l

From Automation application in action Run Command File

The command files are always processed in order from top to bottom of the file. The first command in the file is processed first. The order of appearance is important. For example: you need to
specify the printer first and then print the label.
The command files are stored in a text file. Unicode values are supported.
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Command File: JOB File
The commands available in the JOB command files are NiceCommands.
See the chapter of NiceCommands for more information about their syntax and method of usage.
Sample JOB Command File

Example of NiceCommands usage in a JOB file:
LABEL "C:\LABELS\LABEL1.LBL"
SET Title = "Some string"
SET BarCode = "123456789012"
PRINT 10
FILECLOSE
The words formatted in bold are NiceCommands. The sample above will command the print
engine to do the following:

1. Load label stored in a file C:\LABELS\LABEL1.LBL.
2. Set the variable Title to the value "Some string".
3. Set barcode value to "123456789012".
4. Print ten labels. In this case ten copies of the label.
5. Close the label file.
See also the Samples folder. It provides additional JOB file samples.

Automatic Print with JOB Files
Use this facility for automatic un-attending printing from the labeling software. The JOB file is a
plain text file with commands that instruct the labeling application what to do automatically. Usually the scenario goes like this:

1. The software opens the label file, as defined by LABEL command.
2. The software sets the values of variables on the label, as defined by SET commands.
3. Optionally, the software selects some other printer for printing, as defined by PRINTER
command.
4. The software prints the required amount of labels, as defined by PRINT command.
The Automatic Print can be used interactively in the application or with command-line parameter.
To start Automatic Print with JOB file interactively, do the following:

1. Open label designer.
2. Select File -> Command Files -> Print.
3. Browse to the .JOB file and click Open.
Note: Interactive mode is useful for testing your .JOB files. If there is any syntax error with the
command in the JOB file, you will be notified about it.
To start Automatic Print with command-line parameters, do the following:
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1. Make sure the syntax of your commands in the .JOB file is correct.
2. Start the software from command prompt with the following syntax:
NLABEL6.EXE <full path to your .JOB file>
For example: NLABEL6.EXE c:\My Labels\PRINT.JOB
You can find the file NLABEL6.EXE in the Bin folder in the Program Files folder structure.

Using JOB Files
JOB file is one option to automate label printing. When you do not want the user to interact directly
with label designer to print labels using JOB file can help. The print operator does not need to be
confronted with the label designer and see all design options not really important during the printout. Instead a JOB file drives the printing process.
JOB file is a plain text file that contains commands. The text can have Unicode formatting. The
commands instruct the label print engine what actions must be executed to successfully print the
label. The commands are executed in order from top to bottom. The order of commands is important.
The JOB files are commonly used to automate label printing process. Here are some ideas where
to use JOB files:
l

Command-line option in the labeling software. The software will open the JOB file and
process the commands within. If last command is QUIT, the software will close when
printing completes.
For example:
c:\Program Files\EuroPlus\NiceLabel 6\\bin\NLABEL6.EXE c:\MyJOB\FILE01.JOB

n

Action Run Command File in applications NiceForm (application generator) and (automation module).

Note: When working with job files make sure to remember that the '\n' sequence is understood as
the newline character. If you have the folder names beginning with '\n' you have to put an extra
backslash character in front of the sequence. You must encode the path and filename 'c:\NewJobs\Print.JOB' as 'c:\\NewJobs\Print.JOB'.

Command File: CSV File
The commands available in the CSV command files are a subset from NiceCommands. You can
use the following commands: Label, Set, Port, Print and Printer. Of course, the syntax of the commands differs a little bit when used in CSV file.
CSV Command File Structure

The CSV stands for Comma Separated Values. This is the text file where field values are delimited by the comma (,) character. The text file can contain Unicode value (important for multi-language data).
Each line in the CSV file contains the commands for one label printing.
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The first row in the CSV command file must contain the column names. This is important for the
labeling software to know what is the order of appearance of fields and how is the data organized. Several column names are pre-defined.
Column Name
@Label

@Printer

@Quantity

@Skip

@IdenticalCopies

@NumberOfSets

@Port

Other fields

Description
The name of the label to use. It is recommended to include
label path and filename. Note: You can provide label name
only, but be sure that print engine will try locate the label in
the correct folder. Is required.
Use this field to override the printer defined on the label. Print
the label to some other printer. The other printer must be
accessible from this computer. Use the printer name for value
of this attribute. Not required.
Use this field to specify the number of labels to print. Possible
values: numeric value, VARIABLE or UNLIMITED. Is
required.
Use this field to specify how many labels to skip at the beginning. This feature is useful if you print sheet of labels to laser
printer, but the sheet is partial already printed. Not required.
Use this field to specify how many label copies should print for
each unique label. This feature is useful when printing labels
with data from database or when you use counters, and you
need label copies. Not required.
Use this field to specify how many times the printing process
should repeat. Each label set defines the occurrence of the
printing process. For example: setting this value to 5 will cause
the printing process to repeat five times. Not required.
Use this field to specify the port name for the printer. You can
override the default port as specified in the printer driver. Not
required.
All other fields define the name of the variables from the label.
The fields provide values for variables.

The order or appearance of the columns in the CSV file is no important. But it is important that
all rows in the same CSV file have the same structure.
Session print is used automatically. Session printing is disabled when you change the printer or
label within the same CSV file.
All columns in the CSV file are used when setting the values to the label variables. If the variable with the name from CSV does not exist on the label, no error message is displayed.
Sample CSV Command File

The sample presents the structural view on the fields that you can use in the CSV command file.
@Label,@Printer,@Quantity,@Skip,@IdenticalCopies,NumberOfSets,@Port,Var1,Var2 …
Label name, printer name, Quantity, Skip, IC, NS, port name, variable
value, variable value,…
Label name, printer name, Quantity, Skip, IC, NS, port name, variable
value, variable value,…
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Command File: XML File
The commands available in the XML command files are a subset from NiceCommands. You can
use the following commands: Login, Quit, Label, LabelClose, Set, Port, Printer, SessionEnd, SessionStart, SessionPrint, SetDatabase and SetTable. Of course, the syntax of the commands differs
a little bit when used in XML file.
The root element is Nice_Commands that must be present in the XML command file. The next element that must follow is Label, that specifies which label to use. Next you have two options for
label printing:

1. Print labels normally using the element Print_Job.
2. Print labels in session using the element Session_Print_Job.
You can also change the printer to which the labels will print, you can set the variable value and
you can change the database that is currently used on the label.
XML Command File Structure

XML Command File Structure Explained
Below is the description of the command file structure. There are several elements that contain
attributes. Some attributes are required, other are optional. Some attributes can occupy predefined values only, for other you can specify the custom values.
Nice_Commands: Is root element with two attributes
l
l

login: Performs login procedure into the program. Not required.
quit: Closes the print engine when the actions execute. Will remove the print engine
from the memory. Is required.

Label: The element that opens the label in the print engine. If the label is already opened, it will
be re-used. You can use this element several times within the command file.
l

l

name: Attribute contains the label name. It is recommended to include label path and
filename. Note: You can provide label name only, but be sure that print engine will try
locate the label in the correct folder. Is required.
close: The attribute instructs the print engine, if the label should close after printing, or
it should remain open. Possible values: true, false. Is required.

Print_Job: The element that unions the commands for printing labels. You can use this element
several times within the command file.
l

l

l

l

printer: Use this attribute to override the printer defined on the label. Print the label to
some other printer. The other printer must be accessible from this computer. Use the
printer name for value of this attribute. Not required.
quantity: Use this attribute to specify the number of labels to print. Possible values:
numeric value, VARIABLE or UNLIMITED. Required.
skip: Use this attribute to specify how many labels to skip at the beginning. This feature
is useful if you print sheet of labels to laser printer, but the sheet is partial already printed. Not required.
job_name: Use this attribute to specify the name of your job file. The specified name is
visible in the print spooler. Not required.
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l

print_to_file: Use this attribute to specify the file name where you want to save the
printer commands. Not required.

Session_Print_Job: The element that unions commands for printing labels. It considers session
print rules. You can use this element several times within the command file. For available attributes lookup the attributes for the element Print_Job. All of them are valid, you only cannot use
the quantity attribute. See the description of the element Session to find out how to specify label
quantity in session printing.
Database: The element that overrides the database selection on the label. Use it whenever you
do not want to use data from the database that is configured on the label, but some other database. You can use this element several times within the command file.
l

name: The attribute contains the database name. Required.

Table: The element that overrides the table selection on the label. Use it whenever you do not
want to use data from the table that is configured on the label, but some other table. You can use
this element several times within the command file.
l

name: The attribute contains the table name. Required.

Variable: The element that sets the value of variables on the label. You can use this element several times within the command file.
l

name: The attribute contains the variable name. Required.

Sample XML Command File

The sample presents the structural view on the elements and their attributes as you can use them
in the XML command file.
<nice_commands login="username" quit="true">
<label name="label name 1" close="false">

<session_print_job printer="printer name 1" skip=0 job_name="job
name 1" print_to_file="filename 1">
<database name="db1">database name 1</database>
<table name="table1">table name 1</table>

<session quantity="10">
<variable name="variable name 1" >variable value 1</variable>
</session>
</session_print_job>

<print_job printer="printer name 2” quantity="10" skip=0
identical_copies=1 number_of_sets=1 job_name="job name 2" print_to_
file="filename 1">
<database name="db1">database name 1</database>
<table name="table1">table name 1</table>
<variable name="variable name 1" >variable value 5</variable>
</print_job>
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</label>
</nice_commands>

Automating the Software
Automation with ActiveX
Programming interface: Automation (ActiveX)
The information in this chapter is for advanced users and application developers only. If you don't
plan to write applications that use the embedded print engine to print labels, you can skip this
chapter entirely.
The labeling software can act as an OLE Automation server. Its class name is NiceLabel6.Application.
The commands actually allow you to have more control over the labeling software from your own
application. Active X allows also the status of variable managing procedure to be returned to your
application so you can control printing process more accurately. A lot more programming functionality is allowed. The ActiveX interface makes is possible to query every label element for its
properties. The same goes for variables and functions defined on the label. The properties of all
label elements can be modified prior printing if for some reason you do not want to use labeldefined settings. You can even create a label preview in your own application.
For more information about programming interface please refer to the manual ActiveX and DDE
Programming manual available on the product CD-ROM and on the product website.
You can also auto-generate the description of the interface using /typelib command-line parameter. It will create NLABEL6.OLB with description of methods, properties and events that the
labeling software. Appropriate application for viewing .OLB files is required to be able to see the
file contents.

Programming Samples
Programming samples demonstrate how you can use the labeling software as a print-engine from
your applications. The programming samples are not installed with the labeling software.
However, they are available for separate install as the add-one, Integration Pack. You can install
the Integration Pack from the product CD or from the product web site.
The samples are available for different development platforms (MS Visual Basic, Borland Delphi,
C++ and other). You can take a look at the ready made sample and use the similar code immediately inside your application. Refer to the documents enclosed to the Integration Pack to see how
to embed the label print engine inside your application. The whole programming API is documented in the Programming Guide. It will help you start using the label print engine from your custom application.
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Automation with DDE
DDE Communication
You can use DDE connection to print the labels from your Windows applications, that you develop
in standard programming environments such as Microsoft Visual Basic, Borland Delphi, C,
Microsoft Access…
To create the DDE communication the client application must use the following DDE parameters:
Service = NiceLabel6
Topic=LINE or JOB

When you are using topic JOB the content is the name of the command file, which must be run.
When you are using topic LINE the content is one of the commands.
When you want to use DDE communication to manage the labeling software, it is probably the
best, when the user doesn't know for the background running of this application. For this purpose
you can use this command parameter:
NLABEL6.EXE <label_name> /s

The parameter s (silent) prevents that the software will show on the screen. It is run in the minimized form.

Integration to SAP R3
Integration to SAP/R3
The labeling software can be used to design labels that should be printed to thermal printers from
SAP system. Two possible methods can be implemented.
Printing
directly
from
SAP/R3

Using this option the labels are designed with the labeling software on a PC computer and are then exported to SAP format.
Export procedure will generate .ITF native file with description
of the label. This .ITF file is then uploaded to SAP system and
users can print labels directly from SAP/R3.
The advantage with this approach is that no PC is required for
label printing. Once the label is created, you do not need the label
designer any more.
However, there are several disadvantages. First of all, every label
printer is not suitable for label printing directly from SAP/R3 system. SAP has certain limitations that the printer has comply to.
There is also limited support for graphics elements. Variable
graphics cannot be used at all. And only some printer models support printing of fixed images/truetype fonts. Variable text fields on
the label has to be set in internal printer fonts that usually do not
look as good as truetype fonts. Only prompted variables can be
used. Because the label design application is not present at printtime, functions and advanced label elements cannot be used.
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For more information about connecting labeling software to SAP R/3 system please refer to the
appropriate White Paper on the web site of contact technical support.

Label Export
Label Export
Label Export functionality is used heavily from stand-alone and some print-only variants of this
labeling software. Its functionality is tightly connected to the ability of printer that is used on the
label. Export is only available when using thermal printer drivers shipping with the labeling software. The printer driver also must have built-in the support for the required export.
Windows version of labeling software on PC computer is used to design the label layout compliant
to the labeling request. All label elements can be used on the label (text, paragraph, RTF, barcode,
image, line, rectangle, ellipse, ...). When printing fixed labels, there is no issue you should pay
attention to. The label elements are printed as graphics.
The exported printer file can have fixed or variable values. If you have label with fixed fields, you
can send it directly to the label printer. If you have a label with variable fields, some external
application has to assign values to the variable fields. Usually, the external application does the
following:
l

Takes the generated print file

l

Searches for the locations of the variable fields

l

Inserts the correct values for these fields

When you use variable fields on the label, you have to pay special attention to their format. All
variable elements must follow some designing rules.
All variables
on the label
have to be
prompted
Support for
functions is
limited (Concatenate, Subset, etc).

All counters
have to be
incremented
by printer
Variable
graphics are
not supported

User must be able to set their values before printing.
Date/Time variables have to acquire the data from the
printer clock not from PC system clock.
As PC labeling software is not available at print time, the
functions cannot be processed, so you cannot use them on
the label.
There are some exceptions, for example Export to
Pocket PC, where some functions can be used, because
the application that will eventually print these files
knows how to process them.
As PC labeling software is not available at print time, the
printer must be capable of using internal counters. Make
sure you defined the counter variable on the label as the
printer internal hardware counter, not software counter.
Because PC labeling software is not available at printtime, it cannot handle the variable graphics. Any image
on the label has to be static.

Label Export is one method of label printing from outside of labeling application. It requires some
other application to be able to open exported label format, parse it and then print it. There are
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numerous other possibilities to integrate label printing to existing systems. More information is
available on the product web site.

Commands
NiceCommands
The printing with the software can be automatic. There are two ways for automation. The first one
is with the use of the command files (JOB file) which is used with Automatic print command from
File menu. The second way is with the help of any other Windows application, which enables
DDE communication between the programs.
In the both ways you can use the same commands. When you are using the automatic print, the
commands must be written one per line in the command file (JOB file). With the DDE communication the commands are send through the DDE channel.
List of Commands

"COMMENT" on the next page
"CREATEFILE" on the next page
"DELETEFILE" on the next page
"EXPORTLABEL" on the next page
"IGNOREERROR" on page 181
"LABEL" on page 181
"LABELCLOSE" on page 181
"LOGIN" on page 181
"MESSAGEBOX" on page 182
"OEMTOANSI" on page 182
"PORT" on page 182
"PRINT" on page 182
"PRINTER" on page 183
"PRINTJOBNAME" on page 183
"QUIT" on page 183
"RETURN" on page 184
"SESSIONEND" on page 184
"SESSIONPRINT" on page 184
"SESSIONSTART" on page 184
"SET" on page 184
"SETDATABASE" on page 185
"SETPRINTPARAM" on page 185
"SETTABLE" on page 186
"TEXTQUALIFIER" on page 186
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COMMENT
;

When developing program code or scripts it is very wise to well document your commands. This
will help you decode what the script really performs, when you will look at the code after some
time.
Use semicolon (;) on the beginning of the line. Everything following it will be treated as script comment and will not be processed by application.

CREATEFILE
CREATEFILE <name_of_the_file>s

This command will create a plain ASCII text file. The file will contain only one line of text.
The purpose of creating such file is to signal some external application that the label processing or
printing has began or has ended.
The example of the CREATEFILE usage is printing labels with the data from some text file. First
the external application prepares variable data for the labels and stores the data into the text file.
Then labeling software is activated and printing starts. A CREATEFILE command is used to create a file on the disk. The appearance of the file represents a signal to the application that the current printing process is finished.

DELETEFILE
DELETEFILE <name_of_the_file>

This command deletes the specified file. You can use it in combination with CREATEFILE command.

EXPORTLABEL
EXPORTLABEL ExportFileName [, ExportVariant [, CreateLVXFile]]

The command is implemented to automate the "Export to printer" command. You can manually
access the command using File -> Export -> Export to printer. The label is exported directly to the
printer and stored in the memory for off-line printing. The user can recall the label with keyboard
on the printer or sending a command file to the printer.
ExportFileName
ExportVariant

CreateLVXFile

The parameter is mandatory and defines the filename of a generated print stream for exporting label to the printer.
Some printers support multiple export variants. When manually
exporting, the user can select the export variant in the dialog.
With the EXPORTLABEL command you must specify which
export variant you want to use.
The first variant has the value 0. The second variant has the value
1, etc.
If you do not specify the variant type, value 0 is used as default.
The parameter has two possible values, TRUE or FALSE. If you
set the value to TRUE, besides the generated print stream also the
LVX file will be created. The LVX file contains information about
the variables used in the label.
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For more information about exporting labels and LVX files refer
to the white paper section on the Web site.

IGNOREERROR
IGNOREERROR ON|OFF

Whenever the error occurs in the JOB file, the printing process will terminate and the printing
application will report errors back from the print engine, for example:
l

Incorrect variable is used in JOB file

l

Incorrect value is sent to the variable

l

Incorrect label is being opened (to be verified)

l

Incorrect printer is used (to be verified)

Note: Automation module processes the JOB files and will display the errors in the log pane.
You can ignore the errors that occur during JOB file processing, if you use the undocumented
switch in the registry
Setting the IGNOREERROR command to ON will ignore errors in variables, printer selection,
label selection, and JOB files. This command should be used with utmost care, as the labeling operator will not be warned about potential errors in the mentioned settings.

LABEL
LABEL label_name [, printerName]

The command opens the working label. If the label is already opened, the program will use this
one. It is recommended to write full path name along with the file name.
Note, if variable value contains space characters or commas, you will have to enclose the whole
path in quotation marks (e.g. LABEL "C:\My Labels\sample3.lbl").
The PrinterName (when provided) sets the printer, for which the label will be initially opened. If
non existing printer is provided, the command will raise an error.

LABELCLOSE
LABELCLOSE

The command closes the currently active label. The label application will stay opened.
FILECLOSE command does the same thing, but is depreciated. To speed up label printing do not
use this command frequently. You can have opened more label files simultaneously. If the label is
already opened, it does not have to be loaded and thus the label processing can be performed
quickly.

LOGIN
LOGIN <username>

Performs login procedure into the labeling software. This is necessary when login is required.
Note: This is a DDE command and should not be used in batch command .JOB files.
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MESSAGEBOX
MESSAGEBOX message [, caption]

Displays the message in the message box. The second parameter is used to define the title of the
message dialog box.
If the variable value contains space characters or commas, you have to enclose the text in quotation marks (e.g. MESSAGEBOX "Insert labels in printer", Warning).

OEMTOANSI
OEMTOANSI ON|OFF

This command works in conjunction with command SET. It puts the text that follows the command
SET in proper codepage, so that variable is assigned the proper value.
Use it to put the values following SET command to the proper codepage, so correct characters will
be transferred to labeling application at print time.

PORT
PORT <file_name> [, APPEND]

This command overrides the printer's port name. This command is used to redirect print output to a
file.
<file_
name>

APPEND

Specify the name of the filename to which you want to redirect the
printer file. You can also include the path in front of the filename. If the
file path or filename contain space characters, enclose the whole string in
double quotes.
The parameter APPEND is optional. By default the print action overwrites the file on the disk, when it already exists. If you want to append
the data to the existing file, make sure to use the parameter APPEND.

Once you use a command PORT in the JOB file it will be valid until the next PORT command, or
until the end of file (whichever comes first). If you use PRINTER command after the PORT command has been executed, the PORT setting will overwrite the port defined for the selected printer.
If you want to use the actual port that is defined for the selected printer, you have to use another
PORT command with empty value, like this PORT = "".

PRINT
PRINT quantity [, skip [, identical label copies [, number of label
sets]]]

Command PRINT starts printing. The first parameter is the quantity of the labels that should be
printed.
<number>
VARIABLE

UNLIMITED

This many labels will be printed.
Some variable contains the information how many labels should be
printed. It can be label-defined prompted variable or a field from the
database.
If you use a database to acquire values for variable fields, unlimited
printing will print as many labels as there are record in the database.
If you do not use a database, there is not much sense to use this
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option. In this case the maximum number of labels that thermal
printer internally supports will be printed.
The parameter skip in the command represents the number of the labels you want to omit before
first printed label on the page. The parameter is used for label printing on sheets of paper. When
the part of the page is already printed, you can re-use the same sheet by shifting the start location
of the first label. The rest of the unused labels on the page can be printed with the help of this parameter.
The parameter identical label copies specifies how many copies of the same label should be printed.
The parameter number of label sets specifies how many times the whole printing process should be
repeated.
If you do not need to set some of the supplementary parameters, use their default values.
Skip
Identical label copies
Number of label
sets

0
1
1

Note: Make sure the quantity values are provided as the numeric value, not string value. Do not
enclose the value in the double quotes.

PRINTER
PRINTER <printer_name>

Normally, the PRINT command prints the label to the printer specified in the label file. Using this
command you can override this defined printer and print the label to some other printer.
If the printer name contains space characters, you have to enclose it in quotation marks.
For printer_name always use the system printer name as is displayed in the status line in the label
design application. System printer names are usually the same as the printer names in Printers
folder from Control Panel, but not always, so pay attention. They differ only when you are using
network-connected printers, when you should use "\\SERVER\SHARE" syntax and not a printer
friendly name.

PRINTJOBNAME
PRINTJOBNAME <job_name>

Specifies the print job name that will be used in print manager when using PRINT command. After
printing the name is returned in normal state. Use this option to easier distinguish between different
printing jobs in the Windows spooler.
If variable value contains space characters or commas, you have to enclose the text in quotation
marks (e.g. PRINTJOBNAME "Label for printing").

QUIT
QUIT

This command stops the labeling program after printing. The application is closed.

- 183 -

RETURN
This command returns focus to the main labeling program after the printing completes.

SESSIONEND
SESSIONEND

The function closes data stream.

SESSIONPRINT
SESSIONPRINT quantity [, skip]

You send the data stream to printer using this function. You can use multiple SessionPrint commands one after another and join them in single data stream. The stream is not closed until the command SessionEnd occurs. The meaning of quantity and skip parameters is the same as with
NiceCommand PRINT.
Note: Make sure the quantity is provided as the numeric value, not string value. Do not enclose
the value in the double quotes.

SESSIONSTART
SESSIONSTART

All three commands(SessionStart, SessionPrint, SessionEnd) are used together. If ordinary command SessionPrint is used, every time a complete data stream for printer is sent. If you want to join
multiple Print commands into one data stream, you can use the command SessionStart followed
with any number of SessionPrint commands and in the end use the command SessionEnd. The
stream is not closed until the command SessionEnd occurs.
These commands offer a way of optimal label printing. It is not necessary to generate a complete
data stream for each print session, you can join more sessions in one stream.
Important for the session printing:
l

You cannot change the label template within a session

l

You cannot use commands SETDATABASE and SETTABLE within a session

l

You cannot change the printer (PRINTER command) within a session

l

l

You must set values for all variables from the label within a session, even if some of the
variables will have empty values
When you test the JOB files that use session printing, the command File -> Command
Files -> Print Preview does not work

SET
SET name=variable_value, [,step[, quantity_of_repetition]]

Name is the name of the variable defined on the label. If the variable isn't on the label, an error
will occur. Step and Quantity_of_repetition are option parameter. These parameters tell the increment of the variable and the number of the labels before change.
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If Variable_value contains space characters or commas, you have to enclose the text in the text
qualifier marks. By default the text qualifier is a double quote character, but you can use any other
character (refer to the command TEXTQUALIFIER).
If you want to assign multi-line value to a variable, use the syntax "\r\n" to encode newline character. "\r" is replaced with CR (Carriage Return) and "\n" is replaced with LF (Line Feed). Both,
CR and LF, represent newline character in Windows operating system.
Note: Be careful when setting values to variables that provide data for pictures on the label, as
backslash characters might be replaced with some other characters.
For example, if you assign a value "c:\My Pictures\raw.jpg" to the variable, the "\r" will be
replaced with CR character and the final result is this:
c:\My Pictures
aw.jpg

Note: You cannot use the command SET to set the value to the variable of the type Global. Values of global variables cannot be set from outside of the label designer.

SETDATABASE
SETDATABASE <database_name> = <value>

database_
name
value

The name of the currently used database as defined in the program.
The name of the new table that should be used as data source.

This command allows you to use some other database with the label file and not the one, that was
connected to the label file at design time.
This other database will only be used when printing labels, the label file will remain intact with
connection to the original database.

SETPRINTPARAM
SETPRINTPARAM paramname=value

This command allows you to set advanced print parameters before printing.
Currently supported PARAMNAMES are:
PAPERBIN

PRINTSPEED

PRINTDARKNESS

Use it to specify from which tray the paper
should be used. If the printer is equipped with
more than just one paper / label tray, you can
control which is used for printing.
The name of the tray should be acquired from
the printer driver.
Use this parameter so specify printing speed.
The value for parameter varies from one
printer to the other. Consult printer's manuals for numbers.
Use this parameter so specify printing darkness / contrast. The value for parameter varies from one printer to the other. Consult
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PRINTOFFSETX

PRINTOFFSETY

printer's manuals for numbers.
Use this parameter to specify left offset for all
printing objects. The value for parameter
must be numeric, positive or negative, in
pixels.
Use this parameter to specify top offset for all
printing objects. The value for parameter
must be numeric, positive or negative, in
pixels.

SETTABLE
SETTABLE <table_name> = <value>

table_
name
value

The name of the currently used table as defined in the program.
The name of the new table that should be used as data source.

This command allows you to use some other table with the label file and not the one, that was connected to the label file at design time.This other database table will only be used when printing
labels, the label template will remain unmodified with connection to the original table.
The new database table must be of the same type as original table. For example, you cannot
change the table from dBase to Paradox. The structure of new table has to be identical to the original one.
You can use table from the database that is already connected to the label or from some entirely
different database.

TEXTQUALIFIER
TEXTQUALIFIER %

Text-qualifier is the character that embeds a data value that is assigned to a variable. If the data
value includes space characters, it must be included in the text-qualifier. Otherwise only the data
until the first encountered space character is assigned to the variable.
The default delimiter for the command SET is double-quote character. Because the double-quote
character is used as shortcut for inch unit of measure, sometimes it is difficult to pass the data with
inch marks in the JOB files.
The work-around is to use the double double-quote character instead of just one, but in this case
already the incoming data stream needed to be changed. You can leave the incoming data stream
as-is and change the delimiter you want to use.
For example:
TEXTQUALIFIER %
SET Var1 = % EPAK WRP BD 12"X10 7/32" %

The command TEXTQUALIFIER set the delimiter to percent sign (%). The command SET can
then use new delimiter character (%) for specifying the value to the variable Var1.
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Note:
The command TEXTQUALIFIER is persistent (during single program session). If your JOB file
sets the TEXTQUALIFIER to some value, it will be used until set to another value.

Command Line Parameters
You can use the command line parameters to pass advanced commands to the label designer when
the application starts.
The following command line options can be used when starting the main labeling application.
NLABEL6.EXE [file_name] [options]

[file_name] Represents the full path name of the file. If the label file is given, then this label is
opened. If JOB file is given, then this JOB file is executed. For more information about JOB files,
refer to the topic NiceCommands.
[parameter] can be one or more of the following:
/silent

/r
/u
/i
/typelib

/lang=<LANG>

Silent mode, no toolbar, menu or banner is displayed
and window is minimized. This is useful when using
the labeling software as label printing engine for label
production from other application.
Registers the software as an OLE server.
Unregisters the software as an OLE server.
After JOB file is finished, the label designer exits.
This option will generate NLABEL6.OLB file with
type library description of the ActiveX interface. The
file contains COM interface description, if you would
like to integrate label-printing functionality to your
application.
Run the software in the specified language. This will
override the language selection in the program preferences, but only temporarily. If you start the software
without the /lang switch, the default language is used.
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Technical Support
Online Support
You can find the latest builds, updates, workarounds for problems and Frequently Asked Questions
(FAQ) on the product web site.
For more information please refer to:
l

Knowledge base: http://kb.nicelabel.com

l

NiceLabel Support: http://www.nicelabel.com/support

l

NiceLabel Tutorials: www.nicelabel.com/Learning-center/Tutorials

l

NiceLabel Forums: forums.nicelabel.com

- 188 -

